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Introduction
Welcome to Now Up-to-Date & Contact™! This Introduction provides some basic informa-
tion about this User’s Manual, the product’s online help, and technical support.

About this User’s Manual
This User’s Manual assumes that you know how to use the Macintosh to open applica-
tions, copy files, and open control panels and Chooser devices. A working understanding
of basic Mac OS features is important as well.

Notes, Tips, and Online Help
We’ve placed special icons in the left margin throughout this User’s Manual to draw your
attention to important points about using the software.

Text accompanied by this icon indicates that you can find more detail on a topic in the On-
line Help.

Text accompanied by this icon indicates something that is important for you to know about
the software in order to ensure that you’re successful in using it, or to avoid problems.

Text accompanied by this icon informs you of a special or little-known feature, or of a par-
ticularly time-saving function.

Online Help
Context-sensitive online Help is available throughout Now Up-to-Date and Now Contact.
You can click the Help button in major dialog boxes, or choose the Help command from
the Window menu, to get information on the program feature you’re currently using.

For more information on using Online Help, choose Help from the Window menu and se-
lect the Help on Help topic.  In addition to online Help, the buttons in the Now Up-to-Date
Toolbars include Tool Tips—short identifying labels that appear whenever you pass the
pointer over the button.

The Help files copied to your hard disk during installation must be in the same folder as
the Now Contact and Now Up-to-Date applications, or Online Help won’t be available.
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Technical support
If you can’t find the answer to your question in this User’s Manual or the online Help, you
may wish to use one of our technical support options. When contacting us for technical
support, please be prepared to provide the following (and be at your Macintosh when con-
tacting us by telephone, if possible):

• Your product serial number, given to you at the time of purchase.
• A description of your problem—with as much detail as possible.
• A profile of your Macintosh. See the next section, “Creating a Profile,” for more infor-

mation.

The available technical support options are as follows:

• Visit our Web site (http://www.poweronsoftware.com), where you’ll find helpful sup-
port information for all of our products, including a searchable KnowledgeBase on Now
Up-to-Date & Contact. In addition, you’ll find information on the most current versions
and how to obtain them.

• Send e-mail to support@poweronsoftware.com. Please follow the instructions above for
providing us with the necessary details in your message.

• Finally, you can call our Technical Support department for assistance, at 612-317-0344.
Representatives are available to help you from 8:00 A.M. to 5:00 P.M. Central Standard
Time.

Creating a Profile
The Profile option details your Macintosh hardware, your installed system software, exten-
sions and control panels, and other information. Having a profile ready helps a technical
support representative resolve your problem more quickly.

To create a profile:
1. Launch Now Contact or Now Up-to-Date.

2. Choose About Now Contact™ or About Now Up-to-Date™ from the Apple menu.

3. Click the Profile button at the bottom of the About dialog box.

The application creates a profile of your Macintosh, and the Profile dialog box opens
when the profile is complete.

4. Print or save your profile. Then click OK or Cancel to leave the Profile dialog box.
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Chapter 1

Overview
This chapter provides an overview of Now Up-to-Date & Contact, including the basic con-
cepts and terms unique to each application.

Now Up-to-Date is a powerful personal organizer that maintains your schedule, reminds
you of upcoming events, manages your To-Do list and keeps your associates up-to-date,
whether you’re in the office, at home, or on the road. Now Up-To-Date integrates seam-
lessly with Now Contact—a fast, full-featured contact manager that gives you instant ac-
cess to important names, telephone numbers and addresses, and lets you easily share
Contact information with other users.

Now Up-to-Date
This section provides an overview of the concepts and terms used in Now Up-to-Date.

Events
Events are the basic building blocks of information in your Calendar File. An Event might
be an appointment, a birthday, a holiday, or a task you need to complete, but all Events are
part of your schedule. They can have titles, descriptions, attached Contacts, Reminders,
and repeats. You can prioritize them and share them with other users if you’re on a net-
work. By assigning an Event to a Category, you can change the color or style of Events or
display only those Events that relate to a particular topic.
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Your Calendar File
Your Calendar File is the database that stores and maintains the Events in your schedule
that you create, view, and modify. You need only one Calendar File to hold all of your
Events, so once you’ve created one, all you have to do is open this Calendar File when you
want to view, add to or print your schedule. You can also specify a Calendar File as your
Primary File, so that it opens whenever you open Now Up-to-Date. For ease of access, we
suggest you place an alias of your Calendar File or Now Up-to-Date in the Apple menu.

Contacts
With Now Up-to-Date you can attach Contacts to Events. Create an appointment, for ex-
ample, and you can attach Contact information on the person you’re meeting. You can also
share Contact and Event information between Now Up-to-Date and Now Contact.

Ways of viewing your Events
Now Up-to-Date lets you view your schedule in several different layouts and time ranges.
You determine how your Events are displayed by selecting one of several views for your
Calendar File. You can quickly and easily switch to various views by clicking one of the
view buttons in the Toolbar.

Categories
Categories let you group related Events together so that your Calendar File is more orga-
nized. Once you classify your Events into Categories, you can also apply distinct text
styles and colors to the Categories so that you can tell at a glance which Category a given
Event is assigned to. Your Calendar File initially contains a Personal Category by default,
and new Events are initially assigned to that Category. In a way, the Categories are like
overhead transparencies laid one on top of the other in your calendar (see Fig. 1).

Fig. 1—Categories function like transparency overlays to let you see different groups of Events at
the same time, but still tell them apart.
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Private and Public Categories
Categories created and stored in your Calendar File are called Private Categories. Infor-
mation in these Categories is not shared with anyone, even if you’re on a network.

Single users use only Private Categories. Users who are on a network can subscribe to
Public Categories stored on a Public Event Server, in order to share Event information
with other users. Public Categories allow any user to see the same Events as everyone else
on the network; when one user modifies a Public Event, like moving an appointment to a
different time, everyone else will see the change as well.

Sets
The Sets feature is a convenient way to filter your view of Events so that you see only cer-
tain Categories. You can create a different Set for each of the different ways you like to
use your Calendar File. For example, you might create an All Set that includes all Catego-
ries and all the Events they contain, a Work Set for Categories containing Events related to
work, and a Home Set for Categories containing Events that are non-work-related.

Once your Categories are grouped into Sets, you can switch quickly and easily between
them to get the display of Events that you want at any given time. Sets are quite useful in
allowing you to view or print out calendars or lists of Category-specific information—for
example, at different times you may want to view or print a business schedule, a list of
class assignments, or vacation periods.

Group Scheduling
If you’re on a network with other Now Up-to-Date users, you can schedule group meetings
automatically—specify who you want to attend, and Now Up-to-Date will find the times
that you, the colleagues you’re inviting, and even a meeting room are all available. When
someone else on the network schedules a meeting and includes you as an attendee, you
receive a notice in Now Up-to-Date. You can see more information about the meeting and
then choose to attend or decline. If you’re attending the meeting and someone reschedules
it to a different day or time, you’ll get notified of that, too.
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Now Contact basic concepts
This section provides an overview of the concepts and terms used in Now Contact.

Contacts
Contacts are the essential building blocks in Now Contact. A Contact can be a person, a
company, or both; in each case it’s an individual entry in the database of people and com-
panies (and attached information) maintained by Now Contact.

You may be accustomed to a Contact consisting of a person and/or company name, a
couple of addresses and a few telephone numbers. However, with Now Contact, a Contact
can be much more—you can incorporate more information into it and attach information
to it.

Contact Files
A Contact File is the database that stores and maintains your collection of Contacts. The
Contact File is where you create, view and modify your Contacts. A Contact File is much
like a paper-based address book, except that it lets you view and use your Contact infor-
mation in much more efficient and flexible ways.

Views
Now Contact provides two types of Views for you to create, display and modify your Con-
tacts. You can view your Contact information in both the Detail View and the List View
simultaneously.

The List View is a text-based, columnar window that displays Contact information as a
list, sorted according to your preferences. List View Layouts are customizable, allowing
you to sort and arrange Contact information depending on your needs.

The Detail View can display as much or as little Contact information as you want, includ-
ing up to 12 telephone numbers or electronic mail addresses, two postal addresses, and all
information associated with a single Contact. The Contact Log in the Detail View keeps
track of your correspondence and other files relating to each Contact. Detail View Layouts
are also easily customizable.

Categories
Now Contact Categories let you group related Contacts together so that your Contact File
is more organized. You can also apply distinct text styles and colors to the Categories so
that you can tell at a glance which Category a given Contact is assigned to.
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Keywords
Like Categories, Now Contact Keywords let you organize your Contacts into groups. You
can, however, assign as many Keywords to a Contact as you want, and the group defined
by a Keyword can include Contacts from many different Categories.

Public Categories
If you’re using Now Contact on a network, you can share Contacts with other users
through Public Categories stored on a Public Contact Server. Public Categories let you
include other network users’ Contacts in your Contact File, and make Contacts from your
Contact File available to others. This saves you from having to enter valuable Contact in-
formation into your Contact File when it’s already available in another user’s file.

Keywords defined for a private Contact are not available when the Contact is posted to a
Public Category.

QuickAccess Features
Using the QuickAccess features of Now Up-to-Date and Contact, you can immediately
view calendar and contact information, as well as add new Events and Contacts, without
having to open the main applications.

QuickPad
QuickPad gives you the ability to enter new calendar and contact information in an intui-
tive and free-form way. QuickPad uses smart text handling to take cues from what you
type and create events or contacts accordingly, and its support for multiple open windows
lets you enter a lot of information quickly and then decide what to do with it at your con-
venience.

QuickDay
Now Up-to-Date’s QuickDay adds a pull-down menu to your menu bar that provides in-
stant access to your day’s Events. Reminders for your Events appear here, whether or not
Now Up-to-Date is running, and you can set Reminders to notify you before an Event oc-
curs. You can configure how your Reminders appear—as alert dialog boxes or menu bar
alerts, with or without an accompanying sound of your choice. The QuickDay menu can
also be configured to display the date and time, and can be used as a timer.

QuickContact
QuickContact is a control panel that adds a pull-down menu of Contacts, telephone num-
bers and options to your menu bar. QuickContact can search for Contacts based on Contact
Name, Company Name and Full Name, so you can always locate a Contact quickly and
easily—whether Now Contact is running or not. The QuickContact menu appears as a tele-
phone icon ( ) in your menu bar.
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Installing Your Software
Installing Now Up-to-Date & Contact is simple—the Installer application included with
the software does all of the work for you, and puts everything where it belongs. We rec-
ommend that you follow the instructions in this chapter on using the Installer application,
because it removes any previous versions of Now Up-to-Date & Contact, and places each
component in the correct location on your hard disk.

To users of earlier versions: Before installing, be sure to read the “Read Me” file located
in the same folder as the Now Up-to-Date & Contact Installer application. This file con-
tains instructions for handling any unusual situations that may make it difficult for the In-
staller to complete its tasks properly. Under normal circumstances, the Installer handles
upgrading to version 3.8, so you don’t need to move, modify or delete any files before in-
stalling. Components from earlier versions are simply replaced by their version 3.8 coun-
terparts, and your settings for those components are incorporated into the preferences of
the new ones. The components that are new to version 3.8 are placed where they belong,
with their default settings, and your earlier-version files are preserved so that you can use
them in version 3.8.

System requirements
Now Up-to-Date & Contact are fully tested and designed to work on any Macintosh meet-
ing these requirements:

• All 68030 processor or later Macintosh models (including all Power Macintosh, G3 and
G4 computers)

• 16 MB of physical RAM
• 5 MB of available hard disk space
• Mac OS 7.1 or later, up to and including Mac OS 9
In order to use the Web lookup features of Now Contact, you must be running Mac OS
7.5.3 or later, with Open Transport installed and active.
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Installing Now Up-to-Date & Contact
The Installer application included with the software is designed to place the components in
their correct locations automatically.

If you are part of a workgroup of Macintosh users, you may be able to install from a net-
work server. Consult your system administrator for details.

To install:
1. Restart your Macintosh while holding down the Shift key.

This disables all extensions on your Macintosh.

This step is very important—installing any new software product while other
extensions are active may result in corrupted files and other problems.

2. Insert the disc into the CD-ROM drive.

If you obtained the Now Up-to-Date & Contact software electronically by pur-
chasing and downloading it from the Power On Web site, you will skip this step
and simply locate the Installer application (after decompressing the down-
loaded software, if necessary).

3. Double-click the Installer icon to open the application.

A splash screen appears, showing the name of the product you’re installing.

4. Click Continue.

A window appears, displaying the license agreement for the product. You need to ac-
cept the terms of the license agreement in order to use the product.

You can also choose to print a copy of the license agreement, save it to your
hard disk as a text file, or decline the license agreement. Note that if you click
Decline, the Installer will quit, since you must accept the license agreement in
order to use the product.

5. Click Accept.

A new window appears, displaying the “Read Me” information for the product. This
information is also available by opening the “Read Me” file found in the same folder
as the Installer application. You should read this information now if you haven’t yet
done so, as it can be helpful during the installation process.

You can also choose to print a copy of this information, or save it to your hard
disk as a text file.
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6. Click Continue.

The main Installer window appears.

The Installer defaults to a “Single User Install” setup, which installs the necessary
items for an individual to use Now Up-to-Date & Contact on a single computer. If the
computer is connected to a network, the user will be able to share events and contacts
with others, as well as view shared events and contacts made available by others.

If your network isn’t set up for sharing events and/or contacts and you want to
install the Public Server software on this computer to enable these functions,
choose “Custom Install” from the upper left pop-up menu and select an instal-
lation option that includes the Public Event Server or the Public Contact
Server, or both. In most cases, it’s best if a network administrator is involved in
installing these items.

7. Click Install to begin the installation.

Before installation begins, a dialog box appears, asking whether you want to install a
version of the software that will run only on the current computer (68K or PowerPC),
or a version that will run on any computer (“fat binary”).

8. Click “This Computer Only” or “All PowerPC & 68K” as desired.

A window appears displaying the progress of the installation process as the Installer
places the product components in their correct locations.

When installation is complete, a dialog box appears, indicating that installation was
successful and you should restart in order to use the new software.

In some cases, you may want to install the software onto another disk before
restarting; if so, you can click Continue instead of Restart at this point.

9. Click Restart.

Your Macintosh restarts, and Now Up-to-Date & Contact are ready to use.



1 2 Chapter 2

Registering your software
The first time you launch Now Up-to-Date & Contact after installing it, you have the op-
tion of using the product on a demonstration basis for 30 days, or personalizing the soft-
ware with a valid serial number. If you want to use the product in demonstration mode,
just click Demo in the dialog box that appears when you open the application.

To register your software:
1. Purchase Now Up-to-Date & Contact from Power On Software.

You can purchase the product by visiting the Power On Software Web site at http://
www.poweronsoftware.com, or by calling our Sales line at 1-800-344-9160. Upon
purchasing your product, you will receive a registration number.

2. Launch Now Up-to-Date or Now Contact.

A dialog box appears, prompting you to choose between Demo mode and registering
the software.

3. Click Register Now.

A registration dialog box opens, prompting you to enter your name, organization (op-
tional) and the registration number you received when you purchased the product.

4. Enter the required information, taking care to type your registration number correctly,
then click OK.

Your software is now registered, and you should no longer see the dialog box that ap-
peared in step 2 when you open the application.
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Removing Now Up-to-Date & Contact
Should you need to remove Now Up-to-Date & Contact from your hard disk for any rea-
son, the Installer application can do it for you.

To remove the software, just follow the same steps you used for installing, through step 6.
Choose “Uninstall” from the upper left pop-up menu, and then click “Uninstall” at bottom
right. The Installer removes the software, then a message appears indicating that the re-
moval won’t take effect until you restart. Click Restart, and your Macintosh will restart
without the software items you removed.

When you use the Uninstall option, any calendar or contact files you have created are not
removed from your hard disk.
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Working with Calendar Events
This chapter explains how to create and modify Events, set and respond to Reminders, at-
tach Contacts to Events, and find Events.

Creating and opening a Calendar File
Whether you upgrade from a previous version or set up Now Up-to-Date for the first time,
you need to select a primary Calendar File. This is the file that QuickDay scans for Events
requiring Reminders, and the file that’s automatically linked to Now Contact .

To upgrade from an earlier version of Now Up-to-Date:
1. Open Now Up-to-Date.

2. Choose Open from the File menu.

3. In the Open dialog box, locate and select your earlier-version Calendar File.

A dialog box appears asking you to confirm that you want to convert the earlier ver-
sion Calendar File to version 3.8. Click OK.

4. Select “Make this file the primary file.”

5. Click Open.

The file is selected as primary.

To create a new Calendar File to contain your Events (for new users):
1. Open Now Up-to-Date.

An untitled Calendar File opens.

2. Choose Save As from the File menu.

The Save As dialog box appears.
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3. Select “Make this file the primary file.”

Designating the file as primary means that it will open automatically whenever you
open Now Up-to-Date.

4. Enter a name and select a location for the file, then click Save.

Event Info window
Now Up-to-Date’s Event Info window is the control center for creating and modifying
Events. The Event Info window appears when you create any new Event except Notes and
Banners, or when you double-click an Event in any view.

To prevent the Event Info window from opening automatically whenever you create a new
Event, choose General Preferences from the Define menu and deselect this option.

The Event Info window displays information for the currently selected Event. Press Tab to
move from field to field; press Shift-Tab to move to the previous field.

When the Event Info window is open, the calendar view behind it is inactive. Make the
calendar view active by pressing the Enter key. When you do so, pressing Tab or Shift-Tab
moves you between Events in your Calendar File, allowing you to locate another Event.
Press the Enter key again to make the Event Info window active.

Refer to “Event Info” in Online Help for more information on using the Event Info window.
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Creating Events
Once you’ve opened your Calendar File, you’re ready to begin adding Events to your
schedule.

You can also quickly create Appointments, Calls, and To-Dos and add them to your calen-
dar using QuickPad. See “Using QuickPad” in Chapter 13, “QuickAccess Features,” for
more information.

Scheduling Appointments
An Appointment is an Event that occurs on a specific day at a specific time.

To schedule an Appointment in any view:
1. Select a day by clicking in its cell.

2. Choose New Appt. from the Event menu.

The Event Info window appears with the default title of “New Appt.” and the Event
type set to Appt.

3. Change the Appointment’s title by typing.

4. Change any other information in the Event Info window.

5. Close the Event Info window.

To schedule an Appointment in Multi-Day or Day View:
1. In the time grid for the day on which the Appointment occurs, position the pointer

over the starting time.

The pointer becomes a crosshair.

2. Drag the crosshair from the starting time of the Appointment to the ending time.

The Event Info window appears with the default title of “New Appt.” and the Event
type set to Appt.

3. Change the Appointment’s title by typing.

4. Change any other information in the Event Info window.

5. Close the Event Info window.

The Appointment appears highlighted in the current View.
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While in the Multi-Day or Day View, you can change the start and end times of
the new Appointment by dragging the Appointment to a new start time. Change
the duration of the Appointment by dragging the top or bottom edge of the box
in which it appears.

Meetings
If you’re using Now Up-to-Date with a network Public Event Server set up for Group
Scheduling, you can use the Meeting Event type to schedule meetings for specific dates
and times, reserve rooms and resources, and notify attendees.

To schedule a Meeting:
1. Select a day by clicking in its cell.

2. Choose New Meeting from the Event menu.

The Event Info window appears with the default title of New Meeting, and the Sched-
ule Meeting dialog box opens.

3. Select the users, Groups, Conference Rooms, and/or Resources to include in the meet-
ing.

Drag the desired items from the list on the left to the Invite list on the right. To re-
move an item, drag it back to the first list. To inform someone of a scheduled Meet-
ing, but not invite them, drag the name to the Opt list.

4. Click either Group View or Auto-Pick to set the meeting date, time and duration.

Group View shows each invitee’s schedule, including their available times. Any users
you’ve placed in the Opt list appear in italics at the bottom of the list. The first avail-
able time for your meeting is highlighted.

Auto-Pick automatically checks the schedules of everyone you placed in the Invite
list, and the availability of any Conference Rooms or resources you’ve included. The
Auto-Pick dialog box displays the available meeting times.

5. Click OK.

The dialog box closes, and you see the Event Info window for your new meeting.
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6. Fill in any necessary information for the meeting.

7. Close the Event Info window.

The Meeting appears in your Calendar File and everyone on your Invite and Opt lists
receives notification of the new meeting.

Scheduling To-Dos and Calls
To-Dos and Calls are similar types of Events. Use To-Dos to schedule tasks that you want
to complete on a specific day. Use Calls for planning telephone calls that you need to
make on a specific day.

To schedule a To-Do or a Call:
1. Select a day by clicking in its cell.

2. Choose New To-Do or New Call from the Event menu.

The Event Info window appears with a default title and the Event type set to the se-
lected Event.

3. Change the Event’s title by simply typing.

4. Change any other information in the Event Info window.

5. Close the Event Info window.

The To-Do or Call appears highlighted on the selected day.

Marking To-Dos and Calls as In Progress or Done
A To-Do or a Call marked as Not Done (•) or In Progress (••) can be auto-forwarded to
subsequent days until you mark it as Done ( ). When you mark a To-Do or Call as Done,
it is attached to the date on which it was completed.

You can specify that when a To-Do or Call is marked Done it disappears from your view,
or that it appears in the lower section of your To-Do List. See “Define Calendar Formats
dialog box” in Chapter 4, “Viewing Calendar Events,” for more information.

To mark a To-Do or Call as In Progress or Done in the To-Do List:
1. Click once on the box to the left of the To-Do or Call to mark it as In Progress.

A diagonal line appears in the box.

2. Click the box again to mark the To-Do or Call as Done.

A checkmark appears in the box and the item moves to the bottom of the list.

Option-click to mark a To-Do or Call as Done immediately instead of clicking
twice. If you inadvertently mark a To-Do or Call as Done, simply click the box
again to remove the checkmark. The item moves back into the upper part of the
To-Do List.
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To mark a To-Do or Call as Done in other views:
1. Select the To-Do or Call by clicking it once so it’s highlighted.

2. Choose Done from the Event menu, or type Command-/.

A checkmark appears next to the title of the To-Do or Call, indicating that you’ve
completed it.

Special
A Special Event is a date-specific Event that spans an entire day. You can use a Special
Event to indicate a special occasion or simply that you’re out of the office for the entire
day.

To create a Special Event:
1. Select a day by clicking in its cell.

2. Choose New Special from the Event menu.

The Event Info window appears with New Special highlighted in the Title field and
the Special Event type selected.

3. Change the Special Event’s title by typing.

4. Change any other information in the Event Info window.

If you’re using Group Scheduling, you can use a Special Event to indicate that
you are unavailable for Meetings for an entire day.

5. Close the Event Info window.

Holiday
A Holiday is a date-specific Event that’s nearly identical to a Special Event, except that it
represents a holiday. This Event type automatically changes the formatting of the date on
which it falls to the format you’ve specified for weekends and holidays. (The Define Cal-
endar Formats dialog box lets you specify unique appearances for weekends and Holidays.
See “Customizing Calendar Views” in Chapter 4 for more information.)

To create a Holiday:
1. Select a day by clicking in its cell.

2. Choose New Holiday from the Event menu.

The Event Info window appears with New Holiday highlighted in the Title field and
the Holiday Event type selected.

3. Change the Holiday’s title by typing.

4. Change any other information in the Event Info window.

5. Close the Event Info window.
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Banner
A Banner is a graphic Event that spans one or more days. It appears as a Banner in the
Month View; in all other views, it appears like a repeating Special Event. When Banners
overlap, clicking the one in back brings it forward. If you’re using Group Scheduling, you
can use a Banner to indicate that you are unavailable for Meetings for a day or a series of
days.

To create a Banner:
1. With the Month View displayed, choose New Banner from the Event menu.

A new highlighted Banner appears across the current or selected day. If no day is se-
lected, the Banner will appear in the upper left corner.

2. Drag the Banner to the desired position.

3. Resize the Banner, if necessary, to span the desired days.

Click the right edge of the Banner and drag it to cover the span of days desired. The
Banner can span multiple weeks or even months.

4. Enter the desired text in the Banner and then press the Enter key.

Your Banner text is saved and the Banner is selected. Deselect it by clicking any-
where in the Month View.

The Define Calendar Formats dialog box lets you control the shape and appearance of
Banners. See “Customizing Calendar Views” in Chapter 4, “Viewing Calendar Events,”
for more information.

Sticky Note
A Sticky Note lets you place an attention-getting message directly in your Month View.

To create a Sticky Note:
1. With the Month View displayed, choose New Sticky Note from the Event menu.

A new highlighted Sticky Note appears across the current or selected day. If no day is
selected, the Sticky Note will appear in the upper left corner.

2. Enter text in the Sticky Note by typing, then press the Enter key.

Your text is saved and the Sticky Note is selected. You can deselect it by clicking
anywhere in the Month View.

3. Move or resize the Sticky Note as desired.

To move it, drag its top edge. To resize it, place the pointer over the bottom right cor-
ner—it changes to a double-headed arrow—then drag to the desired size.

To add a title to a Sticky Note, double-click it to open the Event Info window; type in the
Title field, then close the Event Info window.
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Graphics
Now Up-to-Date allows you to add bitmap or PICT graphics to your Calendar File to draw
attention to specific days or Events, or to provide a unique background for your calendar
display. You can do this by dragging and dropping graphics from the Graphics Palette, or
by pasting graphics from the Clipboard. You can attach a graphic to a day in the Month
View, or to any of five Event types: Appointments, To-Dos, Calls, Special Events and
Holidays. The maximum number and size of Graphics is limited only by the available
memory.

A graphic attached to a day (rather than to an Event) is actually a separate Event type, with
a title, description, and repeat options. Any Graphic of this sort can be moved, resized, re-
peated, and, because it is an Event, shared with other users over a network.

A graphic attached to an Event appears next to an Event’s title in the Multi-Day and Day
Views, and at the top of the day on which the Event occurs in the Month and Week Views.

Event Graphics are automatically reduced in size for display, so smaller graphics like
icons tend to work best. To increase the size of graphics, increase the size of the number
text in the Define Calendar Formats dialog.

Graphics Palette
The Graphics Palette contains ready-made icon graphics that you can attach to days in the
Month View or attach to individual Events in any View.

Click to add new 
graphics to the palette

Drag a graphic here 
to delete it from the 
palette

Drag to resize 
the palette

Drag a graphic to a 
day or an Event

To… Do this…
Open the Graphics Palette Choose Open Graphics Palette from the

Window menu.

Attach a graphic to a day in Month View Drag the graphic from the Graphics Palette
and drop it on the desired day.

Attach a graphic to an Event in any View Drag the graphic from the Graphics Palette
to the Event, and drop it when the Event is
highlighted.

Add a graphic from the Clipboard Click the Paste button in the Graphics
Palette, or choose Paste Graphic from the
Edit menu.

Remove a graphic from the Palette Drag the graphic to the Trash icon in the
Palette.
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Pasting graphics from the Clipboard
To add graphics to your Calendar File that aren’t available in the Graphics Palette, you can
simply copy them to the Clipboard in any application and paste them into Now Up-to-
Date. Once you’ve copied a graphic to the Clipboard and switched to Now Up-to-Date,
you have the following options:

To… Do this…
Attach a graphic to a day Click in the day cell and choose Paste Graphic from

the Edit menu.

Attach a graphic to an Event Select the desired Event and choose Paste Graphic
from the Edit menu.

Modifying Graphics in your Calendar File
You can modify graphics you’ve added to your Calendar File in several ways. When the
Palette isn’t open and you want to modify a graphic attached to a day, you must first hold
down the Option key and click the graphic. When the Graphics Palette is open, you have
the following options.

To… Do this…
Move a graphic attached to a day Drag it to the desired location.

Resize a graphic attached to a day Place the pointer over its bottom right corner
until the pointer changes to a double-headed ar-
row, then drag to the desired size.

Remove a graphic attached to a day Select it and press Delete/Backspace, or choose
Cut Graphic from the Edit menu.

Remove a graphic attached to an Event Select the Event containing the graphic you
want to remove, and then choose Cut Graphic
from the Edit menu.
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Customizing Events
You can customize an Event by setting repeats and reminders, changing its status, attach-
ing Contacts and a description, and changing the Event’s font size and color. Some of this
customizing is done in the Event Info window, and some using menu commands.

Using the Date/Time Picker
The Date/Time Picker is a special dialog box that makes it extremely easy to set the cor-
rect date and time for the Appointment you’re creating. To open the Date/Time Picker, just
click the button shown at left in the Event Info window.

Using the Date/Time Stamp
The Date/Time Stamp function in the Event Info window lets you make an Event’s de-
scription more informative by documenting the date and time that notes were added, or
even elapsed time, which is very useful in the case of a Call Event.

To use this feature, click the Date/Time Stamp button in the Event Info window Toolbar.
The current date and time are inserted at the top of the Description field. As long as you
keep the Event Info window open to the same Event, clicking the button again will place a
second date and time entry after the first, followed by the elapsed time in parentheses.

When the Event is a To-Do or a Call, the Timer that appears in the Event Info window for
these Events counts elapsed time as it passes.

Using Priorities
The Priority setting causes To-Dos, Calls and Undated To-Dos to appear in order of Prior-
ity. Those with a higher Priority appear higher in the list. You can define up to ten differ-
ent Priorities of any name. You assign a Priority using either the Event menu or the Event
Info window.
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If you’re on a network, note that an Event’s Priority is a private attribute, so any Priority
you assign to a shared Event is not shared with other users.

To assign a Priority to an Event:
1. Select the Event.

2. Choose the desired Priority from the submenu attached to Priority on the Event menu.

or

Choose a Priority from the Priority pop-up menu in the Event Info window.

You can also prioritize by dragging items in the To-Do List.  See Chapter 4,
“Viewing Calendar Events” for more information.

Defining Priorities
You can easily customize the names and order of the available Priorities.

To define Priorities:
1. Choose Priorities from the Define menu.

The Define Priorities dialog box opens.

2. Edit the existing Priority names or add new ones as desired.

3. Click OK to save your changes.

The new or modified Priorities are now available in the Priority submenu.

Setting up repeating Events
You can create an Event once and then set it to repeat at a specified interval for any num-
ber of total occurrences. This makes it very simple to add weekly meetings or other regu-
larly-occurring Events to your Calendar File. You can choose from a list of standard,
preset repeat options, or set up custom repeats for more unique situations. Repeats are
available for all Event types except Banners and Undated To-Dos.

Standard repeating Events
The Repeat menu in the Event Info window provides a number of standard repeating inter-
vals. The options available on this menu vary according to the day on which the Event is
to occur.

To create a standard repeating Event:
1. Open the Event Info window for the Event that you want to repeat.

2. Choose the desired repeat option from the Repeat pop-up menu.
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Because the options on the menu change according to the day on which the selected
Event falls, this illustration may vary from what you see.

3. Save the repeat setting by pressing the Enter key or closing the Event Info window.

The repeating occurrences of the original Event have been added to your Calendar
File.

You can create a repeating Event without opening the Event Info window by holding down
the Option key and dragging the Event to the day on which you want the Event to repeat.

Custom repeating Events
The custom repeat option lets you specify the details of more unique repeating sequences.
It also lets you specify an ending date for a repeating sequence, rather than having to know
exactly how many occurrences you want.

To create a custom repeating Event:
1. Open the Event Info window for the Event.

2. Choose custom repeat from the Repeat pop-up menu.

A dialog box opens for configuring custom repeating Events.

3. Set up the custom repeat frequency as desired.

Click the Online Help button to read a full description of the options in the
Custom Repeat dialog box.
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4. Click OK to save your settings.

You’re returned to the Event Info window. The Repeat menu displays custom repeat
to indicate that you’ve set up a Custom Repeat.

5. Save your repeat settings by pressing the Enter key or closing the Event Info window.

Modifying repeating Events
You can modify the details of a repeating Event, and quickly transfer that change to all
connected repeating Events, future repeating Events, or just selected Events in the series.

To modify a repeating Event:
1. Open the Event Info window for the repeating Event you want to change.

2. Modify the event information as desired.

For example, you may want to change the start or end times for the Event, or change
text in the description field to indicate a different meeting agenda.

3. Close the Event Info window.

A dialog box appears with the following options.

Use this option… To…
Future: Change only future repeating Events to have the same characteristics

as the Event you just modified.

All: Change all past and future repeating Events to have the same charac-
teristics as the Event you just modified.

One: Change only the Event you have just modified, and leave past and
future repeating Events as they were.

As you move your pointer over the Future, All and One buttons, notice the key-
board shortcut text displayed in the dialog box.

4. Click your choice.

The repeating Events are updated accordingly.
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Setting Reminders for Events from within Now Up-to-Date
Reminders are managed by the QuickDay control panel that’s installed with Now Up-to-
Date. See “Using QuickDay” in Chapter 13, “Quick Access Features,” for details on using
QuickDay. This section describes how to set Reminders in the Event Info window.

You can’t set Reminders for Undated To-Dos, Notes, Banners or Graphics.

To set a Reminder for an Event in Now Up-to-Date:
1. Open the Event Info window for the Event for which you want to set a Reminder.

The Event Info window appears. Use the three pop-up menus that appear next to Re-
mind at the bottom of the window to set a Reminder.

In order for you to receive Reminders in the form of menu bar alerts, the
QuickDay Event menu must be turned on by selecting the “Bell” option in the
QuickDay control panel. See Chapter 13, “QuickAccess Features,” for more
information.

2. Save the Reminder setting by pressing the Enter key or closing the Event Info window.

3. Save your Calendar File.

The QuickDay control panel becomes aware of new Events requiring Reminders only
after you save your Calendar File.

Responding to Reminders
Now Up-to-Date offers many options for responding to Reminders.

When you dismiss an alert for a repeating To-Do, you dismiss only the current day’s alert
for that To-Do. If the To-Do is not marked as Done, you’ll receive another alert for it on
subsequent days until it is completed.

Alert dialog boxes
Alert dialog boxes offer the most options for responding to a Reminder. Because alert dia-
log boxes may interrupt background processes such as printing or modem downloads,
however, some users may prefer the menu bar alert option described in the next section.
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A typical Reminder alert dialog box is shown below.

Click to open your Calendar to 
this Event and dismiss the alert.

Click to delete the Event 
from your Calendar.

Click to open the QuickDay Event 
Info dialog box for this Event.

Click to dismiss the 
Reminder.

Click to snooze the Reminder for 
the default delay or by the time 
specified in the adjacent fields.

Set the Snooze interval 
with these options

Event name 
and time

Attached 
Contact info

Event 
description

You can quickly snooze a Reminder by typing the desired amount of time, typing m for
minutes, h for hours, or d for days, and clicking Snooze (or pressing Return or Enter).

Menu bar alerts
When you set a menu bar alert, the Event name flashes where the QuickDay menu heading
appears when the Reminder is due. This type of alert doesn’t interfere with background
processes, and continues to flash until it’s dismissed or snoozed. Your options for respond-
ing to menu bar alerts are described in the illustration below.

Click once in the menu bar 
to dismiss the alert

Choose one of these options 
to snooze or dismiss the alert

Choose this option to open the 
QuickDay Event Info dialog 
box for the Event

Choose another Event to 
open the QuickDay Event 
Info dialog box for the Event

To mark a To-Do or Call as Done, choose Mark [Event] as Done from the QuickDay menu
(this command appears only when the alert is for a To-Do or Call).  This marks the To-Do
or Call as Done and dismisses the Reminder.

To either snooze or dismiss all currently due Reminders, hold down the Option key to
change the Snooze [Event] and Dismiss [Event] commands to Snooze All and Dismiss All.

The Sets feature lets you control the kinds of Reminders you receive from Public Catego-
ries. See Chapter 5, “Organizing Events,” for more information on Sets.
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Attaching Contacts to Events
You can attach Contact information to any Event you create. The attached name, company
and phone number of the Contact appears in the Event Info window. When you receive a
Reminder for an appointment, you’ll also see this Contact information.

The following procedure explains how to add Contact information to your Event without
using Now Contact. By linking a Now Contact file to your Calendar File, you can attach
existing Contacts to Events and add Contacts you create in Now Up-to-Date to your Now
Contact file. See Chapter 14, “Linking Events and Contacts,” for more information.

To attach a Contact to an Event:
1. Open the Event Info window for the Event to which you want to attach a Contact.

Double-click the Event, or select it and then press the Enter key.

2. Choose New Contact from the Attachments submenu on the Event menu.

The New Contact dialog box appears.

3. Enter the Contact information in the appropriate fields.

The Phone pop-up menu lets you specify whether the phone number you enter is a
work (Wk), home (Hm), Fax (Fx), mobile (Mb), or other (#) number.

4. Click OK.

Attaching World Wide Web links to Events
You can attach Web page links to any Event. Web link attachments let you keep track of
Web pages related to certain Events, and make it easy to open the corresponding pages in
your Web browser. Web link attachments include the name of the linked page or site and
its URL, or address. You attach Web page links by dragging them from a browser win-
dow, or by entering them directly in Now Up-to-Date.

To drag a Web page link to an Event:
1. Make sure that Now Up-to-Date is open, and the Event you want to attach the link

to is in the current Calendar View.

2. In your Web browser, select a link and drag it to the Event.
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In some browsers, when you hold the mouse over a link for too long before
dragging, a pop-up menu may appear. If this happens, just move the pointer off
the menu and try again.

3. In Now Up-to-Date, open the Event Info window for the Event.

The Web link attachment appears in the same area as attached Contacts.

4. To open the linked Web page in your Web browser, double-click the attachment while
holding down the Option key.

To create a Web page link in Now Up-to-Date:
1. Open the Event Info window for the Event to which you want to attach a Web link.

2. Click the New URL button in the Event Info window Toolbar.

The New URL dialog box appears.

You can also open this dialog box by selecting the Event in any Calendar View
and choosing New URL from the Attachments submenu in the Event menu.

3. Enter the Web link information in the appropriate fields.

You can test the link by clicking the Web browser button in the lower-left corner of
the dialog box. Your browser opens to the specified Web page.

4. Click OK to return to the Event Info window.

The Web link attachment appears in the same area as attached Contacts.
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5. To open the linked Web page in your Web browser, double-click the attachment while
holding down the Option key.

You can edit Web link attachments by selecting an Event and choosing Edit Attachments
from the Attachments submenu in the Event menu. The URL Info dialog box that appears
is identical to the New URL dialog box shown above.

Attaching documents to Events
Now Up-to-Date also lets you attach documents to Events. This allows you to keep track of
any documents, such as letters and spreadsheets, that relate to particular Events.

To attach a document to an Event:
1. Open the Event Info window for the Event to which you want to attach a document.

2. Click the Attach File button in the Event Info window Toolbar.

A directory dialog box appears.

You can also open this dialog box by selecting the Event in any Calendar View
and choosing Attach File from the Attachments submenu in the Event menu.

3. Locate and select the file you want to attach, then click Attach.

The document is attached to your Event, and appears in the same area of the Event
Info window as attached Contacts and Web links.

4. To open the document in the application that created it, double-click the attachment
while holding down the Option key.

Changing Event text style and color
You can make certain Events stand out from others by applying contrasting colors and/or
text styles to them. The style and color of Events are set according to their Category in the
Define Sets dialog box, but you can do some customizing with menu commands.

To change the text style or color for an individual Event:
1. Select the Event.

2. Highlight the Style or Color command on the Event menu and from the corresponding
submenu, choose the attribute you want to apply.



3 3Working with Calendar Events

Now
 Up-to-Date

Choose… To…
A style or color Apply the selected style or color to the Event.

Same as Category Return the Event to the style or color specified for the Event’s
Category in the Define Sets dialog box.

You can set an Event’s style quickly by selecting it and then using a standard
keyboard shortcut, as listed below:

Plain Command-Shift-P Outline Command-Shift-O
Bold Command-Shift-B Shadow Command-Shift-S
Italic Command-Shift-I Condense Command-Shift-C
Underline Command-Shift-U

You can also set the text style or color for an entire Category. Select an Event that belongs
to the Category whose text style or color you want to modify. Hold down the Option key
while pulling down the Event menu. Then follow the steps above.

Moving, copying, and deleting Events
It’s easy to move, copy, or delete an Event. There are some variations in these procedures
where repeating Events are concerned.

Moving Events
To move a single Event, select it, choose Cut from the Edit menu, select the destination
day, and choose Paste Event from the Edit menu.

In the Month, Week and Multi-Day Views, move an Event simply by dragging it to a differ-
ent day within the current View.

To move a repeating Event:
1. Select the occurrence of the repeating Event that you want to move.

2. Choose Cut from the Edit menu.

3. Select the destination day.

4. Depending on the desired result, choose the appropriate command from the Edit
menu.

Choose… To move the Event to a new day and…
Paste Event Disconnect it from the other repeating Events in the series.

Paste Repeat Keep it connected to the other repeating Events.

To move multiple occurrences of a repeating Event:
1. Select one occurrence of the repeating Event.

2. Depending on the desired result, choose the appropriate command from the Edit menu.
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Choose… To cut the selected occurrence and…
Cut Future All future occurrences of the repeating Event.

Cut All All past and future occurrences of the repeating Event.

3. Select the destination day.

4. Depending on the desired result, choose the appropriate command from the Edit
menu.

Choose… To paste a series of repeating Events that is…
Paste Event Disconnected from the original series and starts on the selected day.

Paste Repeat Connected to the original series and starts on the selected day.

Copying Events
To copy a single Event, select it, choose Copy from the Edit menu, and select the destina-
tion day. From the Edit menu, choose Paste Event to create a new Event with the same
name as the original. Choose Paste Repeat to create a repeating occurrence of the original
Event.

To create a repeating occurrence of an Event, hold down the Option key while dragging
the Event to a new day.

Deleting Events
To delete an Event:
1. Select the Event.

2. Choose Clear from the Edit menu, or press Delete/Backspace.

The Event is deleted. If the Event is part of a repeating series, a dialog box appears
asking if you want to remove the one occurrence, all occurrences, or only all future
occurrences in the repeating series. Click the desired button in the dialog box.

To avoid the confirmation dialog box when deleting repeating Events:

• Press the Command-Delete to delete only a single occurrence of a repeating Event.
• Press Command-Shift-Delete to remove all future occurrences of a repeating Event

without a confirmation dialog box.
• Press Shift-Delete to remove all occurrences of a repeating Event.
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Hiding and unhiding Events
You can selectively hide all Event types. You can’t print hidden Events, nor do you re-
ceive any Reminders for them. When you hide shared Events, they are hidden only within
your Calendar File; other users will still be able to view them.

To… Choose…
Hide an Event Hide Event from the Event menu after selecting the Event.

View a hidden Event Show Hidden from the View menu.

Any Events that you’ve previously hidden appear in a dith-
ered, or dimmed pattern when you choose this command.

Unhide an Event Unhide Event from the Event menu after selecting the dimmed
Event. This option is available only if the selected Event is hidden.

Finding Events and text in your Calendar File
Use Now Up-to-Date’s Find command to locate an Event, Contact information attached to
an Event, or any information entered in the description field of an Event. This command
searches all Event titles, descriptions, and attached Contacts in your current Set of Catego-
ries, except in Events that are currently hidden (see Chapter 5, “Organizing Calendar
Events,” for more information on Categories and Sets).

To find text in your Calendar File:
1. Choose Find from the Event menu.

2. Type the text to search for in the text field.

3. Click Find or press Enter.

Now Up-to-Date begins the search from the day that is currently selected or from the
first day in the current view, and highlights the first Event that contains the specified
text.

To locate the next occurrence, choose Find Again from the Event menu (or type Com-
mand-G). To search backwards, select the Search Backwards checkbox in the Find
dialog box before starting the search, or hold down the Shift key and choose Find
Again.

The Find Original command is used only when working with Unreconciled Events from
Public Categories. See Chapter 11, “Importing, Exporting & Synchronizing Contact Data,”
for more information.
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Setting preferences for Now Up-to-Date
From setting preferences for new Events to general preferences for how Now Up-to-Date
works, you have a great deal of control over the scheduling environment.

To set your preferences, highlight the Preferences command on the Define menu. A sub-
menu appears, providing direct access to Preferences settings in several areas—choose the
submenu command for the area of Preferences you want to modify, and the Preferences
window opens to that pane. You can move to another pane by clicking its icon in the
scrolling list on the left.

Refer to “Preferences” in Online Help for more information on the Preferences options.

Setting Preferences for new Events
You can automate some of the work involved in creating Events by setting default values
for them.

For New Appointment you can set the default Category (see Chapter 5, “Organizing
Events,” for more information), Priority, Reminder attributes, as well as the start time (at
the current time; on the quarter-, half- or whole hour from the current time; or at a time
you specify) and the duration of a new Event.

For New To-Do, and New Call you can set the default Category, Priority, and Reminder
attributes, as well as the beginning time (at the current time; on the quarter, half or whole
hour from the current time; at a time you specify; or none at all) and the duration of a new
Event. You can also indicate if the To-Do or Call will be carried forward until it is marked
as Done. For a Call, you can specify that its Timer will auto-start as soon as you create the
Event.

For New Undated, New Note, New Banner and New Graphic, you can set the default Cat-
egory and Priority. For New Holiday and New Special, you can set the default Category
and Priority, as well as the default Reminder attributes.

Choose Meetings to specify the default Category and Priority for new meetings that you
create, the time interval for auto-picking a meeting schedule, what kind of Reminder you
prefer, and the type of alert and sound to receive when you are invited to meetings. See
Chapter 16, “Group Scheduling,” for more information.
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Setting Now Contact preferences

Choose Now Contact to select which Now Contact file to link your Events to. You can
also set the default phone title that will appear in the New Contact or Contact Info dialog
box, and other options. See Chapter 14, “Linking Events and Contacts,” for more information.

Setting General Preferences

Choose General from the Preferences submenu to set general default preferences for your
Calendar File.

Choose… To specify that…
Open Event Info for new Events The Event Info window will open automati-

cally whenever you create a new Event.

Start the week on Monday Weeks will start on Monday instead of Sun-
day in the Month and Multi-Day Views.

Show Set name in window title The title bar of your Calendar File will dis-
play the name of the Set that is currently
selected in the View menu.

continued next page
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Choose… To specify that…
continued from previous page

Auto-save every x minutes The Auto-Save function will be active, sav-
ing your Calendar File automatically at the
time interval you specify.

Shadow twilight hours In the Multi-Day and Day Views, the hours
from 7 P.M. to 5 A.M. will appear “shad-
owed.”

Use non-enhanced printing Now Up-to-Date’s full-featured printing
will be reduced to very basic functions, in
order to resolve the printing errors that are
occasionally caused by some printers using
custom Chooser devices. Fewer printing
options will be available when this check-
box is selected.

Use system color palette Now Up-to-Date’s custom color palette will
be turned off, to avoid the minor and purely
cosmetic effect that it can have on the ap-
pearance of your desktop and the Apple
icon in the menu bar, only when Now Up-
to-Date is running.

Date range for Reminders Reminders will be presented only during a
certain time range.

Alert on Public Event deletion A warning dialog box will appear when you
delete a Public Event. The warning alerts
you that deleting the Event will also delete
it from everyone else’s calendar.

Receive reminders for time commitments Presents Reminders for all Events in Public
Categories for which you’ve confirmed at-
tendance. This preference applies only if
you are set up for Group Scheduling.
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Viewing Calendar Events
Now Up-to-Date offers a wide variety of Views, so you can examine and modify your
schedule in the way that best suits you. You can also customize Views to fit the way you
want to look at your schedule.

Using Calendar Views
This section provides specific information on each of the calendar-based views, showing
you what’s unique about each one and how it can help you view your schedule.

Elements in each View
Several elements are common to all views in Now Up-to-Date.

Toolbars
The buttons in the Toolbar provide immediate access to most common Now Up-to-Date
functions.

Print

Year 
View

List 
View

Go to 
Date

Word 
Wrap

Show/Hide 
Weekends

Month 
View

Week 
View

Day 
View

New 
Appointment

New 
To-Do

Online 
Help

Define Calendar 
Formats/List Layouts

New 
Call

New 
Meeting

Meeting 
Notices

Scrolling 
View

Multi-Day 
View

To-Do 
List
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Month View
The Month View is Now Up-to-Date’s default view; it displays all Event types except Un-
dated To-Dos, and it’s the only view in which Sticky Notes appear. Banners appear as
graphic items in this view, and as repeating Special Events in other views.

For each day, Events are sorted in the following order:

Holidays
Special Events
Appointments, Meetings, time-specific To-Dos and time-specific Calls—grouped

together and sorted by their scheduled times
Not Done dated To-Dos and Calls (sorted by Priority)
In Progress dated To-Dos and Calls (sorted by Priority)
Done dated To-Dos and Calls (sorted by Priority)

If you schedule more Events on a day than can fit into its cell at the current window size,
the cell will scroll to let you see all of the day’s Events. Upward- and downward-pointing
arrows indicate that there are additional Events to which you can scroll.

Click to scroll up and 
down in the list of Events

Events that don’t have titles do not appear in the Month View.
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Scrolling Option in the Month View
The Month View has a scrolling option that you can toggle on and off. This option lets you
move forward and backward by single weeks, instead of full months. When the scrolling
option is active, the weeks move upward as you go forward in time and vice versa.

Also, the See-Thru Month feature (which displays day numbers and Events from previous
and upcoming months in a dimmed pattern) is no longer active, as all days and Events in
the current time range are displayed. The Calendar Header changes to reflect the time
range being displayed.

Week View
The Week View shows you a week at a time in a format similar to the Month View but
with more space allotted for each day. This view displays all Event types except Sticky
Notes, and includes scrolling cells as well.



4 2 Chapter 4

Multi-Day View
The Multi-Day View displays a week in a time-grid, columnar format, allowing you to see
free time slots at a glance. Only Appointments and Meetings appear in the upper, timed
section; To-Dos, Calls (including time-specific To-Dos and Calls), Special Events and
Holidays appear at the bottom in the All Day area. You can drag Appointments to the All
Day area where they become To-Dos, and drag All Day Events to the timed area where
they become Appointments. As the day progresses, the hours listed along the left side be-
come shaded to indicate that they’re in the past.

Scrolling Option in the Multi-Day View
Like the Month View, the Multi-Day View also has a scrolling option that you can toggle
on and off. This option lets you move forward and backward by single days, instead of full
weeks.
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Day View
The Day View resembles the Multi-Day View, with a time-grid columnar format and a
split window, but it displays one day only. The Day View is a separate window from the
Month, Week, or Multi-Day View; you can have the Day View open at the same time that
you have one of the other views open, and arrange the two windows on your screen so that
you can use them simultaneously. Overlapping Appointments are also tiled in this view so
you can spot conflicts easily.

Zoom commands in Multi-Day and Day View
The Zoom In and Zoom Out commands in the View menu are available only in the Multi-
Day and Day Views. These commands allow you to see the time displayed in increments
other than the default 15 minutes. Each command has five levels of magnification. Choos-
ing Zoom In magnifies the time grid and allows you to read or create Appointments that
start or end at smaller time increments. With the Zoom Out command you can go back to
the preset 15-minute increment scale, or zoom out one more level to 30-minute incre-
ments.

Year View
The Year View provides an overview of a given year; it does not display any Event types.
You can select a month number using the number keys (1-12), move between months us-
ing the arrow keys, and open the Month View by double-clicking the desired month, or
selecting a month and pressing Return or Enter.
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To-Do List
The To-Do List is available as a split window in all views except the List View and the
Year View. To see the To-Do List, just click the button at the right end of the Toolbar. The
To-Do List opens and displays the To-Dos and Calls for the current day.

Click the checkbox to change 
the status of To-Dos and Calls Dated To-Dos and Calls

Undated To-Dos

Done To-Dos and Calls

All Calendar Format and other view-related settings (Event text size, Word Wrap, etc.)
apply to the To-Do List as well.

The To-Do List displays To-Dos and Calls in three groups: dated To-Dos and Calls for the
currently-displayed day, Undated To-Dos, and any Done To-Dos and Calls that were com-
pleted on the currently-displayed day. The first two groups are sorted by Priority, Time (if
any) and Title. The last group is sorted by the date and time that items were marked as
Done, then by their titles.

Changing the status of To-Dos and Calls
Change the Done/Not Done status of To-Dos and Calls in the To-Do List by clicking the
checkbox that appears next to each one. When a To-Do or Call is Not Done, the checkbox
is blank; click the checkbox once to mark the item as In Progress (a single line appears in
the box); click it again to mark the item as Done (a checkmark appears in the box). When
you mark an item as Done, it moves to the bottom section of the To-Do List.

Option-click an item to mark it as Done, skipping the In Progress setting.

Modifying To-Dos and Calls by Dragging
Change the Priority of an item in the To-Do List by dragging it to a new location in the
list. To make an item a higher priority, drag it higher in the list; to make it a lower priority,
drag it lower in the list.

Dragging a dated To-Do or Call into the Undated section of the To-Do List changes it to
an Undated To-Do, and vice versa. Dragging a To-Do, Call, or Undated To-Do into the
Done section marks it as Done at the current date and time; dragging an item from the
Done section into the Dated or Undated section changes its status accordingly.

Dragging an item from the To-Do List and onto a day cell (or the All Day section of the
Multi-Day or Day View) changes its date accordingly, and if the item is an Undated To-
Do, its type is changed to a dated To-Do as well. If the date is in the past, the item is
marked Done on that day; if the date is in the future, the item is simply moved.

Dragging an Event from a calendar View into the To-Do List changes its type to either a
To-Do or an Undated To-Do, depending on which section it is dragged to.
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List View
The List View displays all Event information in a columnar, text-based format. You can
set up the List View so that only certain Event types or certain information contained in
Events is displayed.

Customizing the List View
Use the Define List Layouts dialog box to create and modify List Layouts. To open it,
click the Define List Layouts button in the List View, or choose List Layouts from the
Define menu. The List Layouts dialog box appears.

Refer to “Layout” in Online Help for more information on using the List Layouts dialog
box.

When you create a new List Layout, it appears in the submenu attached to the Use List
Layout option of the Window menu, and also in the pop-up menu found in the List View’s
Toolbar.
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Creating Events
You can create Events in the List View the same way you do in other Views. There are a
few differences in how the Events are displayed and the ways that you change Event at-
tributes.

To create an Event in the List View:
1. Choose the desired Event type from the Event menu, or click the corresponding button

in the Toolbar.

The new Event appears on the current day, or if the displayed time range does not in-
clude the current day, on the first day in the displayed range.

You can create only those Event types that you’ve selected to be displayed in
the current List Layout.

2. Change the new Event’s title by typing.

3. Change other attributes of the Event by tabbing through the columns displayed in the
List View and typing where desired or choosing from pop-up menus.

4. Open the Event Info window if you want to set other attributes of the new Event.

Open the Event Info window by selecting the Event and pressing the Enter key, or by
double-clicking the Event.

Sorting Events
A very useful feature of the List View is its ability to sort Events. You can choose a pri-
mary column by which to sort Events, and up to three additional sub-sort columns.

You can set Sort orders in the Define List Layouts dialog box using the numbered Sort
Order menus provided there, or you can set Sort orders directly in the List View. The fol-
lowing table explains the ways that you can set sorting directly within the List View.

Do this in the column header… To…
Click Make the column’s Event attribute the first-level, or primary

sorting criterion. The column title is underlined and a small
Roman numeral I appears to its upper right.

Shift-click Make a column besides the primary sort column a second,
third or fourth sort column. The column name is underlined
and a small Roman numeral II, III or IV appears to its upper
right.

Option-click Sort the column in reverse order. A downward-pointing ar-
row appears below the column’s Roman numeral.

Option-click again Turn off reverse sorting for the column.
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Modifying the Events in List View
Certain columns in the List View (Priority, Category, Type, Done, and Confirm) provide
pop-up menus for changing their corresponding Event attributes. Clicking in one of these
columns causes a menu to pop up and display a list of options, allowing you to make
changes without opening the Event Info window.

You can also move and resize columns in the List View by dragging.

Navigating through Calendar Views
All of Now Up-to-Date’s views offer many ways to move between Events and days and
switch views. Use the Toolbar buttons to switch Views. Press Tab to move to the next
Event. You can also use the arrow keys to move between days, or use number keys to se-
lect individual days.

Using the Previous/Next Arrows
All views have the Previous/Next arrows and the Today button shown below.

Click the arrows to 
move forward or 
back in the unit of 
time being displayed

Click this button 
to move to the 
current day
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Navigating Using the Go to Date function
Use the Go to Date function to move to a different date in your Calendar File. To use this
function, just click the Go to Date button in any View’s Toolbar, or choose Go to Date
from the View menu.

Customizing Calendar Views
Customize how your schedule will be displayed with the Define Calendar Formats dialog
box, and by using commands in the View menu.

Define Calendar Formats dialog box
You can store different settings as Calendar Formats and switch between them easily. The
Define Calendar Formats dialog box is where you create and modify Calendar Formats.
Click the Define Calendar Formats button in any calendar view or choose Calendar For-
mats from the Define menu to open the dialog box.

Refer to “Format” in Online Help for more information on using the Define Calendar
Formats dialog box.

Once you’ve created a Calendar Format, it appears in the submenu attached to Use Calen-
dar Format in the Window menu. Select Formats from this submenu to switch between
them.
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The name of the month and days of the week, as well as the current date and time, are con-
trolled by the system software. As a result, it’s not possible to modify the name of the
month or the names of the days of the week in Now Up-to-Date (displaying them in
French, for example).

View-specific customizing
Several commands in the View menu let you determine the appearance of your Calendar
File in a particular view. You can toggle each function on and off by choosing it from the
View menu—if a checkmark appears next to the command, it’s turned on; if no checkmark
appears, it’s turned off. Some of these commands are available from the Toolbar or with a
keyboard shortcut.

Choose… To…
Time Display Specify how Appointments appear in your schedule: with no time;

with the start time only; or with both start and end times in one of
three formats.

Event Display Specify whether Descriptions and Marks will be displayed with
Events. Choose Descriptions to display the text from an Event’s de-
scription.

Choose Marks to display special marks attached to Events. These
include:
… an Event that contains a description
= an unread Public Event
+ a Public Event that has been created or edited offline
- the original version of a Public Event that has been edited

offline (not visible unless Show Hidden is active)
? an Unreconciled Public Event
> a Public Event that was created or edited offline and is currently

being sent to the Public Event Server after you have recon-
nected

¬ an Event with attached Contacts
* a Meeting you are invited to

continued next page



5 0 Chapter 4

Choose… To…
continued from previous page

Word Wrap Specify that text in Event titles and descriptions wraps to subsequent
lines until all text is displayed. When you turn off Word Wrap,
Event titles and descriptions are restricted to one line per Event.
(Keyboard shortcut: Command-\).

Show Weekends Display or hide weekends in the Month and Multi-Day Views.

Show Hidden Display Events that you’ve previously hidden. To unhide an Event
when Show Hidden is turned on, select the Event and choose
Unhide Event from the Event menu. (Keyboard shortcut: Command-
;).

Show Toolbar Display or hide the Toolbar in the current View.

Scrolling View Turn the scrolling option on or off in the Month and Multi-Day
Views.

Using Duplicate windows
Another way to customize your Views is to choose Duplicate Window from the Window
menu, which will create an exact duplicate of the active window. You can then set the du-
plicate window to another time period, allowing you to see two different time periods si-
multaneously. Each Window can display its own date range and its own View.

When you quit Now Up-to-Date, all open windows and their sizes and locations are re-
membered, and will be opened in the same orientation the next time you open your Calen-
dar File.
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Organizing Calendar Events
Categories and Sets allow you to filter your calendar information so you can view or print
only certain Events. Using Categories, you can classify related Events together in specific
groups and display them in a distinctive style or color. With Sets, you can control which
Categories are displayed in your calendar.

Using Categories
Every new Calendar File contains one default Personal Category and one default Standard
Set. This one Category and Set may be sufficient for all your needs, particularly if you’re
not using Now Up-to-Date on a network. If you fill your Calendar File with lots of Events,
however, you may find it quite useful to create multiple Categories and Sets so you view
or print only certain Events.

There are two different types of Categories: Private and Public. Private Categories, which
you create and store in your Calendar File, are not shared with other users, even if you’re
on a network. In contrast, Public Categories are stored on a Macintosh running the Public
Event Server software, so that network users can share the Events contained in the Public
Categories. For information on sharing Events and Contacts with Public Categories, see
Chapter 15, “Using Now Up-to-Date and Contact Together on a Network.”

If you’re working with a new Calendar File, any Events you’ve created up to now have
been assigned to the default Personal Category.
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Creating Categories
Create a new Category whenever you want to classify and view a related group of Events.

To create a Category:
1. Choose Categories from the Define menu.

The Define Categories dialog box appears. Notice that =Private= appears next to
Server:—this indicates that any Categories that exist already, or new ones you create,
are Private Categories stored locally in your Calendar File (and not available on the
network, if you’re connected to one).

2. Click New.

The New Category dialog box appears.

3. Type a name for the Category in the Name: field and a description in the Purpose:
field.

Press Tab to move between fields; typing text in the Purpose field is optional.

4. Click OK.

You’re returned to the Define Categories dialog box; notice that the new Category
appears in the Private Categories list.

5. Click OK.

You’re returned to the calendar display.
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Modifying Categories
It’s easy to make changes to an existing Category. The Define Categories dialog box lets
you modify information for a Category, delete a Category, or move it.

Click to select a 
Category from 
the list 

Click to create a new Category 

Click to delete a Category 

Click to move a Category to 
a different server 
Click to change the name or 
description of a Category 

Choose a server

Assigning Events to Categories
Assigning an Event to a Category is quite straightforward. Open the Event Info window
and choose the desired Category from the pop-up menu.

You can set different colors and text styles for individual Categories, so that Event titles
will appear differently in the calendar display according to which Category they belong to.
See “Setting styles and colors for Categories” later in this chapter.

Using Sets
Sets offer additional flexibility in dealing with Categories. You can group Categories into
Sets to establish several displays, each with a particular purpose. For example, your Stan-
dard Set could display all available Categories, while a Work Set might display only those
Categories that relate to your work.

All existing sets are listed at the bottom of the View menu. You can switch between Sets
by choosing them from this menu, or by pressing the keyboard shortcuts shown next to
their names. When you switch Sets, you’ll see a difference in the Events displayed in your
calendar, depending on the Categories subscribed to in the new Set. You can create up to
31 Sets. Deleting a Set does not delete any Categories or Events.

The Sets feature also allows you to specify which Categories you want to receive Remind-
ers from. If you want to receive a Reminder about your 2:00 P.M. meeting, make sure this
Appointment is in a Category that you’ve selected to receive Reminder alerts.

You can have the name of the currently-active Set appear in your Calendar File’s title bar
by selecting this option in the General pane of the Preferences dialog box.
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Creating a Set
Create a new Set whenever you want to set up a new group of Categories to view in your
calendar display.

To create a Set:
1. Choose Sets from the Define menu.

The Define Sets dialog box appears. Use it to create new Sets or modify existing Sets.

2. Click the New button in the Define Sets dialog box.

Or, if you want to use the same configuration as an existing Set, choose the name of
the Set from the Sets pop-up menu and click the Duplicate button.

 We recommend subscribing to the Personal Category (or whichever Category is
specified as your default Category for new Events in the Preferences window) in any
new Sets you create. See “Sets and your default Category” later in this chapter for
more information.

If you are logged on to a Public Event Server, the Sets dialog displays the In-
clude all Events that block my free time checkbox. When this checkbox is se-
lected, you will see Meetings in your Calendar that you’ve marked as
Attending, whether you subscribe to that Meeting’s Category or not. See Chap-
ter 15 , “Using Now Up-to-Date & Contact Together in a Workgroup,” for
more information.

3. Type a name for your new Set and click OK.

4. Click OK to return to the calendar display.

Now Up-to-Date returns you to the calendar display; the Set that was last selected in
the Define Sets dialog box is active.

Modifying a Set
You can also use the Define Sets dialog box to change the configuration of any Set. You
can add or remove Categories associated with a Set, you can change the color and font
style of any Category, and you can indicate the Categories for which you will set reminders.

To modify a Set:
1. Choose Sets from the Define menu.
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The Define Sets dialog box appears.

Click to select a 
Category 

Indicates that the Category 
will receive Reminders.

Choose a Set

Select to set Reminders for 
the selected Category

These settings affect only the 
selected Category or Categories.

Changes the color of the 
selected Category

Sets the text style of the 
selected Category

Click to create a new Set

Click to rename a Set

A checkmark indicates 
that the Category is 
included in the Set. 
Double-click a Category 
to include or exclude a 
Category from a Set

2. Choose the name of the Set to modify from the Sets pop-up menu.

3. Double-click any Category in the Categories in Set list box to add or remove it from
the Set. A checkmark to the left of the Category name indicates that it is included in
the Set.

4. Click any Category in the Categories in Set list box, then select the Receive Remind-
ers checkbox if you want to receive reminders for the selected Category.

5. Click any Category in the Categories in Set list box and choose any color or style set-
tings that you want to apply to the Category.

6. Click OK to return to the calendar display.

Setting styles and colors for Categories
You can set the default style and color of the font for Events in a Category using the De-
fine Sets dialog box, as described in the previous section.

You can also use the Style and Color commands on the Event menu to override a
Category’s style and color setting for a single Event or to set the default style and color for
a Category.

To... Do this...
Set the style and color for a single Event Select the Event and choose the desired

style and color settings from the Style and
Color submenus of the Event menu.

Set the default style and color of a Category Select an Event from the Category you want
to configure, hold down the Option key, and
choose the desired style and color from the
Event menu’s Style and Color submenus.
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When you use the Define Sets dialog box to assign unique color and text styles to Catego-
ries, it doesn’t matter which Set is selected; the settings apply to each Category globally,
no matter which Set is active.

Setting Reminder options for Categories
When you select the Receive Reminders checkbox, you must be subscribed to the selected
Category or Categories in at least one Set—not necessarily the current one—in order to
change the setting.

The Receive Reminders settings controls only whether or not you’ll receive Reminders for
Events in the selected Category or Categories—not what kind of Reminder or when you’ll
receive it. You determine these attributes in the Event Info window. For more information,
see Chapter 3, “Using Now Up-to-Date.”

Sets and your default Category
When you create a new Event, Now Up-to-Date assigns the Event to a Category by de-
fault. This default Category is usually Personal, but you can use the Preferences command
on the Define menu to specify a different default Category.

If you create a new Calendar File and use a Set that does not include the Personal Cat-
egory (or whatever your default category is for new Events), then this dialog box will ap-
pear every time you create a new Event:

You can respond to the dialog box in the following ways:

To: Do this:
Override the default Category for this Event Choose a Category from the pop-

up menu and click Use Once.

Select a default Category for this and future Events Choose a Category from the pop-
up menu and click Set Default.

Avoid future appearances of this dialog box Use the Preferences command to
change your default category for
each Event type to one that is sub-
scribed to in the current Set.

To avoid frequent switching of your default Category or interruption by this dialog box,
it’s usually easiest to settle on one Category to assign as the default for new Events, and
then subscribe to that Category in all of the Sets you create.
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Printing Calendars
Now Up-to-Date lets you print your Calendar File to fit your specific needs. You can print
on the standard paper size that you normally use in your printer, or you can print in page
sizes that fit many popular appointment books such as Day-Timer®, DayRunner®, Franklin
Planner®, and FiloFax®. You can also print your Calendar File to one of three wall chart
sizes for public posting.

The Now Up-to-Date printing functions are compatible with the standard Apple printer
drivers, and support QuickDraw and PostScript printers.

Printing your Calendar
There are many different possibilities for printing your Calendar File. Depending on your
needs and preferences, you might choose very basic printing formats and page sizes, or
you might take the time to customize your print settings carefully and precisely. The fol-
lowing is a basic overview of how to proceed when printing your Calendar File.

To print your Calendar File:
1. Open the calendar View that you want to print.

Select from the Month, Week, Multi-Day, Day, Year or List Views.

2. Modify the appearance of the current View, if necessary, for the desired output.

3. Choose Print Options from the File menu.

The Print Options dialog box appears.

4. Choose the desired View to print from the View: pop-up menu.

The current View is selected by default. The preview graphic in the dialog box
changes to reflect your selection.
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5. Choose the desired page format from the Format: pop-up menu.

The preview graphic in the dialog box changes to reflect your selection.

6. Choose a different Event font and size from that of the current Calendar Format or
List Layout, if desired.

Make your selections from the Event Font: and Event Size: pop-up menus.

7. Set the time range for printing, if you’re printing a time-based format.

If you’re printing the Multi-Day or Day View, choose a starting time and an ending
time from the two Hour Range to Print: pop-up menus.

8. If you chose an appointment book page size in step 5, make any changes desired to the
appointment book settings in the bottom portion of the dialog box.

9. Set the other options in the dialog box as desired.

For instance:

• Select the appropriate checkboxes to determine whether standard headers and/or
custom headers and footers are printed.

• Click Headers if you want to create or modify custom headers and footers for your
printed output.

10. Click Print.

The Print dialog box appears. Your format, page size, and page orientation selections
are reflected here.

11. Specify the beginning of the period to print by typing a date in the appropriate fields.

The text will read Month Starting:, Week Starting:, or Starting Date: depending on the
View you selected.

12.. Specify the number of months, weeks, or days to print.

Type a number in the [Period]s to Print: field.

13. Select other options as desired.

Click Headers or Print Options to change options in those areas, or select the Print to
PICT File checkbox. Select Manual Feed if you’re printing double-sided output.

14. Click Print.

Your Calendar File is printed. If you’re printing an appointment book with double-
sided page output, a series of dialog boxes will appear prompting you to reinsert your
pages into the printer.

Now Up-to-Date remembers the settings you enter for the print job, so that you can simply
choose Print from the File menu the next time you want to print the same output (though
the Period to Print area will always reflect the current date).
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Setting printing options
To configure your printing options, choose Print Options from the File menu. The Print
Options dialog box appears.

Not all of the Print Options dialog box components shown in the above illustration are
available for every type of printing.

You can print any of the calendar Views that are available in your Calendar File. Just set
up any Calendar Format or List View Layout you like, then print exactly what appears on
screen.

Any of the printing formats can be printed to the page size of your choice. Now Up-to-
Date prints on standard paper sizes such as Letter (8.5" x 11"), Legal (8.5" x 14"), and A4
(21 cm. x 29.5 cm.). Select the desired paper size using the Page Setup command in the
File menu.

Use this option… To…
View Select a view for printing. Choose from Views as they ap-

pear on your screen, or Current Event, which prints infor-
mation for the currently selected Event.

Format Control the format of the printed page on the page size of
your choice. Choose from one, two, and four per page; wall
chart; or an appointment book size. Appointment book size
formats offer additional formats, described below.

General printing options Control various additional formatting options.

Appointment book options Control appointment book printing when you’ve selected
one of the appointment book sizes from the Format: pop-up
menu.
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Appointment book printing
Now Up-to-Date includes several page size options that let you print the selected View to
pages that fit your paper appointment book. Now Up-to-Date supports the following ap-
pointment book sizes:

• Day Timer Sr. Desk, Jr. Desk, Sr. Pocket, and Jr. Pocket
• Day Runner Classic, Entrepreneur, Running Mate
• Franklin Classic, Monarch, and Compact
• FiloFax

Appointment book options
Options specific to appointment book printing are available when you’ve selected one of
the appointment book sizes from the Format: pop-up menu. These options appear at the
bottom of the Print Options dialog box.

Choose… To…
Cut/Punch Guides Set cutting guidelines and hole punch guides.

Page Output Determine the order in which pages are printed.

Print Across Two Pages Print the selected View across two appointment book pages.

Prompt for Page Flips Specify that a dialog box will prompt you to flip the printed
page and reinsert it each time a page has been printed.

Holes on Outside Print the hole orientation that matches the paper you’re using.
Select Outside when you’re printing on plain paper, since you
can use it to simulate double-sided printing with the Folding
Pages setting in the Page Output: pop-up menu.  It offers a
larger print area since the holes are in the margins.

Holes on Left Print the hole orientation that matches the paper you’re using.
For sheets with pre-punched holes on the left of each page,
select Left.

Page Output options
The options in the Page Output: pop-up menu determine how each page is placed, and the
order in which pages are printed. These options are listed in the following table.

Choosing… Produces this…
Double-Sided True double-sided output that requires turning over each

printed sheet and re-feeding it into the printer. See “Printing
double-sided output easily” later in this chapter for more in-
formation on this feature.

When you choose this feature, turn off Background
Printing in the Chooser, and select Manual Feed in the
Print dialog box. A dialog box prompts you to turn the
sheet over and reinsert it into the printer.

continued next page
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Choosing… Produces this…
continued from previous page

Folding Pages Simulated double-sided printing for use with the appointment
book page sizes available in the Format: pop-up menu. Pages
are printed two at a time, with hole punch guides appearing in
the outside margins of the full sheet printed. When the two
pages that appear on a sheet are folded down their middle
guideline, the hole punch guides meet and can be punched
once. The result is one simulated double-sided page that is
actually two sheets thick.

Week View printed Across Two Pages on Folding Pages

Single-Sided (Reversed) Prints the pages with hole punch guides in the outside mar-
gins of the full printed sheet. When the two pages are cut out
and placed in an appointment book, they form a two-page
spread, as shown below.

continued on next page
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Choosing… Produces this…
continued from previous page

 Week View printed Single-Sided, Across Two Pages

Left or Right Page Only Prints only left-hand or right-hand pages according to your
selection, with hole punch guides on the left or outside. Print-
ing the right page only with holes on the outside, for ex-
ample, causes the output to appear on the left side of the
printed sheet (as shown in the illustration below). As a result
of the hole orientation, however, this is actually a right-hand
appointment book page.

 Week View printed Right Page Only

Printing double-sided pages easily
You can avoid traveling back and forth between your Macintosh and printer when printing
double-sided output by using the following procedure.

To set up double-sided printing:
1. Open PrintMonitor.

PrintMonitor is located in the Extensions folder in your System Folder.

2. Choose Preferences from the PrintMonitor File menu.

The PrintMonitor Preferences dialog box appears.

3. Select Give no notification under When a manual feed job starts: and click OK.

4. Switch to Now Up-to-Date.

PrintMonitor automatically quits.
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5. Choose Print Options from the File menu.

The Print Options dialog box appears.

6. Deselect the Prompt for Page Flips checkbox and click OK.

7. Choose Print from the File menu.

The Print dialog box appears.

8. Select Manual Feed from the Paper Source pop-up menu.

9. Click Print.

10. Insert the first page for printing.

After this page is printed, the printer’s Insert Paper indicator light lets you know that
you should flip the page and reinsert it.

11. Reinsert the page in the printer.

The printer prints the reverse side.

12. Repeat steps 10 and 11 until the job is finished.

Offsetting double-sided printing
You can correct paper-feeding inconsistencies with your printer that sometimes cause the
front and back of a double-sided page to be misaligned.

To accurately align double-sided printing:
1. Choose Print Options from the File menu.

The Print Options dialog box appears.

2. Choose Double-Sided from the Page Output pop-up menu.

3. Click Margins.

The Margins dialog box appears.

4. Enter the distance by which you want to offset the printing in the Margins dialog box.
You can estimate the amount to offset by holding a misaligned page up to a bright
light.

5. Click OK.

6. Click Print to produce a test print.

If the new test print aligns properly, you should be able to continue to use the same
offset on all of your double-sided printing. If the new test print is still slightly mis-
aligned, you should repeat the steps above using a new estimate for the offset.
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Creating custom headers and footers
You can add custom headers and footers to your printed Calendars. Custom headers and
footers can appear in addition to or place of the standard headers that are part of the nor-
mal Views.

For example, you can print a calendar for the month of November showing your
company’s staff meetings with only the standard header (November 1999), the standard
header and an additional custom header (November 1999-Company Staff Meetings), or
only a custom header (Company Staff Meetings for November 1999).

To configure custom Headers and Footers:
1. Select Print Options from the File menu or click Print Options in the Print dialog box.

The Print Options dialog box appears.

2. Select the header and footer options you want.

Select the Standard Headers checkbox if you want the standard headers for the current
View to appear on your printout. Select the Custom Headers and Footers checkbox if
you want custom headers.

3. Click Headers.

The Headers and Footers dialog box appears.

Enter custom 
header and 
footer text

Page number

Print date

Print time

Calendar File name

Your user name

Month for the 
printed date range

Year for the printed 
date range

Choose font 
settings

Click to insert:

4. Enter any text that you want in the Header and Footer fields provided.

5. Click the appropriate icons to automatically insert the current page number, date,
time, calendar file name, user name, month or year at the current location of the inser-
tion point.

6. Click OK.
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Now Up-to-Date print settings
When you choose Print from the File menu or click the Print button on the Toolbar, the
standard Print dialog box for your printer appears. The bottom half of the Print dialog box
contains additional options for printing your Calendar. The settings in this area are listed
below; for information on the options contained in the standard portion of the dialog box,
consult your Macintosh documentation.

Printing problems
Some third-party printer manufacturers include custom Chooser devices for use with their
printers. In some cases, these Chooser devices (drivers) are nonstandard and have diffi-
culty working with the enhanced printing available in Now Up-to-Date. If you have
trouble using the settings available in Now Up-to-Date’s Print Options dialog box with
your printer, or if you notice lines missing from your printed output, you may need to se-
lect the Use non-enhanced printing checkbox in the General pane of the Preferences win-
dow. Fewer printing options will be available to you, but you should have more success in
printing your Calendar File.
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Chapter 7

Importing, Exporting
and Archiving Events

Now Up-to-Date’s flexible Import function makes it easy to bring schedule information
into your Calendar File—from a different Calendar File, or from any application that can
create a tab-delimited text file. The Export function allows you to create a text file contain-
ing event information that can be opened and used by a word processor, spreadsheet, or
database application. With the Archive function, you can remove old Events from your
Calendar File to improve performance, and then easily restore them, if necessary, at an-
other time.

Importing data into your Calendar File
Before importing data into your Calendar File, examine the file you wish to import to de-
termine what data it contains and in what order the data appears. Then, use this informa-
tion to select or create an Import Template, as described below.

When you use the Import function, we recommend that you first import your information
into a new, untitled Calendar File. This way, if any problems occur, your regular Calendar
File is unaffected.

The Sample Calendar included with your software contains Templates for importing data
from other calendar applications.

To import data into your Calendar File:
1. Choose From Text File from the Import submenu of the File menu.
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The Import dialog box appears. It contains a Template menu and numbered data field
menus that you set up according to the fields in the import file.

Select to import 
repeating Events 
as a linked series

Choose a Template 

Select to create a new Private 
Category when the imported 
Event's Category doesn't match 
existing Categories in your 
Calendar file

Set these fields to 
match the fields in 
the import file

Click to create a new 
Import Template

Click to copy an 
Import Template

Click to delete an 
Import Template

2. Select a Template from the Standard Template menu, or create a new Template by
clicking New.

3. Set the import fields to match the order of the data fields in the import file.

If your import file contains data that’s not applicable to or usable by Now Up-
to-Date, choose Ignored from the pop-up data field menus for fields containing
such data.

4. Set the desired option for importing repeating Events.

Repeating Events are normally linked in Now Up-to-Date.

5. Set the desired option for creating Private Categories on-the-fly.

Select this option to create a Private Category each time Now Up-to-Date encounters a
Category in the imported file that doesn’t match an existing Category in your Calen-
dar File. Deselect to place Events from a non-matching Category in your Default Cat-
egory.

6. Click OK.

A directory dialog box appears, prompting you to locate and select the file to be im-
ported.

7. Locate and select the desired file, and click Open.
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A progress bar appears as the file is imported. When it is finished, the new Events
from the imported file appear in your Calendar File.

If any problems or errors occur while Now Up-to-Date is importing the file, a
dialog box will appear indicating the nature of the problem. The error message
will usually tell you where in the import file the problem occurred, so that you
can open the file in a word processor or spreadsheet application and double-
check the field order against the incoming field order you have specified in the
Import dialog box.

Exporting data from your Calendar File
Exporting calendar information from Now Up-to-Date allows you to use it elsewhere. The
Export function creates a tab-separated text file that contains Events and their selected at-
tributes within a date range that you specify.

Using the functions available in the Export dialog box, you can also control which Event
attributes are exported, as well as the order in which the corresponding data fields will ap-
pear for each Event.

To export data from your Calendar File:
1. From the View menu, choose a Set that includes only the Categories you want to ex-

port.

All Events contained in the Categories (both Private and Public) that you’re sub-
scribed to in the current Set will be exported. Be sure that the Categories included in
the current Set contain Events that you want to export.

2. Choose To Text File from the Export submenu of the File menu.
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The Export dialog box appears.

3. Choose a Template from the Export Template: menu.

The names Standard Template and Calendar Archive appear on the menu. These are
built-in Templates that are included in every new Calendar File.

4. Modify the attributes of the pop-up menus, if desired.

Five Event attributes are selected for exporting by default; these are the most com-
monly-used attributes. For each exported Event, these attributes will appear in the Ex-
port text file as tab-separated data fields. The numbered items in the dialog box
indicate the order in which the data fields will appear in the Export text file for each
Event.

Choose attributes from these menus to include them in the Export file and set their
field order, according to your requirements. Choose None from the pop-up menus for
any remaining fields.

5. Select checkboxes as desired to determine which Event types will be included in the
Export file.

6. Click OK.

A directory dialog box appears, prompting you to select a destination for the Export
file and name it.

7. Choose a location for the Export file, enter a name, and click Save.

A progress bar appears as the Export file is created. When the operation is completed,
you can open the Export file in the application of your choice.

If you created a new Template or modified an existing one, the Export Template
has been saved, and will be the selected Template the next time you open the
Export dialog box. Any Templates available in the Export dialog box will also
be available in the Import dialog box, so that you can easily import data of the
same format.
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Archiving data from your Calendar File
The Archive function allows you to decrease the size of your Calendar file by removing all
Event data that’s older than a specified number of months and saving it in a text file. The
text file allows you to retrieve this information at a later date should you ever need to do
so. You can archive Events from all of your Private Categories, as well as from Public
Categories whose Owner Passwords you know.

To archive data from your Calendar File:
1. From the View menu, choose a Set that includes only the Categories you want to ar-

chive.

In general, be sure that the Categories you’re subscribed to in the current Set contain
Events that you really want to archive. Only Events from Public Categories for which
you can provide the Owner Password will be archived.

2. Choose Archive from the File menu.

The Archive dialog box appears.

Enter a number 
from 1 to 99.

Select archiving options. 
You must have the Owner 
Password to archive from 
Public Categories.

3. Type the number of months for the minimum age of the Events you want to archive.

4. Depending on the desired result, select the checkbox(es) for the appropriate Catego-
ries you want to archive.

5. Click OK.

A directory dialog box appears, prompting you to select a destination for the Archive
file and name it. The default name for the Archive file includes the date of the most
recent Events it contains.

6. Choose a location for the Archive file, enter a name, and click Save.

If you’re archiving any Public Categories, you’ll be asked to enter their Owner Pass-
words now. In the password dialog box, click Cancel to cancel the Archive operation
entirely, or click Skip to cause the Category to be skipped, while allowing the Archive
operation to continue.

Once the Archive file has been created and saved, Now Up-to-Date deletes the ar-
chived Events from your Calendar File and from the Public Event Server.
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Working with Contacts
Now Contact makes it easy to create new Contacts, modify existing ones, and attach other
information to them, like documents, Events, and date and time stamps. Now Contact also
provides flexible options for finding and selecting Contacts from your Contact File.

Creating a Contact File
Before you begin creating Contacts, you need to create a Contact File.

To create a Contact File:
1. Open Now Contact.

A standard directory dialog box appears.

To users of earlier versions: If you’re upgrading to Now Contact from version
1.0 through 3.6.5, you can continue to use your existing Contact File. Just lo-
cate and select the file you want to use, then click Open to update it to the cur-
rent format. An unchanged copy of the old file is saved in case you ever need to
use the older version.

2. Click New.

A second directory dialog box appears.

3. Select the location for your new Contact File.

4. Type a name for your Contact File in the “Save Contact file as” field.

5. Select “Make this my primary file,” if desired.

Designating the file as primary means that it will open automatically whenever you
open Now Contact.

6. Click Save.

Your file is saved, and Now Contact opens. You can now begin creating Contacts.
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Setting a primary Contact File
Make the Contact File you use most often your primary file. Your primary file opens auto-
matically whenever you open Now Contact, and is the file whose selected Contacts display
in the QuickContact pull-down menu (see Chapter 13, “Quick Access Features,” for more
information on QuickContact). Your primary Contact File also serves as the source for
Contacts you link to Calendar Events from within Now Up-to-Date; see Chapter 14,
“Linking Events and Contacts,” for details on linking Now Contact and Now Up-to-Date.

Creating a new Contact
Creating a Contact is simple: just choose New Contact from the Contact menu, or click the
New Contact button in either the List View or Detail View Toolbar. The Detail View
opens and displays a new Contact record with blank fields.

Entering Contact information
Once you’ve created a new Contact, you can enter information into its various fields. Press
Tab to move forward through the fields, or Shift-Tab to move backward. When you finish
entering Contact information, close the Detail View to save the new Contact.

You can configure how your new Contacts are set up in the New Contacts pane of the
Preferences window. See “Setting New Contact preferences” later in this chapter for more
information.
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Using data entry aids
AutoType™, Now Contact’s set of data entry aids, makes creating new Contacts (and
modifying existing ones) fast and simple. Automatic Address Entry and Automatic Typing
scan the other Contacts in a Contact File and determine if they contain data that could ap-
ply to new Contacts. It works for numbers as well as for text.

Automatic Address Entry and Automatic Typing are both configured in the Data Entry
Aids pane of the Preferences window. See “Setting Data Entry Aids preferences” later in
this chapter for more information.

Drag and drop editing is available with all of the fields in the Detail View, including the
Contact Log and the Contact information blocks. Simply select text in one field and drag it
to another field.

To use Automatic Address Entry:
1. Enter a company name in the Company field.

If an existing Contact works for the same company, that Contact’s work address auto-
matically appears in the new Contact’s Work Address block. If there are multiple ad-
dresses for that company in the Contact File, Now Contact enters the address that
occurs most often and a small arrow () appears in the upper-right corner of the
Work Address block.

2. If the address entered in step 1 is incorrect, click the arrow in the Work Address
block.

A pop-up menu of the various addresses defined for that company in the Contact File
appears; the number of Contacts who use each address appears in brackets next to the
address.

3. Choose the work address you want to use for the new Contact from the pop-up menu.

If none of the addresses applies to the new Contact, tab into the Work Address fields
and type over the information.

4. Complete the other fields in the Name block as desired.

To use Automatic Phone Entry:
1. Enter the work telephone number for your new Contact in the Detail View Work field.

When you tab into the Fax field, Now Contact automatically displays the area code
and prefix from the entry in the Work field. The area code is also automatically en-
tered in the other phone entry fields you’ve defined. You can either accept the entry
and add the remainder of the number, or remove the automatic entry and type in the
correct area code or prefix. Tabbing out of the field removes the automatic entry.

2. Accept the automatic entry, type in a new area code and prefix, or simply tab out of
the field.
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To use Automatic Typing:
1. Enter information for your new Contact in the Detail View fields.

Now Contact looks for the most frequently occurring match in other Contacts.

2. Accept the automatic entry, or continue typing.

Other suggestions may appear as you type more letters, depending on the other entries
in the Contact File. To reject an entry, just keep typing.

The following table lists other options for the automatic entries that appear.

Press… To…
Tab Accept the entry and move to the next field.

Command-+ (plus) Display the next similar entry. When you press this key com-
bination, similar entries appear in the field according to the
next alphabetical match.

Command-- (minus) Display the previous similar entry.

Backspace/Delete Delete the highlighted suggestion.

Customizing Contacts
Now Contact lets you add different types of information to a Contact. You can attach
Notes, Comments, documents and Web links; add Events such as Meetings or To-Dos; and
date- and time-stamp Notes and Events.

Selecting Contacts
Select a single Contact in the List View by clicking once on any of its fields; double-click
a field to open the Contact’s Detail View. To select all of the Contacts in the List View,
choose Select All from the Edit menu.

To select Contacts that are all adjacent to each other, hold down the Shift key as you click
Contacts. You can click each Contact individually, click and drag to the last Contact you
want to select, or click the first Contact you want to select and then the last one.
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To select Contacts that are not all adjacent to each other, hold down the Command key as
you click Contacts. You can click Contacts individually or drag through any adjacent Con-
tacts that you want to select.

Attaching Comments to a Contact
Using the Comments field in the Detail View, you can add personal comments for each of
your Contacts. The information you enter in the Comments field can be up to 32K (about
16 pages) long.

To attach Comments to a Contact:
1. Click in the Comments field.

You can also press the Tab key from the last entry field in the Contact informa-
tion blocks to move to the Comments field.

2. Enter any comments you want to make about this Contact.

The information you enter in the Comments field cannot be shared with networked
Now Contact users. To share the information, drag the portion of the comment you
want others to view into the Contact Log window and attach it to the Contact as a
Note.

3. When you are finished typing your comment, close the Detail View.

Attaching Notes to a Contact
Now Contact allows you to attach Notes to each Contact in your Contact File; each Note
can be up to 32K (about 16 pages) in size. Notes include a timer and date/time stamp to
help you keep track of Contact activities, such as telephone conversations.

You can create a new Note by selecting text in the Comments field or in an open text file
and dragging it to the Contact (in either the Detail or List View).
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To attach a Note to a Contact:
1. Open the Detail View for the Contact to which you want to attach a Note, or select the

Contact in the List View.

2. Choose New Note from the Contact menu.

The Note window appears with the Title: field selected.

3. Type a descriptive title for your Note in the Title field.

If you don’t enter a title, your note will be labeled New Note in the Contact Log.

4. Click in the text field and type the text that you want to attach to the Contact.

5. When you’re finished typing text, close the Note window.

The new Note is attached to your Contact.

To copy a Note between Contacts, drag it from a Contact Log and drop it on a
Contact in the List View.

Attaching documents to a Contact
Now Contact lets you attach documents to a Contact. Attached documents appear as en-
tries in the Detail View Contact Log; double-click an entry to open the document in the
application that created it.

To attach a document to a Contact:
1. In the List View, select the Contact to which you want to attach a document, or open

its Detail View.

2. Choose Attach Document from the Contact menu.

A standard directory dialog box appears.

3. Locate and select the document you want to attach, then click Attach.

The document is attached to your Contact, and an entry is added to the Contact Log.
Contact Log document entries are sorted in reverse chronological order by the date
they were attached, so that the documents attached most recently appear at the top.

You can also attach a document to a Contact by dragging it from the Finder and dropping
it on the Contact (in either Detail or List View).
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Attaching World Wide Web links to a Contact
You can attach Web page links to any Contact. Web link attachments let you keep track of
Web pages related to a Contact, and make it easy to open the corresponding pages in your
Web browser. Web link attachments include the name of the linked page or site and its
URL, or address. You attach Web page links by dragging them from a browser window, or
by entering them directly in Now Contact.

To drag a Web page link to a Contact:
1. Make sure Now Contact is open.

You can drag a Web link to a Contact in the List View, or to the Contact Log in a
Contact’s Detail View. If you drag to the List View, make sure that the Contact you
want to attach the link to is displayed.

2. In your Web browser, select a link and drag it to the Contact.

In some browsers, when you hold the mouse over a link for too long before
dragging, a pop-up menu may appear. If this happens, just move the pointer off
the menu and try again.

3. In Now Contact, open the Contact’s Detail View if it isn’t already open.

The Web link attachment appears in the Contact Log, along with attached Notes,
documents and Events.

4. To open the linked URL in your Web browser, double-click the attachment while
holding down the Option key.
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To create a Web page link in Now Contact:
1. Open the Detail View for the Contact to which you want to attach a Web link.

2. Click the New URL button in the Detail View Toolbar.

The URL window appears.

You can also open this window by selecting the Contact in the List View and
choosing New URL from the Contact menu.

3. Enter the Web link information in the appropriate fields.

4. Close the window to return to the Detail View.

The Web link attachment appears in the Contact Log, along with attached Notes,
documents and Events.

5. To open the linked Web page in your Web browser, double-click the attachment while
holding down the Option key.

You can edit Web link attachments by double-clicking them in the Contact Log. The Edit
URL dialog box appears, where you can change Web link attributes.

Creating Calendar Events for a Contact
Now Contact provides the ability to track your interaction with your Contacts by creating
and logging Calendar Events. All of the Calendar Events you create for a Contact are listed
in the Contact’s Contact Log so that you can easily view your history with the Contact.

Now Contact integrates seamlessly with its companion calendar product, Now Up-to-
Date. For more information on how the two applications can communicate, see Chapter
14, “Linking Events and Contacts.”

Calendar Event types
Now Contact provides six Event types for you to choose from, each of which has a spe-
cific purpose for your Contacts.

Event Type Purpose
Call A telephone call to be made on a specific date and time.

Appointment A date- and time-specific task, such as a meeting or interview, that has
a start time and an end time. Both the start and end times can be set in
one-minute increments.

continued on next page
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Event Type Purpose
continued from previous page

To-Do A task to be done on a specific date and time.

Undated To-Do A task that has no specific deadline and is not date-specific.

Special A task that spans an entire day rather than being attached to a specific
time on a day.

Holiday Like a Special Event, only designed to represent a holiday.

You create Calendar Events by choosing the appropriate command from the New Event
submenu in the Contact menu, or by using the Event buttons in the Detail View Toolbar.
(See “Detail View” in Chapter 9, “Viewing Contacts,” for information on Calendar Event
buttons.)

To create a Calendar Event for a Contact:
1. Open the Detail View for the Contact to which you want to attach a Calendar Event.

2. Choose the Event type you want to attach from the Contact menu or Toolbar.

The Event Info window for the Event appears. You can enter information for the new
Event.

The Event Info window differs slightly for each Event type. A To-Do window
appears above (it contains all Event Info window components).

3. Use the options in the Event Info window to set up the new Calendar Event.

4. Click OK.

The Calendar Event you created now appears in the Contact Log of the Detail View.
Double-click a Calendar Event in the log to open the Event Info window for that
Event.
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Using the Timer and Date/Time Stamp
Using the Timer in your Notes and Calendar Events lets you keep track of the time it takes
to perform a Contact-related activity, such as a telephone conversation. In addition, the
Date/Time Stamp allows you to time more than one activity per Note or Event.

To time an activity and place a date/time stamp:
1. Click in the text field of the Note or Event Info window.

2. Click the Timer button in the upper-left corner of the window.

The current date and time are inserted at the top of the text field, whether or not it
contains text. The Timer field begins counting down the elapsed time.

3. To stop the Timer and place a second Date/Time Stamp in the text field, click the
Timer button again.

Now Contact inserts the current time to the immediate right of the previous date/time
stamp, followed by the elapsed time between the initial date/time stamp and the sec-
ond one.

You can click the Detail View window to return to the Contact without stopping
the Timer.

4. Enter any additional text for the Note or Event, then close the window.

Defining Custom Fields
Now Contact provides you with eight Custom Fields that you can set up to hold whatever
additional Contact information you like.

Custom Fields are Category-specific, meaning that a Contact can have different Custom
Fields available depending on which Category you assign it to (including the Contacts in
Public Categories). This allows you to have different Custom Fields for personal friends
than you might for business associates. For more information on using Categories, see
“Using Categories” in Chapter 10, “Organizing Contacts.”
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To define Custom Fields:
1. Choose Custom Fields from the Define menu.

The Define Custom Fields dialog box opens.

Choose a Category 
to define fields for

Type a name for 
the custom field, 
up to 8 characters

Click to copy custom fields 
from another Category

Type a short 
name for the 
custom field, up 
to 3 characters

Choose a field type 

2. Choose a Category from the Category pop-up menu.

3. Type the Long field name that you want to appear in the Custom Field block of the
Detail View.

4. Type the short field name that you want to appear in all locations other than the Detail
View (such as the List View).

5. Select the type of field you want the Custom Field to be from the Field Type pop-up
menu.

Choose from one of five available field types.

Field type Attributes
Text Text entry. This is the default type for all Custom Fields.

Phone Telephone numbers, using the format specified in the Data Entry Aids
pane of the Preferences window.

Date Date entries. Adheres to the format set for your Macintosh in the Date
and Time control panel.

Money Monetary figures. The Money field format is $00,000,000.00 (the dol-
lar sign is entered automatically).

Number Non-monetary figures. The Number field format is 00,000,000.00.

6. Click OK.

Your Custom Field settings are saved.
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Adding URLs and E-mail addresses in Custom Fields
You can include World Wide Web page URLs and e-mail addresses in any Custom Field.
This lets you easily keep track of a Contact’s home page and e-mail address. You can
manually enter URLs or e-mail addresses in Custom Fields, or you can drag them there
from Web pages.

Like telephone numbers, URLs and e-mail addresses have icons at the end of their fields.
When you click a URL icon, the corresponding Web page opens in your Web browser;
when you click an e-mail icon, your e-mail application opens and creates a new message
pre-addressed to that Contact.

To enter a URL or e-mail address in a Custom Field:
1. Open the Contact’s Detail View.

2. Type the URL or e-mail address in an empty Custom Field.

Now Contact recognizes the URL and e-mail address format, and automatically places
the corresponding icon at the end of the field.

Custom Field E-mail addresses in earlier Now Contact files are recognized as
such when you open the files in version 3.8. The appropriate icon is added to
the field(s).

3. Click the icon at the end of the field to open the corresponding Web page (for URLs)
or your e-mail application (for e-mail addresses).

To drag a URL or e-mail address to a Custom Field:
1. Open the Contact’s Detail View.

2. In your Web browser, select a link and drag it to the Contact.

You can drag Web page links or linked e-mail addresses (addresses that appear in the
same color text as page links).

3. Drop the link on a Custom Field.

The URL or e-mail address appears in the field. Now Contact automatically places the
corresponding icon at the end of the field.

Selecting primary e-mail addresses
If you enter more than one e-mail address for a Contact, you can specify a primary ad-
dress. The primary address you select determines how the Contact’s E-mail is addressed
when you’re in the List View.

By default, the first address you enter is primary. To change the primary address, just
place the pointer over the proper address; when the pointer changes to the Primary Field
Selector ( ), click the address. The address becomes underlined, and is now primary.
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Addressing e-mail from the List View
You can select one or more Contacts in the List View and create e-mail messages for them
in your e-mail application.

Once you’ve selected the Contacts, just click the Send E-Mail button in the Toolbar or
choose E-Mail from the Contact menu. Your e-mail application opens with a new, pre-
addressed message for each of the Contacts you selected.

If a Contact has more than one e-mail address defined, the primary address is used; see the
preceding section for details.

Duplicating Contacts
Duplicate a Contact when you want to create a new Contact that is nearly an exact copy of
an existing one. You can duplicate Contacts from the List View or the Detail View.

When you duplicate a Contact, the original Contact’s Notes, Comments, attached Docu-
ments, attached Calendar Events and Keywords are not included.

To duplicate a Contact:
1. Select the Contact you want to duplicate in the List View, or open the Contact’s Detail

View.

2. Choose Duplicate Contact from the Edit menu.

The Contact is duplicated, and the duplicate version now appears in the Detail View
for you to edit.

Deleting Contacts
You can easily delete Contacts that are no longer useful in your Contact File.

Be very careful when deleting Contacts; the deletion cannot be undone.

To delete a Contact:
1. Select the Contact you want to delete in the List View.

2. Choose Delete Contact from the Edit menu, or click the Delete Contact button in the
Toolbar.

A dialog box appears, asking you to confirm that you want to delete the selected
Contact.

3. Click OK.
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Using Copy Contact Info
Use the Copy Contact Info function to copy a Contact’s name and address or other infor-
mation into a different type of application. Now Contact allows you to modify the format
of the information to suit your needs.

Copying Contact information
Copying Contact information is as simple as selecting the desired Contact and using the
Copy Contact Info command in the Edit menu.

To copy Contact information:
1. Open the Detail View for the Contact whose information you want to copy, or select

the Contact in the List View.

2. Choose the appropriate command from the Copy Contact Info submenu of the Edit
menu.

Each submenu option of the Copy Contact Info command offers a different format for
the copied information. See  “Setting Copy Contact Info preferences” later in this
chapter for more information.

The Contact information is copied to the Clipboard. You can now switch to another
application and paste the formatted Contact information in a document.

Replacing text
You can quickly replace Contact information in a number of Contacts, without having to
open the Detail View for each individual Contact. The Replace function is available only
in the List View.

To replace Contact information:
1. In the List View, choose Replace from the Edit menu.

The Replace dialog box appears.

Type the text to replace here

Type the new text here

Click the fields you 
want to search

Click to replace the text

2. Type the text you want to replace in the Replace field.

Enter the text as it appears in your Contacts, with the proper capitalization, punctua-
tion and spelling. You must enter the entire contents of a field for a match to occur.
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3. Type the replacement text in the With field.

Enter the text exactly as you want it to appear in your Contacts, with the proper capi-
talization, punctuation and spelling.

4. In the scrolling list of fields, select the fields where you want to replace the text.

To select the fields, place the pointer over the appropriate field name and click. A
checkmark appears to the left of the fields you select. Now Contact replaces the Con-
tact information only in the fields you select.

5. Click Replace All.

A dialog box appears, asking you to confirm the replacement.

6. Click OK.

The Contact information is replaced in your Contact File.

Changing addresses
When you change a Contact’s address in the Detail View and other Contacts in the Contact
File have the same address, the dialog box below appears.

You have the option of changing only the current Contact’s address, all Contacts with that
address, or all Contacts with the same company name. Select the appropriate radio button
and click Change.

Swapping addresses
The Swap Addresses function swaps the Work and Home addresses in one quick step. It’s
also handy when you’re dealing with Contact information you’ve just imported. The Swap
Addresses function is available only in the Detail View.
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Setting preferences for Now Contact
Use Now Contact preferences to tailor its operations to your work style.

Refer to “Preferences” in the Online Help for more information on the Preferences op-
tions.

Setting New Contact preferences
New Contact preferences provide you with control over how your new Contacts are set up
when you create or import them.

Select a field 
from this list

Enter default text or numbers 
for the selected field

Click keywords to set them as 
defaults for all new Contacts. 

Click to automatically 
mark new Contacts

Click to include new Contacts in 
the QuickContact menu

Choose from 
these pop-up 
menus to assign 
defaults for 
each option

To tailor your new Contact primary address information for international Contacts, choose
one of the options that includes the Postal field, which refers to postal codes for interna-
tional addresses (the equivalent of U.S. ZIP codes).

You can also specify an address format for a new Contact by choosing the appropriate
command from the Address Format submenu of the Contact menu. This allows you to
override the default format for specific Contacts. (The Address Format submenu is avail-
able only when you’re in the Detail View.)
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Setting Data Entry Aids preferences
Automatic Address Entry and Automatic Typing are configured in the Data Entry Aids
pane of the Preferences window.

Choose from these pop-up 
menus to assign defaults 
for the selected field

Click a radio button to turn all 
Data Entry Aids on or off

Click to turn Automatic 
Address Entry on or off

Click to turn Automatic 
Typing on or off

Choose a Phone Format 

Select a field from this list

All of the data entry aids, except automatic typing, are turned on by default; you can turn
them all off by selecting the Off radio button at the top of the pane, or you can turn them
off selectively using the checkboxes.

When you’re defining phone formats, use the symbol # to signify the numbers entered in a
Contact’s phone field. Any other letters, numbers or symbols you type in a phone format
(such as hyphens and parentheses) are treated literally, and are auto-entered for all phone
numbers when that phone format is active.

Setting Copy Contact Info preferences
You can create multiple Contact Info Formats that are available from the Edit menu’s
Copy Contact Info submenu. Three predefined Contact Info Formats are available in every
new Contact File.

Choose a Format to duplicate, delete or rename

Click to create a new Format

Click to duplicate the 
selected Format

Click to delete the 
selected  Format

Click to rename the 
selected Format

Click to include the short field 
labels with the copied Contact info

Choose fields to include 
in the Format 

The fields included in the 
selected Format appear here
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All of the items in the Insert pop-up menu correspond to the Contact information fields in
the Detail View, except for the following:

Field Contents
«Listing» The name (Contact or Company) that you’ve selected as Primary for a

given Contact. See “Primary Fields” in Chapter 9, “Viewing Contacts”
for more information.

«PriAddress» The street address field from the address block (Work or Home)
you’ve selected as Primary for a given Contact.

«PriCity» The City field from the address block you’ve selected as
Primary.

«PriST» The State field from the address block you’ve selected as
Primary.

«PriZip» The ZIP Code field from the address block you’ve selected as Primary.

«PriCntry» The Country field from the address block you’ve selected as
Primary.

«PriPhone» The telephone number (Work, Home, Fax, Mobile, or any Custom
Field defined as a telephone number) you’ve selected as Primary for a
given Contact.

«FullPriAddress» All of the Primary Address fields you’ve assigned for a given Contact
(PriAddress, PriCity, PriST, PriZip and PriCntry).

Setting General preferences
The General preferences settings control several aspects of Now Contact’s general opera-
tions. To set your General preferences, choose General from the Preferences submenu of
the Define menu. The General pane of the Preferences window appears.

Use this pop-up menu… To…
Date Stamp format Choose the format for the Date/Time stamp in your Notes and

Calendar Events. You can stamp the date only, the time only,
or both the date and time (the default) in the text field of
Notes and Events when you start the Timer or choose Date/
Time Stamp from the Contact menu.

Full Name Format Choose to have a Contact’s full name appear in the First
Middle Last or Last, First Middle order when you insert the
«FullName» merge field in a Copy Contact Info Format, a
Template, a Word Processor document and so on.

continued on next page
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Use this pop-up menu… To…
continued from previous page

Listing Format In Listings, show only the name (person or company) that
you selected from the Listing pop-up menu in the New Con-
tacts pane of the Preferences window; or, show that name
with the unselected name (again, person or company) from
the Listing pop-up menu, with the two separated by a carriage
return or colon.

This option is useful in the List View, where it can cut
down on the number of fields you need to display.

Date Format Choose the format for the date that appears in Date/Time
stamps in your Notes and Calendar Events, and in the Modifi-
cation Date/Time field in the List View.

Time Format Choose the format for the time that appears in Date/Time
stamps in your Notes and Calendar Events, and in the Modifi-
cation Date/Time field in the List View.

Other options permitting you to customize your Now Contact file also appear in the Gen-
eral pane of the Preferences window. These options are listed in the following table.

Select… To…
Auto-save every x minutes Automatically save your Contact File. Type the

desired save frequency in the text field.

Use system color palette Use the standard system color palette instead of
Now Contact’s custom color palette, which pro-
vides special colors for certain functions.

Closing last window quits Quit the Now Contact application when you close
the last open window of a Contact File.

Show Tool Tips (Button Help Text) Display short identifying labels beneath each
Toolbar button when you pass the pointer over
the button.



9 2 Chapter 8

Finding Contacts
Now Contact’s Find function works independently of Categories and Keywords. When
you perform a Find operation, all matching Contacts are displayed in the List View regard-
less of the Categories you’ve assigned them to or the Keywords you’ve defined for them.
To search for Contacts based on their Categories and Keywords, use the Find Category
and Find Keyword Toolbar buttons, or use QuickFind; see “Using QuickFind” later in this
chapter for details.

To perform a basic Find:
1. Choose Find from the Find menu, or click the Find Contact button in the Toolbar.

The Find dialog box appears.

2. Type the text that you want to find in a Contact or Contacts.

You can also perform a search by entering the initial letters of the Contact’s
first and last name, with a space in between.

3. Click Find.

Now Contact displays the Contacts that were found in the List View. If the Detail
View is active, it displays the first Contact in the found list.

To perform a detailed Find:
1. Choose Find from the Contact menu, or click the Find Contact button in the Toolbar.

The Find dialog box appears.

2. Click the More button in the lower-left corner of the dialog box.

The Find dialog box expands to show additional options.

Click to select 
fields; click 
again to 
deselect

Click to hide 
the detailed 
Find options

Click to select the fields specified 
in the Finding Preferences

Choose a 
matching criteria

Choose search and 
display options

Type the text to 
search for
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3. In the scrolling list on the left, select the field(s) in which you want to search for the
specified text.

The Full Name option combines the first, middle (if specified) and last name fields.
Selecting this search field allows you to search for Contacts simply by typing the first
letters of their first, middle and last names, with a space in between; you may also
need to choose the Starts With option in step 4.

All of the other options specify searching in a single field at a time.

4. From the Comparison: pop-up menu, choose the criteria to determine how the text
will be matched.

5. Type the text you want to search for in the Find this field.

If you selected is between from the Comparison pop-up menu in step 4, type text into
the second text field as well.

6. Select a Where to search radio button to specify where Now Contact should search for
the text.

Contact File searches the entire Contact File for matches, while Within List limits the
search to the Contacts currently displayed in the List View. Use Within List when
you’ve already performed one search and you want to narrow the found list.

7. Select a What to do radio button to specify how found Contacts will affect the Con-
tacts in the current List View.

The options available are:

Select this option… To…
Replace List Replace the Contacts in the current List View with the found Con-

tacts.

Add to List Add the found Contacts to the Contacts in the current List View.

Hide from List Remove any Contacts that match the search criteria and already
appear in the current List View (doesn’t delete the Contacts from
your Contact File).

8. Click Find.

If Now Contact finds Contacts that match the search criteria, the contents of the cur-
rent List View change according to the options you set in step 7.
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Setting Finding preferences
Now Contact lets you set your own Finding preferences so that you can always use the
Find function in a way that’s convenient to you. Use the Finding pane from the Prefer-
ences dialog box to set your preferences.

The fields you select in the Finding Preferences dialog box are the fields that Now Contact
automatically selects when you click the Default button in the Find dialog box.

If you select the Notes field, select the Ignore accents when searching notes checkbox at
the bottom of the pane to make your search more precise by ignoring text containing dia-
critical marks. For example, if you’re searching for a Note containing the word resume,
Notes containing the word résumé are not considered a match.

Other Find menu commands
In addition to the Find command, Now Contact provides several other search-related com-
mands in the Find menu.

Choose this command… To…
QuickFind… Find Contacts based on their Categories and Keywords. See “Us-

ing QuickFind” later in this chapter for details.

Find All Find all of the Contacts in the Contact File.

Find Marked Find Contacts you’ve marked in the Contact File.

Find Selected Find Contacts you’ve selected in the List View.

Find QuickContacts Find the Contacts you’ve selected to include in the QuickContact
menu in your primary Contact File. See “Using QuickContact” in
Chapter 13, “Quick Access Features” for details.

Find Duplicates Find duplicate information among the Contacts in a Contact File.
See “Finding duplicate Contacts” later in this chapter for details.

Hide Remove selected Contacts from the List View. See “Hiding Con-
tacts” later in this chapter for details.
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Finding duplicate Contacts
Now Contact lets you search for duplicate Contacts in your Contact Files, and provides
various options for resolving them.

Use the Duplicate Handling pane of the Preferences dialog to specify which fields to com-
pare before searching for duplicate Contacts.

To find duplicate Contacts:
1. Choose Find Duplicates from the Find menu.

The Finding Duplicates dialog box opens, asking you whether you want to find and
merge duplicate Contacts or simply display them in the List View.

The dialog box contains the following duplicate handling options.

Choose this option… To…
Find/Merge Update the last-modified copy of the Contact (if necessary)

and delete the older version.

Display Display all found duplicate Contacts in the List View without
merging them.

2. Click Find/Merge or Display.

If you clicked Find/Merge, the duplicate Contacts are combined and only one copy of
that Contact appears in the Contact File. If the older Contact had Notes, documents or
Calendar Events attached to it, they are added to the more recent Contact before the
older one is deleted. Additionally, a new Note similar to the one illustrated below is
attached to the merged Contact, indicating which copy was older and listing the
changes made to the merged Contact.

Find/Merge finds only two duplicates per Contact. If you suspect that more
than two copies of a Contact exist in a Contact File, use the Find Duplicates
function a second time.



If you clicked Display, all found duplicates appear in the List View. You can examine
them in the Detail View to see if they are actually duplicates and, if they are, choose
Find Duplicates again and merge them.

Using QuickFind
The QuickFind feature filters the Contacts in your Contact File based on their Categories,
Keywords, or both, and lets you view specific Contacts while hiding any Contacts you
don’t want to view.

To Now Contact 1.x users: QuickFind takes the place of Now Contact version 1.x’s Sets
feature. QuickFind functions in much the same way as Sets, but also lets you narrow the
Contact list based on the Keywords assigned to your Contacts.

To use QuickFind:
1. Choose QuickFind from the Find menu, or click the QuickFind button in the List

View Toolbar.

The QuickFind window opens.

Click to select a 
Category, click 
again to deselect

Click to select a 
Keyword, click 
again to deselect

Click to select all 
or none of the  
Categories

Click to toggle 
between All 
and Any

Drag to resize 
the panes

Drag to resize 
the QuickFind 
window

The scrolling list at the top of the window shows all Categories defined for the current
Contact File, while the list at the bottom shows all Keywords defined for the file.

The QuickFind Categories and Keyword lists work independently—that is, you
don’t need to select a Category in order to filter your Contacts using Key-
words. However, using the lists in combination with one another allows you to
be more specific in your search.

2. In the Categories list, click the Categories whose Contacts you want to include in the
List View, or click the All or None buttons.

Contacts assigned to the Categories you select appear immediately in the List View.

3. In the Keywords list, select the Keywords whose Contacts you want to include in the
List View.
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Contacts who have been assigned the Keywords you select, and who are assigned to
the Categories you selected in step 2, appear immediately in the List View.

The Keywords list operates in two modes: All and Any, described in the following
table.

Choose this mode… To find…
All Only those Contacts with all the selected Keywords.

Any Contacts with any of the selected Keywords, regardless of
other Keywords assigned to them.

4. Close the QuickFind window.

You’re returned to your Contact File, where only the matching Contacts appear in the
List View.

The QuickFind window can remain open while you work in your Contact File.

Hiding Contacts
You can remove Contacts from the found list by selecting them and choosing Hide from
the Find menu, or clicking the Hide Contact button in the List View Toolbar.

To return hidden Contacts to the List View, simply choose Find All from the Find menu or
click the Find All button in the Toolbar.
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Viewing and Dialing Contacts
Now Contact makes it simple for you to view, browse, and modify Contact information in
either the List View or the Detail View, and gives you extensive control over the appear-
ance and formatting of both Views. In addition, you can use Now Contact to dial the
phone numbers of your Contacts from either the List View or the Detail view.

List View
The List View is the first view you see when you open a Contact File. It has two main
components: the columns in which Contact data is displayed and the Contact data itself.

Each column has a header at the top that shows the name of the Contact data field whose
information it displays; special symbols in the column’s header also reflect sorting at-
tributes that have been assigned to it.
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The Toolbar at the top of the List View provides immediate access to the most commonly
used Now Contact functions. The status bar at the bottom tells you how many Contacts of
the total number in your Contact File are currently displayed in the List View.

The List View Toolbar
The buttons in the List View Toolbar provide immediate access to most common Now
Contact functions. While each of the buttons has a corresponding menu command, click-
ing a button is often faster than choosing the command from the menu.

Defining List Layouts
List Layouts determine how your Contacts appear in the List View. With Now Contact,
you can modify predefined List Layouts or create your own. Click the List Layouts button
in the List View Toolbar or choose List Layouts from the Define menu to open the follow-
ing dialog box.

Choose from 
these pop-up 
menus to define 
display options

Choose from 
these options to 
define Sort 
Order

Select a Layout 

Click fields to 
include them 
in the Layout; 
drag fields to 
reorder

Click to create a 
new Layout

Click to copy the 
selected Layout

Click to rename the 
selected Layout

Click to delete the 
selected Layout

Refer to “Define List Layouts” in Online Help for more information on determining how
your Contacts look in List View.

When you define a new List Layout, it appears in the Use List Layout submenu of the
Window menu.
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Sorting List View columns
Now Contact lets you sort the List View to control how your Contact information is dis-
played. You can choose a primary column on which to sort your Contacts, plus up to four
additional sub-sort columns.

Set the sort order for a List View in the Define List Layouts dialog box, described in the
previous section. You can create a new sort order directly in the List View, but the new
order does not affect the current List Layout definition. Now Contact uses the new sort
order until you choose the original List Layout from the Use List Layout submenu of the
Window menu.

To sort columns in the List View:
1. Click any column header to make it the primary column by which Contacts are sorted.

The column name becomes underlined, and a small Roman numeral I (the sort level
indicator) appears above and to the right of the column name.

2. To define sub-sort columns, hold down the Shift key and click other column headers.

A Roman numeral II appears in the second column you click, a III appears in the third
column, and so on up to the fifth column.

If you Shift-click one of the defined Sort columns, it is removed from the group and
the remaining columns are renumbered accordingly. Shift-click another column
header to add it to the Sort group.

Click any column header without holding down the Shift key to cancel all previous
Sort columns and makes it the new primary Sort column.

3. To sort a column in reverse order, hold down the Option key while clicking the col-
umn header.

A downward-pointing arrow appears below the column’s assigned Roman numeral to
indicate a reverse sort order for the column. To turn off reverse sorting for a column,
Option-click the column header a second time.
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Moving List View columns
Drag columns in the List View to reorder them.

To move columns in the List View:
1. Click the header of the column that you want to move and hold down the mouse but-

ton.

2. Drag the column to the desired location.

Two vertical dotted lines represent the borders of the column as you drag.

3. When you’ve dragged the column to the desired location, release the mouse button.

The column appears in its new location.

When you move a column directly in the List View, the new column order is
saved immediately in the current List Layout.

Resizing List View columns
Now Contact makes it easy for you to resize the List View columns, making them wider or
narrower as necessary.

To resize columns in the List View:
1. Place the pointer over the right border of the column you want to resize.

The pointer changes to a double-headed arrow ().

2. Drag the border to the left or right, depending on whether you want to make the col-
umn wider or narrower.
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Dotted lines appear at the left and right sides of the column, reflecting the borders.

3. Release the mouse button when you’ve resized the column to the desired width.

The column border changes from a dotted line back to a solid line in the top row of
the List View.

Modifying Contacts in the List View
You can edit the information in many of the List View columns without opening the Detail
View.

Editing text
Columns in the List View that display basic Contact information can be edited by clicking
and typing. The pointer turns into the No Edit symbol () when you pass it over columns
whose contents can’t be edited.

To edit text fields in the List View:
1. Select a Contact by clicking it.

2. Place the pointer over a column that offers direct text editing.

The pointer changes to the standard text-editing I-beam cursor () when it’s positioned
over one of these columns.

3. Click once in the field that contains information you want to edit.

The Contact is no longer highlighted, and the cursor blinks in the text field.

4. Make the desired changes to the text.

5. Move to other fields and modify text if desired.

You can move from the current field to the next editable text field by pressing the Tab
key, or to the previous text field by pressing Shift-Tab.

6. When you’re finished editing text, press the Enter key.

This confirms your changes to the Contact and selects it again in the List View.
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Pop-up menus
Clicking in certain columns in the List View opens a pop-up menu that contains a list of
options for that field. The Category, Listing and Pri. Phone columns all include pop-up
menu capabilities.

To use a pop-up menu in the List View:
1. Select a Contact by clicking it.

2. Place the pointer over a column that offers pop-up menu capability.

The pointer changes to a downward-pointing arrow () when it’s positioned over one
of these columns.

3. Click over the column and hold down the mouse button.

A pop-up menu appears, listing the options for that column.

4. Choose the desired item from the pop-up menu and release the mouse button.

The item you chose now appears in the column.
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Detail View
The Detail View is where you create new Contacts, enter Contact information, and view
information that isn’t included in your current List View. You can create Detail Layouts
that specify display font, orientation of the various fields, tab order and more.

Since all of the components described in the following sections can be included in or ex-
cluded from the Detail View according to the current Layout, the illustration above shows
a Layout that includes all components; see the next section, “Defining Detail Layouts,” for
more information on Detail View Layouts.

The Detail View Toolbar
The buttons in the Detail View Toolbar let you perform many common Now Contact func-
tions. While each of the buttons has a corresponding menu command, clicking a button is
often faster than choosing the command from the menu.
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Listing Header

The Listing Header shows the name and telephone number of the current Contact accord-
ing to the Primary field selections you’ve set. See “Primary Fields” later in this chapter for
more information.

Use the Contact icon to the left of the Contact name for Now Contact drag-and-drop op-
erations, such as copying Contacts, pasting Contact information in a text file and so on.
Click and hold the mouse button on the icon (or anywhere in the Listing Header) and drag
it to the desired location.

Category Header

The Category Header lets you navigate through your Contact File and make changes to the
Contacts. Click the arrow buttons to move forward or backward through the Contact File.

Pressing Command–Right Arrow or Command–Left Arrow on the keyboard also moves
you forward or backward through the current List View; pressing Command–Up Arrow or
Command–Down Arrow moves you to the first or last Contact in the current List View.

The numbers next to the arrows indicate the position of the current Contact in the Contact
File. The Mark checkbox ( ) lets you mark or unmark the current Contact, and the
QuickContact checkbox ( ) lets you include the current Contact in the QuickContact
pull-down menu for quick reference. Finally, the Category pop-up menu indicates the Cat-
egory to which the current Contact is assigned; you can change a Contact’s Category by
choosing one from the pop-up menu.

Contact information blocks

Name/Address blocks

Phone/Custom Field blocks

Click to view 
additional 
information

Click to dial the 
corresponding 
telephone number

The fields in the Contact information blocks contain the name, address and telephone
number information for the current Contact, as well as information for any Custom Fields
you’ve set up in your Contact File.
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Contact Log

All Contact attachments, Calendar Events and your personal Comments appear in this sec-
tion of the Detail View. Personal Comments are shown in the scrolling Comments field.
Attached Notes, documents, and Events appear in the scrolling list on the left side of the
log; on the right is a list of the Contact’s assigned Keywords. See Chapter 8, “Customizing
Contacts,” for more information on attaching and viewing Comments, Notes, documents
and Calendar Events.

You can resize the panes in the Contact Log by dragging the four-headed resizing control
vertically and horizontally in the Detail View. The information contained in the windows
remains attached to the Contact even though it may be out of view.

Contact Log entries include the following information:

• Free-form text in the Comments field
• Type of attachment (Note, To-Do, document and so on)
• Title of the attachment
• Symbols indicating whether an attached To-Do is Done (checkmark), In Progress (two

bullets) or Not Done (one bullet)

You can sort Contact Log entries by clicking any of the column header buttons; by default,
entries are sorted in ascending order by type. To sort in descending order, Option-click the
appropriate header.

The three icons beneath the Contact Log let you filter the entries in the log. When you se-
lect an icon, entries of that type appear in the log; when you deselect the icon, it is no
longer highlighted and its entries are hidden from view. Icons for hidden entries have a red
slash through them.
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Defining Detail Layouts
Detail Layouts determine the appearance of the Detail View. With Now Contact, you can
modify predefined Detail Layouts or create your own. Click the Detail Layouts button in
the Detail View Toolbar or choose Detail Layouts from the Define menu to open the fol-
lowing dialog box.

Select a Layout 

Choose from 
these pop-up 
menus to define 
which elements 
to display

Choose from 
these pop-up 
menus to define 
display options

Click fields to 
include them in 
the Layout; drag 
fields to change 
tab order

Click to create a 
new Layout

Click to copy the 
selected Layout

Click to rename the 
selected Layout

Click to delete the 
selected Layout

Refer to “Define Detail Layouts” in Online Help for more information on determining
how your Contacts look in Detail View.

When you create a new Detail Layout, it’s added to the Use Detail Layout submenu of the
Window menu, so you can easily switch between existing Layouts as you work.

Primary Fields
Primary Fields help to ensure that the most essential information about a given Contact is
always displayed or retrieved. For each Contact, you can select a Primary Name (either
Contact Name or Company Name), a Primary Phone (Work, Home, Fax, Mobile, or any
telephone number in a Custom Field), and a Primary Address (Work or Home).

Primary Field functions
Primary Fields function in five main areas:

• Listing Header in the Detail View: The name field and telephone number you select as
Primary determine the information that appears in the Contact’s Listing Header.

• Address information in the Detail View: When you specify a display size smaller than
3 Blocks for the Name and Address information blocks, the Primary Address you select
determines which address is shown first (the Secondary address is available by clicking
the dog-ear in the address block).



109Viewing and Dialing Contacts

Using Contacts
Now

 Contact

• Special columns in the List View: Two List View columns are affected by your Pri-
mary Field settings. The Listing field displays the name you select as Primary, option-
ally followed by the unselected (or Secondary) name; the Pri. Phone (Primary Phone)
field displays the Primary telephone number you select.

• Templates and Word Processing: When you’re creating a Now Contact printing Tem-
plate, or a document using Now Contact’s Word Processor, you can include merge fields
that automatically insert the Primary information for each Contact. The fields are «List-
ing», «PriAddress», «PriCity», «PriST», «PriZip» and «PriPhone».

For example, you might set up a merge address as:

«Listing»
«PriAddress»
«PriCity», «PriST» «PriZip»
«PriPhone»

This is often preferable to inserting, for example, «WkAddress», since you may not
want to use the work address for every Contact you’re including in a merge operation.
Instead, the Primary Field options let you use one Contact’s home address and another’s
work address, according to the Primary selections you’ve made for each Contact. For
more information on using merge fields, see Chapter 12, “Printing Contacts.”

• Copy Contact Info: You can configure the Edit menu’s Copy Contact Info command to
use the same Primary merge fields described above, allowing you to automatically copy
a Contact’s Primary information to the Clipboard. For more information on setting up
and using the Copy Contact Info function, see Chapter 8, “Using Now Contact.”

When your General preferences are set to display the «Listing» field as the Primary Name
followed by a carriage return and the Secondary Name (the name not selected as Pri-
mary), this field will consist of two lines in Word Processor documents and in Copy Con-
tact Info Formats.

Selecting Primary Fields
Selecting your Primary Fields is simply a matter of clicking within the Detail View.

To select Primary Fields for a Contact:
1. Open the Detail View for the Contact whose Primary Fields you want to select.

A name and telephone number appear in the Listing Header by default. The current
Primary Fields in the Name, Address and Phone blocks are underlined.

2. From the Use Detail Layout submenu of the Window menu, choose a Detail Layout
that allows you to see as much Contact information as possible on your screen.

3. Place the pointer over the title of the Name field.

The arrow pointer changes to the Primary Field Selector (). This selector also ap-
pears when you place the pointer over the title of the Company field. Of these two
fields, the one that is currently underlined is the Primary Name—the one that appears
in the Listing Header.
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4. Click the title of the field you want to select as the Primary Name for the current Contact.

The field you clicked becomes underlined, and the newly selected Primary Name now
appears in the Listing Header.

5. Place the pointer over the title of the Home field.

The pointer changes to the Primary Field Selector () over this field. The Primary
Field Selector also appears when you place the pointer over the title of the Work Ad-
dress field. The field that’s currently underlined is the Primary address.

6. Click the title of the address field you want to select as the Primary Address for the
current Contact.

The field you clicked becomes underlined.

7. Place the pointer over the title of the Work Phone (Work) field.

The pointer changes to the Primary Field Selector over this field as well. It also ap-
pears when the pointer is over the Home Phone, Fax Phone or Mobile Phone field, as
well as any Custom Fields you set up to contain telephone numbers. The telephone
field that’s currently underlined appears in the Listing Header.

8. Click the title of the phone field you want to select as the Primary telephone number.

The field you clicked becomes underlined, and the newly selected Primary telephone
number now appears in the Listing Header.

Dialing Contact telephone numbers
Now Contact provides the control you need to dial Contact telephone numbers accurately,
no matter where you are or who you’re calling. You set up the dialing function from the
Dialing pane of the Preferences window, and dial from the Call dialog box. You can set up
multiple dialing configurations for all of the various situations you may encounter. Now
Contact remembers the dialing combinations you choose and saves them as the defaults for
any subsequent calls.

Dialing methods
You can dial using your Macintosh speaker, a modem connected to your Macintosh, a So-
phisticated Circuits DeskTop Dialer or another application via Apple Events.

To dial using… Do this…
Your speaker Hold the mouthpiece of your telephone handset as close as possible

to the internal speaker of your Macintosh (or a connected external
speaker) when you activate dialing (how close you need to hold it
may depend on the current volume setting in the Expert Dialing
Setup dialog box; see “Speaker settings” later in this chapter). As
long as your outgoing line supports touch-tone dialing, your call
should go through.

continued next page
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To dial using… Do this…
continued from previous page

A modem Select the appropriate Dialing preferences. See “Setting Dialing pref-
erences” later in this chapter for details.

DeskTop Dialer™ Select the appropriate Dialing preferences. When you activate dial-
ing, the Contact number is sent to the DeskTop Dialer, which in turn
dials it. In addition to the dialer unit itself, you must have the Sophis-
ticated Circuits Dialer control panel installed on your Macintosh for
Now Contact to use your DeskTop Dialer.

Apple Events Specify an application other than Now Contact to dial your Contacts.
When you activate dialing, the Contact number is sent to the applica-
tion and that application dials it. This is useful for certain PBX sys-
tems that use an Apple Event-aware application to handle telephone
calls, or for any application capable of dialing telephone numbers.

Setting Dialing preferences
Now Contact’s Dialing preferences let you configure all of the dialing combinations you
might need to call from various locations and connect to any long-distance services.

To set Dialing preferences:
1. Choose Dialing from the Preferences submenu of the Define menu.

The Dialing pane of the Preferences window appears.

2. Choose a dialing method from the Dial via pop-up menu.

You can choose the Speaker, Modem, DeskTop Dialer or Apple Event Dialer options
described in the previous section.

If you choose Apple Event Dialer in step 2, click the Choose button to the right
of the pop-up menu. A standard directory dialog box appears—locate the appli-
cation you want to use for dialing and click Open. The application you select
must be Apple Event-aware; see the application’s documentation for informa-
tion.
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3. Set options in the Dialing Defaults section as desired.

These options apply every time you use the dialing feature. They are described in the
following table.

Choose this option… To…
Create new Call event Create a new Call Event for the current Contact whenever

you dial. This adds a record of the call to the Contact’s
Contact Log.

Omit Local Area Code Remove the specified area code when dialing local tele-
phone numbers. You must enter a local area code in the
Local Area Code text field for this option to work properly.

If you don’t select this checkbox, you can still omit
the local area code on a per call basis by checking
Smart area code handling in the Call dialog box. See
“Dialing a Contact” later in this chapter for details.

Local Area Code Specify the area code to omit when the Omit Local Area
Code checkbox is selected. Whenever you dial a number
containing this area code, only the telephone number itself
is dialed.

Dial Tone Specify a number string that should be dialed to obtain a
dial tone. There are two predefined dial tone strings to
choose from, or you can define or modify dial tone strings;
see “Defining dialing strings” later in this chapter.

LD Prefix Specify a long-distance prefix that should be dialed before
the telephone number. There are two predefined prefixes to
choose from, or you can define prefixes; see “Defining di-
aling strings” later in this chapter.

LD Suffix Specify a long-distance suffix that should be dialed after
the telephone number. There are two predefined suffixes to
choose from, or you can define or modify suffixes; see
“Defining dialing strings” later in this chapter.

4. In the When dialing fields, enter text to precede telephone extensions and specify the
number of commas to use in place of the text when dialing.

This allows you to dial extension numbers after the telephone numbers in your Con-
tacts’ Phone fields.

For example, if you follow a Contact’s Work telephone number with Ext. 194 in the
Detail View, Now Contact replaces the letters Ext. with the number of commas you
specify—each comma causes a pause, after which the extension is dialed. This gives
the main phone system time to answer before the extension is dialed.



113Viewing and Dialing Contacts

Using Contacts
Now

 Contact

You can enter any combination of text or numerals to precede extensions—just be
sure that what you enter is short enough to fit in your Detail View Phone fields. The
text you enter must precede any extensions in your Detail View Phone fields. You can
enter only numerals in the commas field.

5. Close the Preferences window.

You’re returned to the current Contact File and your Dialing preferences are set. To
define or modify dial tones and dialing prefixes and suffixes, see “Defining dialing
strings” later in this chapter.

Setting expert options
When you use the Speaker or Modem dialing method, you can configure additional set-
tings. Simply click the Expert Setup button at the top of the Dialing preferences pane and
set the options in the Expert Dialing Setup dialog box that appears.

If you make changes in the Expert Dialing Setup dialog box and later decide to use the
original settings, click the Reset button.

Speaker settings
The Expert Dialing Setup dialog box for speaker dialing is shown below.

This option… Controls…
Tone Duration The length of the dialing tones played through your Macintosh

speaker, in 60ths of a second. If you have problems connecting
when dialing through your speaker, try increasing this setting.

Pause Between Tones The length of silence between each dialing tone, in 60ths of a
second. If you have problems connecting when dialing through
your speaker, try increasing this setting.

Comma duration When using commas in dialing strings, the length of silence
each comma represents. See “Defining dialing strings” later in
this chapter for details.

Volume The speaker volume for your dialing tones; you can choose
Low, Medium (the default) or High.
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Modem settings
The Expert Dialing Setup dialog box for modem dialing is shown below. Now Contact
assumes that your modem is Hayes-compatible and can respond to the industry-standard
modem commands Now Contact uses.

You should be familiar with your modem and modem commands before changing the mo-
dem settings in the Expert Dialing Setup dialog box .

This option… Controls…
Initialization How Now Contact prepares your modem for dialing.

Hangup string How your modem releases the line when you click Cancel in the dial-
ing status dialog box (see “Dialing a Contact” later in this chapter for
more information).

Port The Macintosh port your modem is connected to—Modem (the de-
fault) or Printer.

Dial prefix How Now Contact prepares the telephone line for dialing; a T at the
end of the prefix indicates touch-tone dialing, while a P indicates pulse
dialing.

Dial suffix How your modem behaves during a call; a semicolon (the default set-
ting) keeps the modem in command mode so that it can release the line
if your call doesn’t go through.
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Defining dialing strings
Dialing strings let you add special numbers to your Contact telephone numbers without
having to modify the Phone fields for each Contact. There are three types of dialing
strings, and Now Contact includes predefined strings for all types.

This string… Dials…
Dial Tone The numbers and pauses necessary to get a dial tone in a particular location.

A predefined dial tone for outgoing office calls is included.

Prefixes Any numbers that need to occur after getting a dial tone and before dialing a
Contact’s telephone number. A predefined prefix for toll-free 800 number
access is included.

Suffixes Any numbers that need to occur after dialing a Contact’s telephone number.
A predefined suffix for long-distance telephone card calling is included.

In addition to the predefined strings, you can define new strings or modify the predefined
ones to suit your needs.

When you’re defining or modifying dialing strings, inserting a comma anywhere in a
string denotes a pause. You can use commas to tell Now Contact to pause the dialing pro-
cess in order to wait for a confirmation tone. (See “Setting expert options” earlier in this
chapter for information on setting comma pause duration.)

To define dialing strings:
1. Choose Dialing from the Preferences submenu of the Define menu.

The Dialing pane of the Preferences window appears.

2. Choose a dialing string option from the Define: pop-up menu at the bottom of the
window.

The scrolling list below the pop-up menu changes to show the strings for the option
you chose.

3. Click New.

Depending on your choice in step 1, the New Dial Tone (pictured below), New Prefix
or New Suffix dialog box appears. Each dialog box contains the same components.

4. Enter a descriptive name for your new string in the Name field.

To modify existing strings, select them in the scrolling list, click Edit and follow
the remaining steps.
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5. Enter the numbers to dial in the Value field.

If you’re defining a new dial tone or prefix, remember that the numbers you enter are
dialed before the Contact’s telephone number, while suffixes are dialed after it.

6. Click OK.

The new string appears in the scrolling list.

7. Repeat steps 3 through 7 for any additional strings you want to define.

8. Close the Preferences window.

You’re returned to the current Contact File; the new strings you defined are now
available when you use the dialing feature.

Dialing a Contact
Once you’ve set your Dialing preferences, you can dial any Contact in your Contact File
from either the List View or the Detail View. The options you’ve set up in your prefer-
ences are available when you dial.

To dial a Contact number quickly from the Detail View, click the telephone icon () next
to the number you want to dial and follow steps 9 and 10 in the procedure below.

To dial a Contact:
1. Select the Contact whose telephone number you want to dial.

2. Choose Dial from the Contact menu, or click the Dial button in the List View Toolbar.

The Contact’s Detail View opens (if it wasn’t already open), then the Call dialog box
appears. Notice that the top of the dialog box displays a summary line showing the
name and company of the Contact you’re calling.

3. In the scrolling list of phone numbers, choose the number you want to call.

Select a number by clicking it; the number appears in the Dialing field at the bottom
of the dialog box. By default, the phone number you’ve specified as the Primary
Phone for the Contact is selected.

4. From the Dial tone pop-up menu, choose the dial tone string necessary to obtain a dial
tone at your current location.



117Viewing and Dialing Contacts

Using Contacts
Now

 Contact

The predefined dial tone strings, and any you’ve set up in the Dialing preferences
window, are listed in the pop-up menu. Choose None if you don’t need a string to get
a dial tone.

Any dialing string you choose is inserted in the Dialing field at the bottom of
the dialog box.

5. From the LD Prefix pop-up menu, choose the appropriate dialing prefix for your call.

Choose any prefix that needs to be dialed before the selected telephone number (out-
side line access, and so on); the predefined prefixes, and any you’ve set up in the Dial-
ing preferences window, are listed in the pop-up menu. Choose None if the number
requires no prefix.

6. From the LD Suffix pop-up menu, choose the appropriate dialing suffix for your call.

Choose any suffix that needs to be dialed after the selected phone number (long-dis-
tance access, and so on); any suffixes you’ve set up in the Dialing preferences win-
dow are listed in the pop-up menu. Choose None if the number requires no suffix.

7. Select Create new Call event if desired.

Selecting this checkbox causes Now Contact to create a new Call Calendar Event in
which you can document the phone call you’re making. If you select this option, the
Event Info dialog box opens automatically after the telephone number has been dialed.

In the Dialing pane of the Preferences window, you can specify that Now Con-
tact always creates a new Call Calendar Event whenever you dial a Contact.

8. Select Omit local area code if desired.

Selecting this checkbox causes Now Contact not to dial the local area code.

You must specify a local area code in your Dialing preferences for this feature
to work. See “Setting Dialing preferences” earlier in this chapter for details.

9. Click Dial.

Now Contact dials the number. If you selected the Create new Call checkbox in step
7, another dialog box appears allowing you to cancel or continue your call once the
number has been dialed.

If you’re using the Apple Event Dialer and you haven’t chosen a dialing appli-
cation, a standard directory dialog box appears at this point. Locate the appli-
cation capable of dialing using Apple Events and click Open.
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10. Click OK when the party you’re calling answers the phone, or click Cancel if the line
is busy or there’s no answer.

If you selected the Create new Call Event checkbox, the dialog box disappears and the
Event Info window appears when you click OK. If you’re dialing through a modem,
pick up your telephone handset when the party answers and then click OK—the mo-
dem releases the line to transfer control of the call to you.

If you click Cancel, no Call Event is created and you’re returned to your Contact File.

Now Contact remembers the options you choose in the Call dialog box and uses
them as the default values the next time you use the dialing feature.
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Organizing Contacts
Now Contact helps you manage your Contacts by allowing you to group related ones to-
gether using Categories. You can also classify Contacts by assigning your own Keywords
to them, and use the Mark function to “tag” your Contacts for printing, temporary group-
ing or other purposes.

Using Categories
Categories help you classify your Contacts into related groups. You can assign a different
color and text style to each Category, making it easy to spot related Contacts in the List
View.

Creating new Categories
You can create new Categories from either the List View or the Detail View.

To create a Category:
1. Choose Categories from the Define menu, or choose Define Categories from the

Detail View’s Category pop-up menu.
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The Define Categories dialog box appears.

The list of currently 
defined Categories 
appears here

This area is active only 
if you are connected to 
a Public Contact Server

The number of 
Contacts assigned to 
the selected Category 
appears here

Click to copy the 
selected Category

Click to create a new Category

Click to delete the 
selected Category

Click to edit the selected Category

2. Click New.

A dialog box appears, prompting you to enter a name for the new Category.

3. Type a name for the new Category in the Name field.

4. Type a brief description of the new Category in the Description field.

5. Click OK.

You’re returned to the Define Categories dialog box; the new Category appears in the
Category list.

6. Click OK.

You’re returned to your Contact File.

Assigning Contacts to Categories
Once you’ve created your Categories, the next step is assigning your Contacts to the ap-
propriate Categories. You can do this in either the Detail View or the List View.

To assign a Contact to a Category in the Detail View:
1. Open the Detail View for the Contact that you want to assign to a Category.

2. Click the Category pop-up menu.

The available Categories are listed in the menu.

3. Choose the desired Category from the pop-up menu.

The name of the Category you chose now appears next to Category in the Detail
View.
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To assign a Contact to a Category in the List View:
1. In the List View, select the Contact that you want to assign to a Category.

2. Click in the Category field for the selected Contact.

A pop-up menu appears, listing the available Categories.

3. Choose the desired Category from the pop-up menu.

The name of the Category you chose appears in the selected Contact’s Category field.

You can also select a group of Contacts and assign them all to the same Category, even if
they initially belong to different Categories.

To reassign selected Contacts to a Category:
1. Select the Contacts whose Category you want to reassign.

Shift-click to select adjacent contacts; command-click to select non-adjacent contacts.

2. Choose Assign Category from the Contact menu.

The Assign Category dialog box opens. It contains a pop-up menu listing the available
Categories in your Contact File.

3. Choose the desired Category from the pop-up menu.

4. Click OK.
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Editing Categories
You can make changes to your existing Categories by renaming a Category or changing its
description.

To edit a Category:
1. Choose Categories from the Define menu, or choose Define Categories from the Cat-

egory pop-up menu.

The Define Categories dialog box appears.

2. Select the Category you want to edit and click Edit.

The Category Info dialog box appears, displaying the name and description (if any)
currently defined for the selected Category.

3. Make the desired changes in the Name and/or Description fields.

4. Click OK.

You’re returned to the Define Categories dialog box.

5. Click OK.

You’re returned to your Contact File.

Deleting Categories
If you no longer have a use for a Category, simply delete it.

Deleting a Category deletes any Contacts assigned to it. Reassign any Contacts you want
to keep before deleting the Category.

To delete a Category:
1. Choose Categories from the Define menu, or choose Define Categories from the Cat-

egories pop-up menu.

The Define Categories dialog box appears.

2. Select the Category you want to delete and click Delete.

A confirmation dialog box appears, asking if you’re sure you want to delete the se-
lected Category and its assigned Contacts, if any.
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3. Click OK.

The selected Category is deleted, and you’re returned to the Define Categories dialog
box. The deleted Category no longer appears in the Category list.

4. Click OK.

You’re returned to your Contact File. The Contacts assigned to the Category you de-
leted no longer appear in the file.

Setting colors and text styles for Categories
Now Contact lets you assign different colors and/or text styles to your Categories. This
makes it easy to tell which Contacts belong to which Category.

To set colors and text styles for Categories:
1. Choose Category Styles from the Define menu.

The Define Category Styles dialog box appears.

Click to select a 
Category from 
the list

Select any or all of 
these checkboxes to 
set text styles for the 
selected Category

The number of 
Contacts assigned 
to the selected 
Category appears 
here

Choose a text color 
for the selected 
Category from this 
pop-up menu

2. Select the Category you want to assign a color and/or text style to from the Categories
list.

3. Set the desired color and/or text style for the Category.

4. Repeat steps 2 and 3 to set colors and/or text styles for other Categories.

5. When you’ve finished setting colors and text styles, click OK.

You’re returned to your Contact File.



124 Chapter 10

Using Keywords
In addition to using Categories, you can use Keywords to help organize and classify your
Contacts. Keywords let you assign multiple “tags” to your Contacts so you can identify
them as belonging to one or more groups. A Contact can belong to only one Category at a
time, but it can be assigned multiple Keywords. Using Keywords works well for groups
that might “cross over” between Categories.

The Keywords you assign to your Contacts are not available to other networked users
when you post the Contacts to a Public Contact Server. See Chapter 11, “Using Public
Categories,” for more information.

Defining Keywords
A new Contact File has Keywords already defined. You can change these default Key-
words or create new ones.

To define a new Keyword:
1. Choose Keywords from the Define menu.

The Define Keywords dialog box opens; existing Keywords are displayed in the list.

Click to select 
a Keyword to 
edit or delete

Click to create a new Keyword

Click to edit the selected Keyword

Click to delete the selected Keyword

You can also open the Define Keywords dialog box from the Detail View Con-
tact Log. Click the Keywords column heading and choose Define Keyword from
the pop-up menu that appears.

2. Click New.

The New Keyword Title dialog box opens.

3. Type your new Keyword in the text field.

4. Click OK.

You’re returned to the Define Keywords dialog box, where the new Keyword now
appears.

5. Click OK.

The dialog box closes; your new Keyword is now available for your Contacts.
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Assigning Keywords to a Contact
You can assign Keywords to Contacts in either the Detail View or the List View.

To assign a Keyword to a Contact:
1. Select a Contact in the List View, or open a Contact’s Detail View.

2. Choose Assign Keywords from the Contact menu, or click the Keywords button in the
Detail View Toolbar.

The Assign Keywords dialog box appears.

3. Click the Keyword you want to assign.

A checkmark next to a keyword means that it’s already assigned to the Contact. To
deselect a Keyword, click it a second time and the checkmark disappears.

4. Repeat step 3 for any additional Keywords you want to assign to the Contact.

5. When you’re finished assigning Keywords, click OK.

The Keywords you selected are now assigned to the current Contact and are listed in
the Keywords column of the Detail View Contact Log.

You can also assign Keywords to a Contact directly from the Contact Log, as
illustrated below. Click the Keywords column heading (on the right-hand side
of the log) and choose a Keyword from the pop-up menu that appears.
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Using the Mark function
Categories and Keywords provide fairly permanent approaches to organizing your Con-
tacts. There may be times, however, when you want to organize some of your Contacts in
a more temporary group. The best way to do this is to mark Contacts. When you finish
with the temporary group, you can unmark all of the marked Contacts at once so that you
can use the Mark function again.

Marking Contacts
You can mark individual Contacts in the Detail View, or you can mark either single or
multiple Contacts in the List View.

To mark a Contact in the Detail View:
1. Open the Detail View for the Contact you want to mark.

2. Select the checkbox next to the Mark icon () in the Category Header.

The Contact is now marked. You can unmark it simply by deselecting the checkbox.

You can also mark a Contact in the Detail View by choosing Mark Contact
from the Contact menu, and unmark it by choosing the same command a sec-
ond time.

To mark Contacts in the List View:
1. Select the Contacts you want to mark in the List View.

2. Choose Mark Contact from the Contact menu.

The selected Contacts are marked. You’ll be able to verify that they’ve been marked
only if the Marked field is included in the current List Layout.

The Mark Contact command toggles the marked/unmarked state of any selected Con-
tact, so you can unmark a marked Contact by selecting it and choosing the command
again.

Choosing Mark Contacts marks all selected Contacts, whether they were
marked previously or not. Choosing Unmark Contacts unmarks all selected
Contacts.
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Importing, Exporting
 and Synchronizing Contacts

Now Contact provides a number of ways for you to move Contact information into and out
of your Contact Files, and to synchronize the contents of duplicate files.

Importing from a text file
You can import addresses and telephone numbers from text files from other types of appli-
cations, such as spreadsheets, database files and word processor files.

We recommend that you first import your information into a new, untitled Contact File
until you are sure that the data is being imported properly (into the desired fields, etc.).
This way, your regular Contact File is unaffected until you are confident that the new data
will be added correctly.

To import Contact data from a text file:
1. Export the data from the other application into a tab- or comma-delimited text file.

2. Choose From Text File from the Import submenu on the File menu.

A standard directory dialog box appears.

3. Locate and select the file you want to import and click Open.
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Now Contact briefly displays a progress bar as it scans the Contacts in the file. The
Import Setup dialog box appears.

Choose an Import Template

Select to exclude 
the merge header  
in the file

Click to open the New Contacts 
Preferences window

Click to duplicate, 
delete, rename or 
create a new Import 
Template

Drag fields you are 
importing into to 
match the information 
in the left column

Click in this area 
to include or 
exclude a field

Fields from the  
file you are 
importing 

Select to have 
imported Contacts 
use the default 
values set in New 
Contact Preferences

Click to display next 
or previous records 
in the import file

4. Choose an Import Template from the Import Template pop-up menu, or create a new
one for this operation.

If a predefined Template exists for the application that created your export file, choose
it from the menu. If no matching Template exists, create a new Template by clicking
New or Duplicate. Click OK after naming the new Template.

5. Examine the incoming Contact data.

6. Reorder, include and exclude fields as necessary.

Compare each line of incoming data to the field it’s across from. Drag destination
fields on the right to match the incoming fields on the left.

Click in the middle column to include or exclude fields for the Import operation.

7. Select other import options as desired.

8. Click Import.

When the import is complete, the imported data appears in your Contact File.

Using special import fields
Now Contact includes definable fields that you can configure to match incoming data.
Several fields can be added immediately to handle Contact data for which there isn’t an
appropriate field, or you can create other fields yourself.

To define import fields:
1. Double-click a Define field in the Import Setup dialog box.
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The Configure Special Import Field dialog box appears.

2. Choose the appropriate field type option from the Field Type pop-up menu.

The options in the pop-up menu are described below.

If an import field is already included in the current Template, the correspond-
ing pop-up menu option is dimmed and unavailable.

Choose this field… To…
Wk/Home Address (2nd line) Direct the second line of a two-line imported address

to the appropriate “2nd line” import field.

Notes Create a Note field as a temporary storage area for
miscellaneous import data.

Keywords Direct Tags or imported Keywords to the Keywords
field; New Keywords are created as needed.

Listing Import viewing options from contact managers that
let you view your Contacts by “Business” or
“Name.”

Category Assign imported category information. New Cat-
egories are created as needed.

Append to next/previous field Combine the data labels with the corresponding data
and put them in the correct fields for each Contact.

3. Click OK.

The field is renamed to the type you chose.

Handling duplicate Contacts
Now Contact doesn’t automatically delete duplicate Contacts. To find and merge duplicate
Contacts, use the Find Duplicates command in the Find menu. See “Finding duplicate
Contacts” in Chapter 8, “Using Now Contact,” for details.
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Importing Contacts from another Contact File
Now Contact lets you combine two Contact Files by importing one directly into the other.
See “Exporting Contacts to a Contact File” later in this Chapter for details on exporting
the data. Use the following procedure to “merge” Contacts with other Contact Files.

To import Contacts from a Contact File:
1. Choose From Contact File from the Import submenu on the File menu.

A standard directory dialog box appears, where you locate and select the Contact File
that you want to import.

2. Select the Contact File you want to import and click OK.

The newly imported Contacts appear in the List View of the current Contact File.

Exporting Contact data to a text file
Now Contact allows you to export Contact information by creating a text-only version of
your Contact File.

To export Contact data to a text file:
1. Verify that all the Contacts you want to export are in the current List View.

The Export function exports only the contents of the current List View.

2. Choose To Text File from the Export submenu on the File menu.

The Export Setup dialog box appears. Specify which fields to include in the export
file and their order.

Click fields to 
select them 
for export

Drag fields to 
reorder them

Select to include field name labels 
in the first record in the file

Select an Export Template

Click to duplicate, delete, 
rename or create a new 
Export Template

Click to select a field delimiter

Select to create two separate field for 
an address broken into two lines

3. Choose an Export Template from the Export Template pop-up menu, or create a new
one for this operation.



Importing, Exporting and Synchronizing Contacts 131

Getting Started
Now

 Contact

4. Reorder, include and exclude the available Export fields as necessary.

Reorder fields by dragging them to the desired locations. Include or exclude fields by
clicking to the left of a field name to make the checkmark appear (include) or disap-
pear (exclude).

5. Select the other Export options as desired.

6. Click Export.

A standard directory dialog box appears.

7. Choose a location and name for the Contact File, then click Save.

The exported text file is saved in the location you specified.

Dragging Contact data from the Detail View onto the desktop creates a text file containing
the Contact’s essential information.

Exporting Contacts to a Contact File
Now Contact’s Export feature allows you to export selected Contacts to a separate Contact
File.

Linked Calendar Events contained in the Contacts you export are unlinked in the exported
Contact File.

To export Contacts to a Contact File:
1. Verify that all of the Contacts you want to export are in the current List View.

2. Choose To Contact File from the Export command on the File menu.

A standard directory dialog box appears.

3. Choose a location and type a name for the Now Contact File, then click Save.

The exported Contact File is saved in the location you specified.

Synchronizing Contact Files
The Synchronize feature lets you quickly and easily update different copies of the same
Contact File so that they contain identical information. All changes made to the last-modi-
fied copy of the file are automatically applied to the other copy, including any newly at-
tached or modified Notes, documents or Calendar Events, and any alterations made to a
Contact—address information, company name, and so on. In addition, new Contacts added
to the file and existing Contacts deleted from it are updated in the older copy.

File synchronization works only with copies of the same Contact File—for instance, an
original file and a copy you made using the Save a copy command in the File menu.
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Basic synchronizing
No Contact information is lost when you synchronize files. The older, outdated informa-
tion is stored in a new Note attached to the Contact.

You may want to make a backup copy of the older version of a file before synchronizing
Contact information.

To synchronize copies of a Contact File:
1. Open the version of the Contact File you want to synchronize.

2. Choose Synchronize from the File menu.

A standard directory dialog box appears.

3. Locate and select the copy of the same Contact File and click Sync.

The two copies of the file don’t have to have the same name. The two must,
however, be copies of the same file.

Now Contact saves the open Contact File and closes it. When Synchronization is com-
plete, the copy of the Contact File you had open reappears.

If Contacts were changed as a result of the synchronization, only the changed Con-
tacts appear in the List View; if no changes were made during synchronization, all
Contacts appear in the List View.

Synchronization changes made to Contacts in Public Categories are sent to the
Public Contact Server when the next scheduled update occurs. See Chapter 10,
“Organizing Contacts,” for more information.
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Viewing Synchronization changes
Changes made to Contacts as a result of the synchronization appear in new Notes attached
to the changed Contacts. This gives you access to the older information in case you want
to revert to view it for any reason.

To view Synchronization changes:
1. Open the Detail View for a Contact that was updated.

A SYNCHRONIZE FIELDS Note appears in the Contact Log.

2. Double-click the SYNCHRONIZE FIELDS entry in the Log.

The Note window opens. The text field indicates whether the Contact in the original
file (the first record) or the copy you chose in the directory dialog box in step 3 (the
second record) was updated, and describes all modifications to the Contact informa-
tion.

3. Close the Note window.

You’re returned to the Detail View.
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Printing Contacts
Now Contact provides a variety of ways to print the information in your Contact File, in-
cluding lists of Contacts, individual Contact details, address book pages, envelopes, and
labels. Use Templates—predefined sets of formatting specifications—to create and format
printed output quickly, or design your own Templates.

Printing your Contact information
You can select to print any or all Contacts in the List View or the entire contents of your
Contact File.

To print Contact information:
1. Select the Contact(s) whose information you want to include in the print job.

Select the Contact(s) in the List View, or narrow the contents of the List View to the
desired Contacts by using the Find function or QuickFind.

2. Choose Print from the File menu.

The Print dialog box appears with special Now Contact options at the bottom.



136 Chapter 12

3. Click Select Template.

The Template Selection dialog box appears.

Choose a Template Type

The layout of 
the selected 
Template is 
shown here

Click to select a 
Template from 
this list

4. Select the Template that you want to use for printing.

If none of the predefined Templates meet your printing needs, you may need to create
or modify a Template. See “Using Templates” later in this chapter for details.

5. Click OK.

You’re returned to the Print dialog box.

6. Set the Now Contact printing options as desired.

Use the Which Contacts pop-up menu to choose the Contacts whose information you
want to print.

Choose… To print…
Template Preview The Template only with no Contacts, and the merge fields

themselves.

Selected contacts The Contacts that are currently selected in the List View.

Marked contacts The Contacts that you’ve previously marked.

Current list The Contacts currently displayed in the List View.

Entire Contact File All of the Contacts in the Contact File.

7. Click Printing Options to specify print options.

(The Printing Options button may not be available depending on the Template you
selected in step 4.)
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The Printing Options dialog box appears.

Not all of the printing options (listed below) are available for every type of print job.

Select… To specify that Now Contact will…
Print Short Field Labels Print the short labels for the Primary Address fields,

all Phone fields that contain data, and Custom Fields
for which you defined short field labels.

Print Template Outline Print the outline of the Template’s margins.

Break Pages By Letter Always start a new Address Book page each time a
new letter of the alphabet is reached.

Include Letter Headers Place a letter header before each alphabetical group
of Contacts.

Variable Height Entries Allow the height of entries on your printed pages to
vary according to the amount of information they
contain.

Fit to Page Fit all fields in a Contact List across one printed page.

Always Sort By Listing Sort the printout based on your Listing format,
regardless of the current sort order.

Single-Sided Print simple, single-sided output.

Double-Sided Print true double-sided output; requires turning over
each printed sheet and re-feeding it into the printer.

When printing double-sided output, turn off
Background Printing in the Chooser and
select “Manual Feed” in the Print dialog
box. Now Contact prints the first side of all
pages, then prompts you to turn over these
pages and feed them back into the printer.

8. Click Print.

If you’re printing labels, a dialog box appears. If you want to start printing on a label
other than the first one in the upper-left corner of the sheet, click the label that you
want to start printing with—the labels preceding it become shaded, indicating that
Now Contact will skip them. Specify the number of labels to print and click OK.

The Contact information is printed.
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Templates
Templates determine the page size, margins and pre-entered text in your printed output.
Several preset Templates are included with Now Contact, and you can design or modify
Templates using the Template Editor.

Templates are stored in the Templates folder that the Installer places in the Now Contact
folder on your hard disk. Inside the Templates folder are individual folders for each of the
Template types.

Creating and modifying Templates
The following procedure describes the basic options available when you’re creating or
modifying a Template.

To create or modify a Template:
1. Choose the type of Template you want to create or modify from the Templates sub-

menu of the Define menu.

The Define Templates dialog box opens.

Choose a Template Type 
from this pop-up menu

The page 
dimensions of 
the selected 
Template are 
shown here

Click to select a 
Template from 
this list

Click to display the 
Dimensions dialog 
box for the selected 
Template

Click to display the 
Template Editor

2. Select the Template that you want to duplicate or modify.

3. Depending on the desired result, click New or Duplicate.

A dialog box appears, prompting you to give the new Template a name.

4. Type a name for the new Template and click “OK.”

You’re returned to the Define Templates dialog box where the new Template now ap-
pears in the Templates list.
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5. Highlight the Template name and click Dimensions.

Depending upon the kind of Template you’re creating or modifying, the options avail-
able here can differ. If you’re working with a Letter, Fax, Contact Details or Contact
List Template, the dialog box appears as shown below.

If you’re working with an Address Book, Envelope or Label Template, additional op-
tions appear in the dialog box. See the descriptions in the “Template Setup Options”
section for details.

6. Configure the Dimensions options as desired for the Template.

If you’re working with a Letter, Fax, Contact Details or Contact List Template, set the
margins for your printed output.

7. Click OK.

You’re returned to the Define Templates dialog box.

8. Click Layout.

The Template Editor window opens. This is where you enter predefined text or graph-
ics that will appear in a Template by default when you use it to print.

9. Place the desired text or graphics in the Template.

Use the tools and options available in the Template Editor just as you would use simi-
lar tools in any word processor. See “Using the Template Editor” later in this chapter.

10. When you’re finished placing the desired elements in the Template, click OK.

The Template Editor closes, and you’re returned to the Define Templates dialog box.

11. Click OK.

You’re returned to your current Contact File.
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Using Templates
Templates determine the page size and margins of your printed Contact information and
documents. Templates also determine what text, if any, is pre-entered in the address
books, envelopes and labels you print. There are seven types of Templates, each of which
has a corresponding command on the Templates submenu of the Define menu:

• Address Books
• Contact Details
• Contact Lists
• Envelopes
• Faxes
• Labels
• Letters

This section describes the common settings in the Dimensions dialog box, with notes for
some of the specific Template Types.

Template setup options
When you click the Dimensions button for Address Book, Envelope or Label Templates in
the Define Templates dialog box, the Dimensions dialog box appears.

The selected Template 
name is displayed here

If desired, 
modify the 
default 
measurements 
for the selected 
Preset Size

Click to select 
measurement options

This area displays 
a preview of your 
settings

Select a Preset 
Size from this 
pop-up menu

This setting… Specifies…
Preset Sizes The basic page size used as a starting point for the Template. When

you choose a size from this menu, the appropriate values are auto-
matically entered in the Item Dimensions fields.

Margins The orientation of pages on the original sheets. “Left” sets how far
from the left edge the first page on a sheet is printed, and “Top” sets
how far from the top edge the page is printed.

continued on next page
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This setting… Specifies…
continued from previous page

Items per sheet The number of pages, envelopes, or labels per sheet. In the Across
text field, specify the number to print across the width of the sheet;
in the Down text field, specify the number to print down the height
of the sheet.

Item Dimensions The size of the printable area of each item on a sheet.

Space between The amount of empty space left between pages, envelopes or labels.

Address Book Template Setup options
Now Contact can automatically produce Address Book output in five basic page sizes that
fit most popular address book formats. Use one of these five sizes as defined, or use one as
a starting point for a custom Template.

Page size Dimensions
Compact 4.25" x 6.75". Two pages take up only a portion of a sheet; the pages need

to be cut to fit into an address book.

Jr. Pocket 2.75" x 5". Two pages take up only a portion of a sheet; the pages need to be
cut to fit into an address book.

Organizer Two pages fit exactly on one sheet of the selected paper size; the two pages
can be folded or cut to fit into an address book.

Portfolio Takes up an entire sheet of the selected paper size; requires no cutting after
being printed.

Sr. Pocket 3.75" x 6.75". Two pages take up only a portion of a sheet; the pages need
to be cut to fit into an address book.

An Address Book Template consists of a single text object that contains the merge fields
you want to include for each Contact printed. When you actually print the Template, this
text object is repeated down the height of each Address Book page as often as it will fit.
Note that the Template Editor displays only one text object, even in Preview mode.

Contact Details Template Setup Options
Contact Details Templates provide a way to print a detailed summary of a Contact.

The Template Setup options for Contact Details printing are simple: you specify the left,
right, top and bottom margins for the printed output. You set up Templates for Contact
Details printing in essentially the same way that you set up Templates for letters and
faxes—a single text object is placed on the page, and you insert, arrange and format merge
fields as desired.



142 Chapter 12

Contact List Template Setup Options
Contact Lists let you print specified Contacts, formatted according to any of the List Lay-
outs you’ve created. Contact Lists print your Contact List exactly as you see it on your
screen.

Because Contact Lists are based on your List Layouts rather than on actual Templates, you
can’t create or modify Contact List Templates from the Define Templates dialog box—
you can only modify their page margins. Choose Define List Layouts from the List menu
to modify the Layouts on which Contact List printing is based.

The Template Setup options for Contact Lists are the same ones available for Contact De-
tails: you specify the left, right, top and bottom margins for the printed output.

The Fit to Page option in the Printing Options dialog box lets you fit all fields in a Contact
List across one printed page, even if the List Layout it’s based on contains more fields
than will normally fit on the page.

Envelope Template Setup options
Now Contact lets you place multiple text objects in an Envelope Template. The most typi-
cal use for multiple text objects is to place one in the upper-left corner and insert your re-
turn address into it, and place one in the middle of the envelope and insert the desired
merge fields for Contact information into it.

Use the various graphics tools to add graphic elements such as lines, boxes, and pictures or
logos as desired.

To place a bar code in the Template, select the Bar Code tool in the Template Editor Tool-
bar and then click anywhere in the Template; the bar code appears where you clicked. The
recommended placement is just below the address. When you print a document using this
Template, Now Contact inserts the correct bar code for the Contact being printed, instead
of the placeholder shown on your screen.

Label Template Setup options
You can create or modify Templates for labels of virtually any size. Since labels are fre-
quently used to place shipping information on packages, Now Contact provides you with
the same options for Label Templates as for Envelope Templates.

A Label Template consists of one or more text objects, usually depending on the size of
the basic label you’re printing. A large shipping label might contain one text object for a
return address and another for a destination address. Label Template text objects can con-
tain static text or merge fields you specify for each Contact printed.

Word Processor documents
You can create document Templates to use as the basis for letters and faxes you create in
the Now Contact Word Processor. You can include merge fields in your document Tem-
plates, making it possible to send important information to several people at once without
having to write a separate letter for each recipient. See “Creating and Printing Docu-
ments,” later in this chapter for more information.
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Using the Template Editor
The Template Editor combines familiar word processor features with graphics capabilities
for creating the basic foundations of print documents.

Ruler

Text formatting 
tools Ruler

Toolbar

Click to display the 
Dimensions dialog box

Left margin 
control

Right margin 
control

Template Editor Toolbar
The Template Editor features a Toolbar at the top of the window. The graphics tools and
buttons that are available depends on the type of Template you are creating or modifying.

Text 
tool

Rectangle 
tool

Insert 
graphics

Select line 
thickness

Bring to 
front

Preview Next 
Contact

Insert 
Merge 
Field

Online Help

Selection 
tool Line 

tool

Rounded 
rectangle 
tool

Move 
to back

Previous 
Contact

Insert 
Compound 
Merge Field

Font pop-up 
menu

Bold

Italic Underline

Flush 
left

Center

Flush 
right

Justify

Single 
space

Double
space

One-and-a-
half space

Font  size 
pop-up 
menu

Left 
tab

Right 
tab

Decimal 
tab

Center 
tab
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Working with graphics
You can place graphics saved in MacPaint, PICT or EPS format to your Template. Graph-
ics are placed as separate elements in Address Book, Label, Envelope and Contact List
Templates; they’re placed in-line with text in document and Contact Details Templates.

To Now Contact 1.x users: When you use version 1.x Letter, Fax and Contact Details
Templates in Now Contact version 3.8, graphics contained in the Templates are converted
from separate elements to inline graphics.

To place a graphic in a Template:
1. Click the Picture tool.

A directory dialog box opens where you locate and select a graphic to place.

2. Locate and select the graphic you want to place in the Template.

3. Click Open.

The pointer changes to a special picture cursor for placing your graphic ().

If you’re creating or modifying an Address Book, Label, Envelope or Contact List
Template, you can place the graphic anywhere on the page. If you’re creating or
modifying a Letter, Fax or Contact Details Template, the graphic is placed at the text
insertion point.

4. Click to place the graphic.

To resize a graphic in a Template:
1. Click the graphic once to select it.

2. Drag one of the four corner handles.

All resizing is proportional.

To move a graphic in a Template:
1. Click the graphic once to select it.

2. Drag it from its center.

Using merge fields in Templates
Merge fields let you automatically place specific pieces of Contact information in pre-
defined areas of your Templates.

Compound merge fields
Clicking the Compound Merge Field button in the Template Editor Toolbar opens a long
pop-up menu of compound merge fields and options; fields are surrounded by angle brack-
ets (« »), while options are not. The sections of fields and options are divided by separators.
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The following table shows which merge fields are inserted for the options in the first two
sections.

Choose this… To insert…
«Today’s date» Today’s date

Primary Postal Address «Listing»
«PriAddress»
«PriCity», «PriST» «PriZip»
«PriCntry»

Home Postal Address «FullName»
«HmAddress»
«HmCity», «HmST» «HmZip»
«HmCntry»

Work Postal Address «FullName»
«Company»
«WkAddress»
«WkCity», «WkST» «WkZip»
«WkCntry»

The third section of the compound merge fields list lets you insert the Home Return Ad-
dress and Work Return Address you’ve defined in the Personal Data pane of the Prefer-
ences window.

The fourth section of the compound merge fields list consists of field names based on the
data you’ve selected as Primary for each Contact. Choosing «FullName» and «Listing»
inserts the Full Name and Listing according to formats set in the General pane of the Pref-
erences window.

The fifth section of the compound merge fields list contains fields that insert information
about the Contact, as well as information on attachments to the Contact.

This section is not available for Address Book, Envelope and Label Templates.

Choose this… To insert…
«Keywords» A list of all Keywords specified for the Contact.

«Category» The Category to which you’re assigned.

«Notes» The text for all notes attached to the Contact.

«Events» A summary of all Calendar Events attached to the document.

«Documents» Information about all documents attached to the Contact—the
documents’ names, descriptions, and so on.

The last section in the compound merge fields list displays all of the Copy Contact Info
Formats that are set for the current Contact File. These are the same Format names that
appear on the “Copy Contact Info” submenu in the Edit menu. You set Copy Contact Info
Formats in the Copy Contact Info pane of the Preferences window.
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Inserting a Copy Contact Info Format name into a document allows you to enter several
blocks of Contact information in one step, rather than inserting the information one merge
field at a time.

Individual merge fields
The pop-up menu that appears when you click the Merge Field button lets you insert indi-
vidual merge fields, one at a time.

Inserting merge fields
To insert a merge field into a Template, position the cursor where you want the merge
field to be inserted, then choose the desired merge field from the Compound Merge Field
or the Merge Field menu. Choose the appropriate field or fields from the menu; the merge
field appears in the Template at the location you specified.

Format merge fields so that they’ll look correct when replaced with actual Contact data.
For example, when creating the last line of an address, be sure to place a comma and space
between «WkCity» and «WkST», and a space between «WkST» and «WkZip». You can
select any merge field in the Template Editor and apply any text style to it.

When applying a text style to a merge field, be sure that you select the entire merge field,
including the brackets surrounding it.

Preview the appearance of your Template by clicking the Preview button and then moving
forward and backward through Contacts in the current Contact File using the Next Contact
and Previous Contact buttons.

Creating and Printing Documents
You can use Now Contact’s built-in Word Processor to create documents such as letters
and faxes that can be either individual documents for a single Contact, or merge docu-
ments for multiple Contacts.

When you create a document, you can choose a Template to determine the document
specifications. Now Contact includes several preset document Templates, or you can de-
sign custom Templates using the Template Editor.

Word Processor Toolbar
The Now Contact Word Processor Toolbar buttons are described below.

Preview Next 
Contact

Insert 
Merge 
Field

Online Help
Previous 
Contact

Insert 
Compound 
Merge Field

New 
Document

Open

Save

Print

Cut

Copy

Paste

Clear

The Word Processor text formatting buttons are identical to buttons in the Template Editor.
For descriptions of these buttons, see “Template Editor Toolbar,” earlier in this chapter.
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Creating a letter or fax
The Word Processor provides all of the tools you need to create letters and faxes.

To create a letter or fax:
1. Select the Contact you’ll be sending the document to.

You can either select the Contact in the List View, or open the Detail View for the
Contact.

2. Choose New from the File menu.

A dialog box opens where you can select the type of new file you want to create.

3. Depending on the type of document you want to create, click the Letter or the Fax icon.

The icon becomes highlighted.

4. From the Template pop-up menu, choose the Template to use as the basis of the letter
or fax.

This pop-up menu displays all of the available Templates for the currently selected
document type. To create a document without any preset formatting specifications,
choose Blank Page and modify the document as needed.

5. Click OK.

The Now Contact Word Processor opens. If you selected a Template that contains
merge fields, they’re replaced by the actual data from the selected Contact.

Text formatting 
tools

Toolbar

Left margin 
control

Right 
margin 
control
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6. Type any additional text to be included in the document.

Add text as necessary, as you would in any word processor.

7. When you’ve finished working on your document or you want to save your work,
choose Save from the File menu or click the Save button in the Toolbar.

A standard directory dialog box appears, allowing you to name your document and
choose a location for storing it on your hard disk. The dialog box also includes a pop-
up menu for choosing a file type.

8. Choose a file type from the File Type pop-up menu.

Save the document as a Now Contact file to make it accessible from within Now
Contact’s Word Processor, or save it as a text file to open it with another word
processor.

9. Enter a name and choose a location for the document, then click Save.

The document is saved in the location you specified.

10. Close the Word Processor by clicking its Close box, or by choosing Close from the
File menu.

Creating a merge letter or fax
Creating a merge document is very much like creating an individual document, except that
you specify multiple Contacts as recipients instead of just one.

To create a merge letter or fax:
1. Select the Contacts you’ll be sending the merge letter or fax to.

You can either select the Contacts in the List View, or reduce the contents of the List
View to the desired recipients of the document by using the Find function or
QuickFind.

At print time, you can also choose to send a merge document to all marked
Contacts, or to all of the Contacts in your Contact File.

2. Choose New from the File menu, or click the New Document button.

A dialog box opens where you can select the type of new file you want to create.

3. Depending on the type of document you want to create, click the Letter or the Fax
icon.

The icon becomes highlighted.

4. From the Template pop-up menu, choose the Template to use as the basis of the letter
or fax.
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The Now Contact Word Processor opens. If you selected a Template that already con-
tains merge fields, they appear in your document.

6. Insert additional text or merge fields into the document as desired.

To insert a merge field, position the cursor where you want the merge field to go, then
choose the desired merge field using the Compound Merge Field or Merge Field pop-
up menus.

7. Preview your merge document with actual Contact data, if desired.

Click the Preview button to see how the document looks with the merge fields re-
placed by actual data. Click the Previous Contact or Next Contact buttons to move
through the Contacts.

You can’t edit your merge document in Preview mode; to resume editing the
document, click the Preview button again.

8. When you’ve finished working on your document or you simply want to save your
work so far, choose Save from the File menu.

A standard directory dialog box appears, allowing you to name your document and
choose a location for storing it on your hard disk. The dialog box also includes a pop-
up menu for choosing a file type.

9. Depending on the desired result, choose Now Contact 3.5 or Text from the File type
pop-up menu.

10. Enter a name and choose a location for the document, then click Save.

The document is saved in the location you specified. For instructions on printing your
document, see the next section, “Printing documents.”

11. Close the Word Processor by clicking its Close box, or by choosing Close from the
File menu.
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Printing documents
Two printing procedures are presented in this section. The first assumes that you want to
view and possibly modify the document before you print it. The second procedure shows
you how to take advantage of Now Contact’s Template-based printing to print your docu-
ment without previewing it.

To view and then print a document:
1. Select the Contact(s) to whom you’ll be sending the document.

You can either select the Contacts in the List View, or reduce the contents of the List
View to the desired recipients of the document by using the Find function or
QuickFind.

If you’re printing a merge document, you can also choose to send it to all
marked Contacts or to all of the Contacts in your Contact File.

2. Open the document that you want to print.

3. Make any desired changes to the document, or preview it if desired.

4. Choose Print from the File menu.

The Print dialog box opens with special Now Contact options at the bottom.

5. Set the Now Contact printing options as desired.

Select the Attach document to Contact(s) checkbox if you want to add the document
to the Contact Log(s) of the Contact(s) you’ve selected to receive it.

If you’re printing a merge document, choose from the Which contacts pop-up menu.

Choose… To print…
Template Preview The document with no Contacts, showing the merge fields

themselves.

Selected contacts The Contacts currently selected in the List View.

Marked contacts The Contacts that you’ve previously marked.

Current list The Contacts currently displayed in the List View.

Entire Contact File All of the Contacts in the Contact File..

The Which contacts pop-up menu is dimmed when you’re printing an individual
(non-merge) document.

6. Click Print.

The document is printed.

In merge documents, the order in which the Contacts are printed is determined
by the current list’s sort order.
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To print a document without previewing or modifying it:
1. Select the Contact(s) to whom you’ll be sending the document.

2. Choose Print from the File menu.

The Print dialog box opens with special Now Contact options at the bottom.

3. Click Select Template.

The Template Selection dialog box appears.

Choose Fax or Letter from the Template Type pop-up menu.

4. Select the Template that you want to use for printing.

5. Click OK.

You’re returned to the Print dialog box.

6. Set the Now Contact printing options as desired.

See step 5 in the previous procedure for an explanation of these options.

7. Click Print.

The document is printed.





QuickAccess Features 153

QuickAccess

Chapter 13

QuickAccess Features
Now Up-to-Date and Now Contact offer several quick access features that give you the
ability to view, enter and edit Calendar and Contact information without having to launch
the main applications. The QuickAccess components are described in the following table,
and the rest of this chapter describes each one in detail.

This component… Lets you…
QuickContact View, edit and dial existing Contact, find existing Contacts, and create

new Contacts.

QuickDay View and edit Events for the current day, receive and respond to Re-
minders, and create new Events.

QuickPad Enter new Event and Contact information in an intuitive and free-form
way.

Using QuickContact
The QuickContact component adds a pull-down menu of Contacts, telephone numbers and
options to your menu bar. You can find, view, dial, and copy Contact information from
QuickContact. You can also use QuickContact to launch Now Contact where you can
modify Contact information and create new Contacts.

Adding Contacts to QuickContact
You specify which Contacts in your primary Contact File appear in the QuickContact
menu by selecting the QuickContact checkbox in the Contacts’ Detail Views. You must
save the Contact File before the newly added Contact will appear in the QuickContact
menu.
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Configuring QuickContact
Before you can use QuickContact to find Contacts and display frequently called Contacts
in the pull-down menu, you need to set up the QuickContact control panel.

This section assumes that you installed QuickContact when you installed Now Contact,
and that you’ve restarted your Macintosh since installation. If this isn’t the case, please do
so before proceeding.

To configure the QuickContact control panel:
1. Open the QuickContact control panel.

Open the control panel by choosing Control Panels from the Apple menu and locating
and opening QuickContact.

The name of your primary Contact File appears at the bottom of the control panel.

2. Select the On radio button next to QuickContact Menu Icon.

3. Choose a font and size from the Menu Preferences pop-up menus.

4. Select the “Show Phone Labels” checkbox if desired.

Selecting this checkbox precedes the telephone numbers in the QuickContact menu
and the QuickContact Find dialog box with a label indicating whether they are Work,
Home, Fax or Mobile numbers (or a telephone number in a Custom Field).

5. Click the Find Hotkey button.

A dialog box appears where you specify a hotkey to open the QuickContact Find dia-
log box.

6. Press the desired key combination in the “Enter Hotkey:” text field.

The hotkey can be any combination of letters and numbers plus one or more modifier
key (Shift, Command, Option, Control or a function key). The key combination you
press appears in the text field.

7. Click OK.

Your hotkey is saved; press this key combination in any application to open the
QuickContact Find dialog box.

8. Select an option from the Selecting item in menu pop-up menu.
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The four options in this pop-up menu determine what happens when you choose a
Contact from the QuickContact pull-down menu.

Choose… To…
Shows More Info Display the Contact’s essential information in the

QuickContact Find dialog box.

Opens Contact Record Open Now Contact and then open the Detail View for the
selected Contact.

Dials Primary Phone Dial the Primary telephone number for the Contact you
chose.

Copies to Clipboard Copy the Contact’s essential information to the Clip-
board.

9. Close the QuickContact control panel.

Your QuickContact settings are saved. QuickContact settings are stored in the
QuickContact Preferences file located in the “Now Contact Prefs” folder inside your
Preferences folder.

10. Click the QuickContact icon in the menu bar.

The Contacts in your primary file that you’ve specified to include in QuickContact
now appear in the QuickContact menu.

Working with QuickContact
This section describes how to use QuickContact to view Contacts, create new Contacts,
find a Contact, and more.

To view a Contact using QuickContact:
1. Click and hold the QuickContact icon in the menu bar.

The QuickContact menu displays several options and the list of Contacts you’ve se-
lected from your primary Contact File.

Choose to launch Now Contact  

Choose to open the Now Contact 
Detail View for a new Contact

Choose to open the QuickContact 
Find dialog box

Choose a Contact to 
open the QuickContact 
dialog box

2. Choose one of the Contacts in the menu.
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The QuickContact dialog box displays the Contact information for the selected Contact.

Click to open the 
Now Contact Detail 
View for the Contact

Click to copy the 
Copy Contact info 
to the Clipboard

Click to open the Now 
Contact Detail View 
for a new Contact

Click to quit 
QuickContact

Click to open the 
QuickContact Find 
dialog box

Click to dial the 
number shown

3. Click the Cancel button to dismiss the dialog box.

Alternately, you can hold down the Option key while choosing a Contact from
the QuickContact pull-down menu to open your primary Contact File in the full
Now Contact application and open the Detail View for the selected Contact.

To find a Contact using QuickContact:
1. Choose a Find Contact from the QuickContact menu.

The QuickContact Find dialog box appears.

2. Type the text you want to search for in the Find text field.

QuickContact searches your entire Contact File based on First Name, Last Name,
Company and Full Name, so choose the text to search for according to these criteria.
The Full Name option allows you to search for Contacts simply by typing the first let-
ters of their first and last names, with a space in between.

3. Click the Find button (or press the Return or Enter key).

The names of any Contacts matching the text you entered appear in the box below the
Find field, followed by their Company names. The first Contact in the found list is
selected, and information for that Contact appears to the right.

To dial a Contact using QuickContact:
1. Choose a Contact from the QuickContact menu, or find a Contact as described above.

The QuickContact dialog box displays the Contact information for the selected Contact.

2. Click the phone icon button next to the number you want to dial.

See “Dialing Contacts” in Chapter 9, “Viewing and Dialing Contacts,” for details.
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To modify a Contact using QuickContact:
1. Choose a Contact from the QuickContact menu.

The QuickContact dialog box displays the information for the selected Contact.

2. Click the Open Contact button.

Now Contact opens and displays the Detail View for the selected Contact.

To create a new Contact with QuickContact
1. Choose New Contact from the QuickContact menu.

Now Contact opens and displays an empty Detail View window.

2. Enter the new Contact information.

Using QuickDay
The QuickDay component adds a pull-down menu to your menu bar. It also lists the current
day’s Holidays and Special Events, Appointments, To-Dos, Calls and Undated To-Dos. The
QuickDay menu lets you create new Events, edit existing Events and open Now Up-to-Date.
This provides you with a quick way to glance at your schedule without having to launch
Now Up-to-Date, or to edit any of the listed Events simply by choosing one of them.

Working with QuickDay
The QuickDay pull-down menu makes it easy to view, create and edit Events, even when
you’re not running Now Up-to-Date.

Events that you create or modify using the QuickDay Event Info dialog box aren’t saved to
your Calendar File until you open it in Now Up-to-Date.

To check your schedule using the QuickDay menu:
1. Pull down the QuickDay menu by clicking and holding the QuickDay menu bar icon.

Below the commands, the menu lists the current day’s Holidays and Special Events,
Appointments and Meetings (in chronological order), and To-Dos, Calls and Undated
To-Dos.

You can specify which Event types appear in the QuickDay menu. See “Setting
Event Menu preferences” later in this chapter for more information.

To create a New Event using QuickDay:
1. Choose New Appt. from the QuickDay menu.

The QuickDay Event Info dialog box appears, with your primary Calendar File listed
at the top right. A new Appointment is created automatically with the default attributes.

2. Enter the desired text and values for the new Appointment in the dialog box.

There are a few limitations when using this dialog box to create or edit Events, as
compared to using the Event Info window in Now Up-to-Date:
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• Public Events are created and edited offline, and aren’t posted to the Public Event
Server until the next time you open your Calendar File in Now Up-to-Date.

• Only standard Repeating Events can be created; Custom Repeats aren’t available.
• You can’t create or edit Sticky Notes, Banners or Graphics.

3. Click Add to save the settings for the new Event.

4. Click OK to close the dialog box.

To edit an existing Event using QuickDay:
1. Pull down the QuickDay menu.

2. Choose any Event from the menu.

The QuickDay Event Info dialog box appears with the Event selected.

3. Make any desired changes to the Event.

Note the following limitations in this dialog box:

• Public Events are created and edited offline, and are posted to the Public Event
Server until the next time you open your Calendar File in Now Up-to-Date. If
you’ve modified Events contained in password-protected Public Categories, you’ll
be prompted for the passwords when you open your Calendar File.

• Only standard Repeating Events can be created; Custom Repeats aren’t available.
• Editing the description of a Repeating Event changes the description of all future

Events in the repeating series, without first asking you whether the change should
affect one, all or future occurrences.

• You can’t edit Meeting Notices, only view them.
• You can’t create or edit Sticky Notes, Banners or Graphics.

4. Click OK to save the new settings for the Event and close the dialog box.
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Setting QuickDay preferences
Use the Preferences settings in the QuickDay control panel to specify what items appear in
the QuickDay menu, how QuickDay reminds you of your Now Up-to-Date Events, and
more.

To set Event Menu preferences:
1. Open the QuickDay control panel.

Open the control panel by choosing Control Panels from the Apple menu and then lo-
cating QuickDay.

The name of your primary Calendar File appears at the bottom of the control panel.

2. Depending on whether or not you want to use the QuickDay Event menu, select
“Bell” or “Off.”

Select “Bell” to have the bell icon appear in the menu bar so that you can use the
Event menu; select “Off” if you don’t want to use the menu at all.

If you select “Off,” you will not receive any reminders for which you’ve chosen
the “Menu Bar Alert” notification option. You can close the control panel at
this point, since the Event Menu will not be displayed.

3. Click Preferences.

The Preferences dialog box appears.

4. Choose Event Menu from the Preferences pop-up menu.

The Event menu pane of the Preferences dialog box appears.
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5. Select the checkboxes for the Event types you want to appear in the QuickDay Event
Menu.

The Event types you select will appear in the pull-down menu.

6. Select the checkboxes for the commands you want to appear in the QuickDay menu.

7. To set a Hot Key for an Event menu command, highlight the text field next to the
command and press a key or key combination.

Once you’ve configured a Hot Key, pressing the corresponding key combination will
activate that command.

8. Specify a font and font size for the QuickDay menu text.

9. Click OK to save the QuickDay menu settings.

You’re returned to the QuickDay control panel.

To set Reminder preferences:
1. Open the QuickDay control panel.

2. Click Preferences.

The Preferences dialog box appears.

3. Choose Reminders from the Preferences pop-up menu.

The Reminders pane of the Preferences dialog box appears.

4. Set a Default snooze delay for your Reminders.

When a Reminder appears, you can delay it for this period of time by clicking Snooze.
(You can also change the Snooze delay for an individual Event when its Reminder
appears.)

5. Set an Auto Snooze after delay for your alert dialog box Reminders.

When a Reminder alert dialog box appears, it remains on screen until this period of
time has passed; it then snoozes automatically for the amount of time you set for the
default snooze delay in step 4.
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This setting applies only to alert dialog box Reminders. It ensures that the alert dialog
boxes don’t interrupt background processes such as printing or modem downloads.

6. Set a Stop reminding after period for your Reminders.

When a Reminder appears for an Event and you don’t dismiss it, it reappears until the
period of time specified here has passed.

7. Select a default alert action for your Reminders.

Dismisses Reminder turns off the alert when you acknowledge the Reminder. Snoozes
Reminder delays the alert for the default snooze time you specified in step 4 when you
acknowledge the Reminder.

You acknowledge menu bar alerts by clicking on the menu bar display when the alert
appears. You acknowledge dialog box alerts by pressing the Return or Enter key when
the alert appears; depending on your selection here, either the Snooze for or Dismiss
button in the dialog box is already highlighted.

8. Click OK to save the Reminder settings.

You’re returned to the QuickDay control panel.
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Using QuickPad
QuickPad, included with Now Up-to-Date & Contact, gives you the ability to enter new
Calendar and Contact information quickly and at your convenience without forcing you to
open the main applications. QuickPad uses SmartWords to automatically define and
schedule Events; see “Using SmartWords” later in this chapter for details.

Working with QuickPad
This section details how to use QuickPad’s features to create Events or Contacts, find a
Contact, jot down notes, dial a call, and other useful functions.

In order to use QuickPad to find a Contact, you must already have selected a primary
Contact File in Now Contact. See Chapter 8, “Using Now Contact” for more information.

To create an Event with QuickPad:
1. Open QuickPad by choosing it from the Apple menu or using the QuickPad hot key.

See “Setting QuickPad Preferences” later in this chapter for more information on set-
ting the hot key.

The appearance of the QuickPad window differs slightly for each Event type.
For illustration purposes, an Appointment window, which contains a majority
of the available elements, is shown above.

2. Type a title for your Event in the Title field.

If the first word you type is a SmartWord, QuickPad selects the corresponding Event
type when you tab out of the field, and schedules the Event with the preset start and
end times, if appropriate. To override the selection, click another Event type button at
the top of the QuickPad window.

3. Type additional text relating to this Event in the Description/Notes field.

4. Set or override the date and the start and end times.

You can also use the Date/Time Picker to choose a date and time.
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5. To attach a Contact from your Contact File, type the Contact’s name in the Name field
and press Tab.

QuickPad searches for matching names from your Contact File. See “To find a Con-
tact with QuickPad” later in this chapter for details.

6. To accept a Contact name suggested by QuickPad, press Tab.

The company name and primary telephone number for the Contact appear in the Com-
pany and Phone fields.

7. Click the Save button.

The Event is saved to your primary Calendar File.

You can also save an item by pressing the Enter key, or by choosing Add Item
from the File menu.

If you simply close the QuickPad window, a dialog box appears asking if you want to
save the item to its respective Calendar and/or Contact File, or discard it.

If you quit the QuickPad application, any open windows are retained without being
saved to a Calendar and/or Contact File. The next time you launch QuickPad, the un-
saved windows will open, along with a new window.

To create a Contact in QuickPad:
1. Open a QuickPad window by choosing QuickPad from the Apple menu or using the

QuickPad hot key.

2. If desired, enter Event information as described above.

3. Type the new Contact’s first and last names in the Name field, and press Tab.

4. Type the Contact’s company name in the Company field, and press Tab.

5. Type the Contact’s primary telephone number in the Phone field, and press Tab.

6. Select a phone type (work or home) from the Phone types pop-up menu.

7. Click the Save button.

New Contacts are stored according to the preferences you defined for new
Contacts in the Now Contact Preferences dialog box.

To find a Contact in QuickPad:
1. Open a QuickPad window by choosing QuickPad from the Apple menu or using the

QuickPad hot key.

2. Type a first or last name in the Name field, or a company name in the Company field,
then press Tab.

QuickPad automatically enters the first alphabetical matching name from your Contact
File. If multiple matches are found, the Find Contact button appears as a head icon. If
no matches are found, the Find Contact button appears as a question mark icon.
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3. Click the Find Contact button.

If QuickPad found one or more matches, the matching Contacts are displayed. Select a
Contact entry and click OK to add it to the QuickPad window.

If QuickPad found no matching entries, the Find dialog box opens. You can then per-
form a more detailed search, or create a new Contact as described above.

To dial a phone number in QuickPad:
1. Open a QuickPad window by choosing QuickPad from the Apple menu or using the

QuickPad hot key.

2. Find an existing Contact with its phone number, as described above, or enter a new
phone number in the Phone field.

3. Click the Dial button.

The dialing functions use the settings that you’ve specified in Now Contact. See “Di-
aling Contacts” in Chapter 9, “Viewing and Dialing Contacts,” for details.

Using SmartWords
QuickPad uses SmartWords to help you create Events and attach Contacts without specify-
ing an Event type in the Toolbar, or clicking the Find button to find a Contact. If the first
word you type in the Title field is a SmartWord, QuickPad selects the corresponding Event
type when you tab out of the field, and schedules the Event with preset start and end times.
The following table lists the SmartWords that you can use to trigger specific actions in
QuickPad.

You can type SmartWords in any format you want—all capital letters, all lowercase let-
ters, or any combination.

Type this SmartWord… To trigger this action…
with, w/, at, @, or see [first or last name] attach a Contact name to the current Event, as

in “lunch with monica”.

meet, meeting, appt, visit, or see create an Appointment scheduled to start at
the current time by default.

call, phone, ring, or fax create a Call scheduled for the current time.

to-do, todo, or do create a To-Do scheduled for the current time.

breakfast create an Appointment from 7:00 am to 8:00
am.

lunch create an Appointment from 12:00 noon to
1:00 pm.

dinner create an Appointment from 7:00 pm to 8:00
pm.

note or remember create a Note.
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You can attach Contacts to Events using the SmartWord “with.” Just follow one of the
SmartWords listed above with the word “with,” followed by a Contact’s first, last, or com-
pany name. The first matching Contact found will be attached by default.

Using QuickPad throughout the day
Save space in the QuickPad display by clicking the Minimize button in the title bar. When
you minimize a window, only a small bar remains displaying the item’s title, and you can
drag the bar to any location. Click the Minimize button again to see the entire window.

Minimize button

Minimizing a QuickPad window does not save the item to your Calendar or Contact file.
You must specifically choose to Save or Add the item as described in the previous section.

QuickPad supports drag and drop, so you can drag selected text from the Description/Note
field (or other fields) into Now Up-to-Date or Now Contact, to another application or to
the Finder to create a clipping file. You can also drag text from other applications into
QuickPad’s text fields.

Setting QuickPad preferences
Preferences let you specify how you want to open the QuickPad application, and which
Event type appears by default when you open a new window.

Open the QuickPad application either by choosing it from the Apple menu or using a hot
key. The default hot key is Control-Option-Command-Spacebar.

To set QuickPad preferences:
1. Choose Preferences from QuickPad’s File menu.

The QuickPad Preferences dialog box opens. The default hot key combination appears
in the New Item Hot Key field.
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2. Press the key combination you want to use to open a new QuickPad window in the
New Item Hot Key field.

Your hot key can be any combination of letters and numbers plus one or more modi-
fier keys (Shift, Command, Option, Control or a function key). The key combination
you press appears in the text field.

3. Choose an item type from the Default Item Type pop-up menu.

The item type you choose (Appointment, Call, To-Do or Note) will be selected by de-
fault when you open a new QuickPad window.

4. Click OK.

Your hot key is saved; you can now use it in any application to open a QuickPad win-
dow with the default item type you selected.
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Linking Events and Contacts
Now Up-to-Date integrates seamlessly with Now Contact, letting you share information
easily and efficiently between the two applications. You can create new Contacts in Now
Up-to-Date and automatically add them to your Now Contact File, and you can search for
specific Contacts and link them to an Event without leaving Now Up-to-Date.

When you create a linked Contact from within Now Up-to-Date, the Contact information
is sent to Now Contact via Apple Events and added to your primary Contact File by de-
fault. Similarly, when you create a linked Event in Now Contact, the Event information is
sent to Now Up-to-Date via Apple Events and added to your primary Calendar File. Once
you create a linked Contact or Event, you can switch applications and see the linked item
in the other file instantly.

If the application you’re linking to isn’t running at the time, the sending application uses a
“store and forward” technique to make sure the new information is saved and added the
next time you launch the destination application.

Now Up-to-Date links to your primary Contact File by default, just as Now Contact auto-
matically links to your primary Calendar File.

If you make changes to the linked Contact or Event after its creation (for example, a
Contact’s telephone number changes, or an Event’s time or date changes), the changes are
recorded in both applications regardless of where they were made.

Setting linking preferences
Before you begin sharing information between Now Up-to-Date and Now Contact, you
need to specify in the Preferences windows of each application how you want the commu-
nication to occur.

The steps below describe how to set linking preferences from within Now Up-to-Date.
Follow the same procedure from within Now Contact.
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To set linking preferences:
1. Choose Now Contact from the Preferences submenu of the Define menu.

The Now Contact pane of the Preferences window appears.

2. To link to a Now Contact file other than your primary Contact File, click the Contact
File button.

It’s best to maintain the same pair of linked files at all times.

A directory dialog box appears, where you locate and select the Contact File you want
to link to.

3. Locate and select the desired Contact File, then click Link.

The file you selected is now the destination for Contacts you create and link from
within Now Up-to-Date, as well as the source for Contacts you link to Now Up-to-
Date from within Now Contact.

4. Select or deselect the Always link Contacts to contact file and Transfer to Now Con-
tact when creating new Contacts checkboxes as desired.

Always link Contacts to contact file automatically links every new Contact to the se-
lected Contact File. If you don’t want all Contacts created in Now Up-to-Date to be
linked to your Now Contact File, deselect this checkbox.

Transfer to Now Contact when creating new Contacts automatically transfers you to
Now Contact whenever you create a new Contact.

5. Choose a default telephone number type from the Primary Phone: pop-up menu.

This telephone number type (Work, Home, Fax or Mobile) is automatically selected in
the New Contact dialog box when you create a new Contact.

There is no corresponding selection in the linking preferences from within Now
Contact.

6. Close the Preferences window.

You’re returned to your Calendar File. The Now Up-to-Date preferences for linking
with Now Contact are set.
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Working with linked Contacts in Now Up-to-Date
Use the Now Up-to-Date Event Info window to create, edit, and search for Contacts stored
in your linked Contact File. You can tell by looking at the Event Info window whether a
Contact attached to an Event is linked or not, as shown below.

Unlinked Contact

Linked to another user’s Contact File

Linked to your Contact File

To create a linked Contact:
1. Locate the Event to which you want to attach a linked Contact.

2. Double-click the Event.

The Event Info window opens.

3. Choose New Contact from the Contact submenu of the Event menu, or click the New
Contact button in the Toolbar.

The New Contact dialog box appears.

4. Enter the desired Contact information in the appropriate fields.

5. Select the Add to checkbox.

If you selected “Always link Contacts to contact file” in the Now Contact pane of the
Preferences window, this checkbox is selected by default.

Click to open Now Contact to the 
Detail View for this Contact

Displays the name of 
the linked Contact File

6. Click OK.
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Once a Contact is linked to a Contact File, it cannot be unlinked. The only way to
break the link is to delete the Contact or the Event.

Only a first, last and company name and a single telephone number for a Con-
tact appear in Now Up-to-Date.

To edit a linked Contact:
1. Double-click the Contact in the Event Info window’s Contact field.

The Contact Info dialog box appears. If more than one Contact is attached to the
Event, the total number of attached Contacts is listed in the upper-right corner; click
the left and right arrows to display the other attached Contacts.

2. Make the desired changes to the Contact.

You can edit any of the text fields in the dialog box.

When you’re connected to a network and sharing Event information with other
users, you may view, but not modify, Contact entries linked to other users’ Con-
tact Files.

3. Click OK.

The changes appear in the Contact field of the Event Info window and in the Contact
in your Contact File.
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To find an existing Contact and link it to an Event:
1. Locate the Event to which you want to attach a linked Contact.

2. Double-click the Event.

The Event Info window opens.

3. Choose Find Contact from the Contacts submenu of the Event menu, or click the Find
Contact button in the Toolbar.

The Find Contact dialog box appears.

4. Type the text you want to search for in the text field.

You can search for a Contact by first name, last name, full name or company name.

5. Click Find.

A dialog box appears, listing all of the Contacts in the linked Contact File that match
your search text (if no matching Contacts are found, the dialog box indicates “0 con-
tacts found”).

6. Select the desired Contact.

Click to re-enter 
search text

Click to create a 
new Contact

7. Click Attach to Event.

You’re returned to the Event Info window, where the Contact appears with a Contact
icon in the Contact field.
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Linked repeating Events
Now Contact handles linked repeating Events differently than Now Up-to-Date, which of-
fers flexible handling of repeating Events and lets you view them wherever they occur in
your Calendar File. If you link a Contact to a repeating Event, Now Contact’s Contact Log
displays only the last repeating Event in the series (if the last Event is in the past) or the
next occurrence in the series; no other Events in a repeating series are listed.

Deleting linked Contacts
You can delete linked Contacts from the Contact field of an Event’s Event Info window.
Deleting a Contact from Now Up-to-Date does not delete the Contact itself from your
Now Contact File.

If you delete an Event to which you’ve attached linked Contacts, the linked Contact entries
are deleted along with it. The Event entry is deleted from each of the corresponding Con-
tacts’ Contact Logs, but the Contacts themselves are not deleted.

You cannot delete a Contact linked to a Public Event if the Contact is linked to another
networked user’s Contact File. Such a Contact appears in the Event Info window preceded
by a dimmed Contact icon.

To delete a linked Contact:
1. Locate the Event that contains the Contact you want to delete.

2. Double-click the Event.

The Event Info window opens.

3. Select the Contact in the Contact field.

4. Press Delete/Backspace.

The Contact is removed from the Contact field, and the corresponding Calendar Event
in Now Contact is deleted from the Contact’s Contact Log.

You can “re-link” the Contact at any point by finding the Contact and attach-
ing it to the Event again.

Working with linked Events in Now Contact
Now Contact lets you create Calendar Events manually in the Detail View, or automati-
cally when you dial a Contact’s telephone number. You can link these Events so that they
also appear in your Now Up-to-Date Calendar File, which lets you receive automatic up-
dates whenever the Events are modified in Now Up-to-Date.
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Creating linked Calendar Events in the Detail View
Creating linked Calendar Events when using Now Contact and Now Up-to-Date together
is only slightly different from creating unlinked Events.

Certain elements of Now Up-to-Date’s Event Info window are missing from Now
Contact’s Event Info window—for instance, the Priority, Repeat and Remind settings, and
some of the available Event types (Banner, Sticky Note and so on). When you link a Calen-
dar Event to your Now Up-to-Date Calendar File, these settings take on the values you set
in the Event panes of the Now Up-to-Date Preferences window.

To create a linked Calendar Event:
1. Open a Contact’s Detail View.

The Contact Log at the bottom of the Detail View displays any Events already at-
tached to the Contact; the most recent Events appear at the top of the log.

2. Choose an Event type from the New Event submenu in the Contact menu, or click the
appropriate Event button in the Toolbar.

The Event Info window opens, where you enter the necessary information for the new
Calendar Event. See “Creating Calendar Events for a Contact” in Chapter 8, “Using
Now Contact,” for a full discussion of available Event types.)

If you selected the “Transfer to Now Up-to-Date when creating new events”
checkbox in the Preferences window, Now Contact transfers you to your Now
Up-to-Date Calendar File immediately after you choose an Event type. The
Event Info window for the new Event opens in Now Up-to-Date, with the new
Event already linked to the original Contact. See “Creating New Events” in
Chapter 3, “Using Now Up-to-Date” for more details on creating Events.

3. Enter the appropriate information for the new Calendar Event.

4. Click the Link/Unlink Event button in the upper-right of the window.

If you selected Always link events to calendar file in the Preferences window, the
Event is already linked. If you don’t want this particular Event to be linked to your
Now Up-to-Date Calendar File, click the button again.
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5. Close the Event Info window.

You’re returned to the Detail View. If your Calendar File is currently open in Now
Up-to-Date, the new Event has been added. If your Calendar File is not currently
open, the new Event is added the next time you open the Calendar File.

You can switch quickly to your Now Up-to-Date Calendar File by Option-
double-clicking a linked Event in the Contact Log—you go directly to the cor-
responding Event Info window.

Deleting linked Events
You can delete linked Events from either the Detail View or the Event Info window. De-
leting an Event from Now Contact does not delete the Event itself from your Now Up-to-
Date Calendar File.

If you delete a Contact that contains linked Events, the linked Events are deleted along
with it. The corresponding Events in your Now Up-to-Date Calendar File lose their entries
for the deleted Contact, but the Events themselves are not deleted.

To delete a linked Event in the Detail View:
1. Open the Detail View for the Contact with the linked Event you want to delete.

2. Select the Event in the Contact Log and press the Delete key.

The Event entry is removed from the Contact Log, and the corresponding Event in
Now Up-to-Date loses the Contact that was attached to it.

To delete a linked Event from the Event Info window:
1. Open the Detail View for the Contact with the linked Event you want to delete.

2. Double-click the Event in the Contact Log.

The Event Info window opens.

3. Click the Link/Unlink Event button in the upper-left corner of the window.

The icon on the button changes to a broken chain, and the corresponding Event in
Now Up-to-Date loses the Contact that was attached to it.

4. Close the Event Info window.

You’re returned to the Contact’s Detail View, where the Event remains in the Contact
Log.

You can “re-link” the Event at any point by clicking the Link/Unlink Event but-
ton in its Event Info window.
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Chapter 15

Using Now Up-to-Date & Contact
on a Network

If you’re using Now Up-to-Date & Contact on a network, you can share Events and Con-
tacts with other users through Public Categories stored on a Public Event Server or a Pub-
lic Contact Server.

This chapter assumes that a Macintosh running a Public Event or Contact Server contain-
ing Public Categories already exists on your network. If one doesn’t exist on your net-
work, consult your network administrator before proceeding. If you plan on using your
Macintosh as a Public Server, refer to the Administrator’s Guide for details.

Communicating with a Public Server
To view shared Events and Contacts, you must connect to the Public Event or Contact
Server. Connecting to a Server is a simple process, and requires only that AppleTalk be
active on your Macintosh. To verify that AppleTalk is active, choose Chooser from the
Apple menu. AppleTalk’s Active button in the Chooser window should be selected.

You can also connect to a Public Server via TCP/IP, either remotely or via a local area
network. After making sure that your TCP/IP connection is active, simply follow the pro-
cedures for either Now Up-to-Date or Now Contact below.

Connecting Now Up-to-Date to a Public Event Server
Shared Events are stored and maintained in Public Categories on a Public Event Server.

To connect to a Public Event Server:
1. Choose Server Connections from the Define menu.
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The Server Connections dialog box appears, showing the names of any Public Event
Servers that you’ve connected to previously. If this is the first time you’re opening the
dialog box, this area is blank.

2. Click Add.

Click to select 
a server

Active servers in 
the selected zone 
appear in this list

Click to select 
a zone

If no Public Event Servers appear in this dialog box, you should verify that
AppleTalk is active on your Macintosh and that at least one Public Event
Server exists on your network.

If you want to connect to a Public Event Server using TCP/IP, click TCP/IP...
and enter the server’s name, its IP address, and its port number (this informa-
tion should be supplied to you by the administrator of the Public Event Server),
then click OK. The server should now appear in the Server Connections dialog
box; skip ahead to step 5.

3. Add a Public Event Server by selecting it in the Servers list and clicking OK.

You’re returned to the Server Connections dialog box.

4. Repeat steps 2 and 3 to connect to other Public Event Servers on your network.
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5. Select the Server name, and change settings as desired.

Click… To…
Set Freq Choose the time interval at which your Calendar checks the

Public Event Server.

Increase the frequency to a longer time interval if
you want to reduce network traffic.

Update Now Update your Calendar File immediately.

Set Time Zone Choose the time zone offset type (ahead or behind) and the
number of hours to offset.

Use this feature when you are in a different time zone
than the Server.

6. Click OK.

You’re returned to the calendar display. In the Month, Week or List View, the status
message in the header briefly reads “public events up to date” when you have success-
fully connected to the Public Event Server. (You may also notice that a Meeting menu
has been added to the menu bar. The Meeting menu is described in Chapter 12,
“Group Scheduling.”)

Changing Public Event Server status
You may want to disconnect temporarily from the Server to reduce network traffic or to
turn off AppleTalk on your PowerBook to conserve battery power. When you do this, your
Calendar File will indicate that you are “offline.” To resume communication with the
Server, go back online. You may also permanently disconnect from a Server.

At times you may lose your connection to a Server if someone renames or moves it. If this
happens, the status message reads “looking for [Public Event Server name]” constantly
rather than “public events up to date.” When you see this message, you may need to re-
establish your connection.

To change Public Event Server status:
1. Choose Server Connections from the Define menu.

The Server Connections dialog box appears, listing any Public Event Servers you’ve
connected to previously.

2. Select a Public Event Server and make the desired change to its status.

Click… To…
Offline Temporarily disconnect (go offline).

Online Go back online.

Remove Permanently disconnect.

Removing the Server connection also removes Public Catego-
ries and the Public Events they contain from your Calendar File.

continued next page
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Click… To…
continued from previous page

Locate Re-establish connection. Select the desired Server in the dialog box.

3. Click OK.

You’re returned to the calendar display.

If you removed the connection to the Server, the Meeting menu option is also re-
moved from the menu bar. You do not have access to group scheduling functions un-
less you are logged in to a server.

Editing and creating Public Events while offline
When you disconnect from your network and open your Calendar File, you still have ac-
cess to the Events in all Public Categories that were part of any existing Sets the last time
you were connected to the Public Event Server. You can edit these Events and create new
ones.

The first time that you edit or create a Public Event while offline, a dialog box will appear,
indicating that the Public Event Server is not responding, and asking if you want to make
changes offline and send the edits to the Server the next time you connect.

When you click OK, the new or modified Event is saved in your Calendar File. If Marks is
turned on in the Event Display submenu of the View menu, a plus sign (+) appears next to
the Event, marking it as an edit that will be sent to the Public Event Server the next time
you’re connected. Subsequent edits or new Events are automatically marked without inter-
rupting you with a confirmation dialog box.

Reconnecting to a Public Event Server
The updating of the Public Event Server when you reconnect to the network is a mostly
automatic process. If you set the Public Event Server status to “offline” in the Server Con-
nections dialog box while you were disconnected, change the status back to “online.” Oth-
erwise, simply opening your Calendar File after restoring your network connection starts
the updating process automatically.
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If Now Up-to-Date discovers that an Event you modified while offline was also edited by
someone else in your absence, a dialog box appears indicating that your edited version of
the Event was not stored to the Public Event Server, and asking if you want to save the
edited Event to a Private Category called “Unreconciled Events.”

You can either click Discard to delete your edited version of the Event, or click Save to
place the Event in your Unreconciled Events Category (if this is the first time an
Unreconciled Event has occurred in your Calendar File, the special Category is created
automatically). You can then compare it to the version that was edited while you were
offline, if you want.

To compare an unreconciled Event to the original Event:
1. Select the unreconciled Event.

An unreconciled Event is denoted by a question mark (?) in front of its title.

You must turn on Marks in the Event Display submenu on the View menu in
order to see the question mark.

2. Choose Find Original from the Event menu.

Now Up-to-Date switches the current View and highlights the original version of the
Event. Once you’ve located the original Event, you can decide whether to keep it or
replace it with your changes.

If the Event was moved to a different Category that is not in your current Set,
Now Up-to-Date may not be able to find it; we suggest that you switch to a Set
in which you subscribe to all Categories to have the best chance of finding the
original Event.

3. Choose Find Original again to move back to the Unreconciled Event, if you want.

Choose Find Original to move the View back and forth between the two Events.

If you made changes while offline to a password-protected Public Category to which you
don’t have access, you will be asked to enter the password when the edits are sent to the
Server. If you don’t know the password, you can store the edited Events to the
“Unreconciled Events” Private Category.

To find an unreconciled Event, choose Find from the Event menu, type “?” (the Mark that
is attached to unreconciled Events) in the text field, and click Find.

While offline, you can’t modify existing Public Categories or create new ones.
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Connecting Now Contact to a Public Contact Server
Shared Contacts are stored and maintained in Public Categories on a Public Contact
Server.

To connect to a Public Contact Server:
1. Choose Server Connections from the Define menu.

The Define Server Connections dialog box appears.

The scrolling list under Connected Servers shows Public Contact Servers to which
you have connected. If you are not connected to any (or if this is the first time you are
connecting to a Server), this area is blank.

2. Click Add Server.

If no Public Contact Servers appear in this dialog box, verify that AppleTalk is
active, and/or that a Public Contact Server exists on your network.

If you want to connect to a Public Contact Server using TCP/IP, click TCP/IP
and enter the server’s name, its IP address, and its port number (this informa-
tion should be supplied to you by the administrator of the Public Contact
Server), then click OK. The server should now appear in the list at right; go on
to step 3.
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3. Add a Public Contact Server by selecting it in the Servers list and clicking OK.

You are returned to the Define Server Connections dialog box. The Public Contact
Server you selected now appears in the Connected Servers list and its Public Catego-
ries are displayed in the scrolling list in the upper right.

4. Select the Categories you want to subscribe to.

In the scrolling list on the right, double-click a Category. This places a checkmark in
front of the Category name and includes the Category’s Contacts in your Contact File.

Repeat step 5 to add other Categories from this Server. Repeat steps 3, 4, and 5
to add Categories from other Public Contact Servers on your network.

5. With the name of the connected Server selected, choose its update frequency from the
Update Every pop-up menu.

The update frequency indicates how often your Now Contact application checks the
Public Contact Server for new Public Contacts or modifications to existing Public
Contacts.

Click Update Now to update Public Contacts on this Server immediately.

6. Select the Alert when deleting checkbox if you want to receive an alert when a Public
Contact is deleted.

7. Click Done.

You’re returned to your current Contact File.

Choose Find All from the Find menu to display the Contacts in the Public Categories
you subscribed to.

Installing a single copy of Now Contact on both a desktop Macintosh and a PowerBook is
an acceptable way to take your Contacts with you when you travel. Generally, it’s best to
quit Now Contact on your desktop Macintosh when you leave the network site and plan to
connect remotely with your PowerBook.
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Changing Public Contact Server status
You may want to temporarily suspend communication with a Public Contact Server (go
offline) to reduce network traffic or to turn off AppleTalk on your PowerBook to conserve
battery power. You may also permanently disconnect from a Server.

You may lose your connection to a Server if someone renames or moves it. If this happens,
the Server status message reads “Looking for [Server name],” rather than “Shared Con-
tacts up to date.” When you see this message, you may need to re-establish your connec-
tion.

To change the status of a Public Contact Server:
1. Choose Server Connections from the Define menu.

The Define Server Connections dialog box appears, listing any Public Contact Servers
you are connected to.

2. Select a Public Contact Server in the Connected Servers list and make the changes
you want to its status:

Click… To…
Offline Temporarily disconnect (go offline).

Online Go back online.

Remove Permanently disconnect.

Removing the Server connection also removes Public Catego-
ries and the Public Contacts they contain from your Calendar
File.

Locate Re-establish connection. Select the desired Server in the dialog box.

3. Click Done.

The Server status changes to reflect your selection.

Disconnecting from a Public Contact Server is not the same as going offline. When you
disconnect from a Server, the Contacts in the Public Categories you subscribe to are no
longer available in your Contact File.

Editing Public Contacts while offline
Contacts in Public Categories remain in your Contact File when you temporarily suspend
communication with a Public Contact Server (go offline).

Before you go offline, update your Server connections to be sure that you have the most
current version of all Public Contact information in your personal Contact File.

Public Contacts that you create or modify while offline are automatically sent to the Public
Contact Server when you launch Now Contact and resume communication with the Server.



183

Sharing Data

Using Now Up-to-Date & Contact on a Network

Sharing Data

When you edit or create a Public Contact while offline, the message “Edits pending for
[Server name]” appears in the status bar at the bottom of the Now Contact window (List
View and Detail View). This message remains until you resume communication with the
Server and the Public Contacts are updated.

You can’t modify attributes of existing Public Categories or create new ones while you’re
offline.

Reconnecting to the Public Contact Server
Public Contacts you create or edit while offline are automatically updated when you re-
sume communication with the Server.

If Now Contact discovers that a Contact you modified while offline was also modified by
a network user who was online, your edited version of the Contact is not posted to the
Public Contact Server. Your changes are instead saved to a Note called “RECONCILE
FIELDS” attached to the Contact. This allows you to compare your changes to the version
that was edited while you were offline.

Unreconciled Contact Notes are also attached to Public Contacts the next time the Server
is updated. If you subscribe to a Contact that was modified both online and offline, you’ll
see the dialog box below when your Server is next updated.

Click OK to display only the unreconciled Contact(s) in the List View; you can then open
the Detail View and compare the offline changes in the Note to the current, updated Con-
tact.

If you made changes while offline to a password-protected Public Category to which you
do not normally have access, you will be prompted to enter the password when the edits
are sent to the Server.
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Sharing Events Using Public Categories
Events that are assigned to Public Categories can be viewed and modified by all users (ex-
cept for Events assigned to password-protected Public Categories). In addition, all users
can create and modify Public Categories.

Viewing Events from Public Categories
To see Public Events in Now Up-to-Date, you first need to select the Public Categories
whose Events you want to view. You do this by including Public Categories in one or
more Sets.

To view Events from Public Categories:
1. Choose Sets from the Define menu.

The Define Sets dialog box appears displaying the name of each Public Event Server
you are connected to, along with any Public Categories it contains.

2. Using the Set pop-up menu, choose the Set you want to add Public Categories to.

 Click New to create a new Set to contain Public Categories.

3. Click to the left of a Category’s name (or double-click the name) to subscribe to it in
this Set.

A checkmark appears to the left of the Category’s name and a Reminder icon appears
after it indicating that you’ll receive Reminders for Events in the Category. Deselect
the Receive Reminders checkbox if you don’t want to get these Reminders.

4. Repeat step 3 for any other Categories you want to subscribe to in the Set.

We recommend that you subscribe to your default Category (specified in the
Preferences window for each new Event type) in any Sets you create. See “Sets
and your default Category” in Chapter 5, “Organizing Calendar Events” for
more information.
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5. When you’ve finished adding Categories to the Set, click OK.

You’re returned to the calendar display. Now Up-to-Date begins retrieving Public
Events from the Public Categories you subscribed to.

Assigning Events to Public Categories
Events that you assign to Public Categories become available to other users who are run-
ning Now Up-to-Date.

You assign an Event to a Public Category the same way you assign an Event to any Cat-
egory—using either the Category pop-up menu in the Event Info window, or the pop-up
menu that appears in the Category column of the List View.

The Categories listed in the menu are grouped according to the Server where they reside,
divided by separator lines. Choose a Public Category from the menu to assign an Event to
it. Other users on the network who subscribe to the Public Category will have access to the
Event.

Creating and Modifying Public Categories
It’s best to create Public Categories for clear and specific scheduling topics, so that other
users on the network can more easily identify them when choosing Categories for viewing.

You can modify a Public Category whenever you’re connected to a Public Event Server,
as long as you have the password. See “Password-protected Categories” later in this chap-
ter for details.

To create a new Public Category:
1. Choose Categories from the Define menu.

The Define Categories dialog box appears.
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Notice that =Private= appears next to Server—this indicates that any Categories you
create will be Private Categories and stored locally in your Calendar File, unless you
change the selection in this menu.

2. Choose a Public Event Server from the Server menu.

The Public Event Server’s name appears next to Server, and the Categories stored on
the Public Event Server appear in the Categories on Server list.

3. Click New.

The New Public Category dialog box appears.

4. Type a name for the new Category in the Name field.

5. Type a description of the Category’s purpose in the Purpose field, if desired.

Including a description is very helpful to network users trying to decide which Cat-
egories to subscribe to.

6. Type in passwords as desired to add password protection.

See “Password-protected Public Events and Contacts” later in this chapter for details.

7. Click OK.

You’re returned to the Define Categories dialog box; the new Category appears in the
Categories on Server list.

8. Click OK.

You’re returned to the calendar display. The new Public Category is automatically
added to your current Set, and you can now assign Events to it.
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To modify a Public Category:
1. Choose Categories from the Define menu.

The Define Categories dialog box appears.

2. Choose a Public Event Server from the Server pop-up menu.

The Public Event Server’s name appears next to Server, and the Categories contained
on the Public Event Server appear in the Categories on Server list.

3. Select the Category that you want to modify.

4. Click the button for the modification you want to make.

Click… To…
Delete… Delete the Category and all Events stored in it.

Move… Move the Category to either another Public Event Server or your own
Macintosh.

Edit… Change the information shown for the Category.

See “Password-protected Categories” later in this chapter for details on delet-
ing password-protected Categories.

You’re returned to the Define Categories dialog box.

5. Click OK.

You’re returned to the calendar display.

Public Categories and Sets
As you start to use Public Categories, and as additional Public Categories are created on
your network’s Public Event Server, you may find that there is more information displayed
in your Calendar File than you want to view at one time. The Sets feature allows you to
view only Events from selected Categories, and to “filter out” Events from other Catego-
ries.

The Include all Events that block my time option in the Define Sets dialog box ensures that
your Calendar displays Meetings and other Events which you have marked as Attending.
See Chapter 16, “Group Scheduling,” for more information.

Once you’ve created Sets, switch between them by choosing Set names from the bottom of
the View menu.

You can also set a different color and/or text style for the Events in each Category, so that
when you look at your calendar display, it’s easier to tell which Events come from which
Category. See “Using Sets” in Chapter 6, “Organizing Calendar Events,” for details.
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Sharing Contacts Using Public Categories
Contacts that are assigned to Public Categories can be viewed and modified by all users
(except for Contacts assigned to password-protected Public Categories). In addition, all
users can create and modify Public Categories.

Assigning Contacts to Public Categories
Once you connect to a Public Contact Server, you can assign Contacts to Public Catego-
ries. Contacts in Public Categories are available to other network users who have Now
Contact.

Keywords you assign to your Contacts are not available to network users when you assign
the Contacts to Public Categories.

To assign a Contact to a Public Category:
1. Open the Detail View for a Contact.

The Category to which the Contact is assigned is in the Category pop-up menu.

2. Open the Category pop-up menu.

The pop-up menu lists the available Categories, which are grouped according to the
Server where they reside and divided by separator lines.

3. Choose a Public Category from the Category pop-up menu.

If the Contact has Notes or Calendar Events attached to it, a dialog box appears giving
the option of making all attachments public, private, or leaving them unchanged.
Click the appropriate button to proceed. (Any Custom Fields you’ve defined for the
Contact are public.)

The name of the Category you chose appears next to Category.

4. Save the Category setting by pressing the Enter key or closing the Detail View.

The Contact is now stored on the Public Contact Server as well as in your Contact
File, and is available to any networked users who subscribe to that Public Category.

To assign multiple private Contacts to a Public Category, select them in the List View and
then choose Assign Category from the Contact menu.

Color and text style settings for individual Categories are personal only; they don’t affect
how your Public Contacts appear in other users’ Contact Files.



189

Sharing Data

Using Now Up-to-Date & Contact on a Network

Sharing Data

Moving Public Contacts
You can assign a Public Contact to a local Category, but doing so moves the Contact from
the Server to your private Contact File and makes it inaccessible to other users. A dialog
box appears when you reassign a Public Contact to a private Category, giving you the op-
tion of moving the Contact or copying it to your private Contact File.

Creating and Modifying Public Categories
It’s best to create Public Categories for clear and specific topics, so that other users on the
network can more easily identify them when choosing Categories for viewing.

There may be times when you want to modify a Public Category by changing its name or
the passwords you’ve set for it, moving it to another Server, or deleting it. You can modify
a Public Category whenever you’re connected to a Public Contact Server, as long as you
have the password. See “Password-protected Categories” later in this chapter for more de-
tails.

To create a new Public Category:
1. Choose Categories from the Define menu.

The Define Categories dialog box appears. Local is chosen in the Location pop-up
menu—this indicates that any Categories you create will be Private Categories stored
locally in your Contact File, unless you change the selection in this menu.

2. Choose a Public Contact Server from the Location pop-up menu.

The Public Contact Server’s name now appears next to Location:, and the Categories
contained on the Public Contact Server appear in the Categories list.
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3. Click New.

The Category Info dialog box appears.

You’ll be prompted for a password to create a Category on the selected Server
if the person in charge of the Public Contact Server has assigned a password
for this function.

4. Type a name for the new Category in the Name field, and, if desired, a description of
the Category’s purpose in the Description field.

5. Type passwords as desired to add password protection.

See “Password-protected Categories” later in this chapter for details.

6. Click OK.

You’re returned to the Define Categories dialog box; notice that the new Category
appears in the Categories list along with any previously created Categories.

7. Click OK.

You’re returned to your current Contact File.

To modify a Public Category:
1. Choose Categories from the Define menu.

The Define Categories dialog box appears.

2. Choose a Public Contact Server from the Location pop-up menu.

3. Select the Category that you want to modify in the Categories list.

4. Click the button for the modification you want to make.

Click… To…
Edit… Change the Category’s name, description, or passwords.

Duplicate… Enter a new name, description or passwords for the copied category

Delete… Delete the selected Category and its attached Contacts.

You’re returned to the Define Categories dialog box.

5. Click OK.

You’re returned to your current Contact File.
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Password-protected Categories
A Public Category can be password-protected in order to prevent network users from
changing or deleting Events or Contacts, or from deleting the Category and its contents.
You cannot modify an Event or Contact that belongs to a password-protected Public Cat-
egory, unless you have the password.

When creating a password-protected Category in Now Up-to-Date and Now Contact, the
following password options appear in the New Category and Category Info dialog boxes:

This password… Must be entered to…
Read See any Contacts or Events in the Category. Read-protected Public

Categories are indicated by .

Write or Edit Change or delete existing Events or Contacts in the Category. Write-
and edit-protected Public Categories are indicated by .

Owner Create new Contacts or Events; archive, move or delete the Category;
change its name or passwords.
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Group Scheduling
With Now Up-to-Date’s Group Scheduling feature, you can schedule Meetings with col-
leagues and associates who have also installed Now Up-to-Date and connected to a Public
Event Server. A system administrator sets up users and resources on the Server for Meet-
ings, and then network users configure their Calendar Files for Group Scheduling.

The Group Scheduling features can automatically find the time when you, your co-work-
ers, and your desired Meeting room are all available for a Meeting. All invitees are noti-
fied, whether they’ve subscribed to that particular Public Category or not; they can then
accept or decline the invitiation. Detailed Meeting information is available in each
person’s Calendar File.

Getting started with Group Scheduling
To begin scheduling Meetings, you first need to set up your Calendar File for Group
Scheduling. This is a one-time procedure (unless you need to change your settings later).

Necessities for Group Scheduling
In order for you to use the Group Scheduling features, the following conditions must exist:

• Your network administrator must install the Public Event Server software on a
Macintosh and then post the names of users, Meeting places, and Meeting resources to
the Server so that these items are available for scheduling Meetings.

• You, along with all those you want to invite to a Meeting, must be connected to a Public
Event Server.

• You must make yourself available for Group Scheduling by logging in with your user
name.

• You must include at least one Public Category in your current Set.
• You must select users, Meeting rooms and resources listed on the Public Event Server

and add them to your Calendar File for your use in scheduling Meetings.
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Basic setup
If you want Now Up-to-Date to guide you through the Group Scheduling setup, just click
the New Meeting button in the Toolbar, and follow the directions provided at each step.

If you’d rather go through the setup process at your own pace, use the following steps.

To set up your Calendar File for Group Scheduling:
1. Connect to the Public Event Server that’s been set up for Group Scheduling, if you

haven’t done so already.

Choose Server Connections from the Define menu and add the Server.

2. Choose Log In from the Meeting menu.

The Log In dialog box appears.

3. Highlight your name in the list and click OK.

Select your name from the list identifies you on the network as a participant in Group
Scheduling. Once you click “OK,” your name will appear at the bottom of the Meet-
ing menu, confirming your identification in Group Scheduling. If your name isn’t in
the list, contact your network administrator.

If prompted, enter the password your network administrator has given you. You
can change the password by choosing Set Password from the Meeting menu.

4. Choose Sets from the Define menu.

The Define Sets dialog box opens.

5. Subscribe to at least one Public Category in the current Set.

Double-click the Category’s name to subscribe to it; a checkmark appears to the left
of the name.
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The Include all Events that block my free time option ensures Meetings and
other Events you have marked as “Attending” will appear in your Calendar—
even Events assigned to Categories that you aren’t subscribed to in any Set, or
on Public Event Servers that you haven’t connected to yet. This allows you to
subscribe to fewer Categories, while still keeping abreast of Meetings that af-
fect you. This option is turned on by default when you create a Set that contains
at least one Public Category.

6. Click OK.

7. Choose Users & Resources from the Meeting menu.

The Users & Resources dialog box opens.

Click to add a 
user or resource 
to your 
Calendar File

A description of 
the selected 
resource 
appears here

8. Add any users, conference rooms and resources that you might want to include in a
future Meeting.

The items you add here become available in your Calendar File for Group Scheduling,
even when you’re disconnected from the network.

Choose only the resources that you’ll regularly need for scheduling
Meetings.

9. Click OK.

Group Scheduling setup is complete; you’re now ready to begin scheduling Meetings.
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Advanced Setup
Use the following Advanced Setup procedures to define password protection, set time
block availability, and set up convenient Groups of people, Meetings rooms and resources.

Defining Password protection
Password-protect access to your user name to prevent others on the network from logging
in as you. If you don’t have a password assigned yet and you want to create one, choose
Set Password from the Meeting menu.

To remove the password protection, choose Set Password and then delete your password
from the dialog box. You’ll be prompted to enter your old password once more to confirm
the change, and then password protection will be turned off.

Setting your Availability
Your Appointments appear as “busy time” during which others shouldn’t schedule con-
flicting Meetings that include you. Banners, Holidays, and Special Events will block out
entire days of “busy time” for you, when the Blocks My Time option is selected in the
Event Info window for those Events.

Use the Availability settings to provide additional Meeting Availability information, such
as your normal lunchtime, and time that you want to reserve during the day for non-Meet-
ing activities.

To modify your Meeting availability, choose Availability from the Meeting menu. Modify
your Availability with the options on the Availability dialog box.

Click to select or deselect 
days of the week

Choose the number of 
personal time blocks

Choose the duration of 
personal time blocks

Click to make 
lunch time 
unavailable

Set lunch time

Set hours of availability 
for the selected day

The Reserve personal time option specifies blocks of time in your day when you’re un-
available for Meetings even if you have no actual Appointments scheduled.

If you prefer to have blocks of reserved time scheduled at specific times instead of letting
Now Up-to-Date place them wherever available, create repeating time-specific Appoint-
ments for the period(s) of time you want to set aside.
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Setting up Groups
Use the Groups function to identify a group of people—or any combination of people,
Meeting rooms and resources—that you can invite to a Meeting with one selection. When
setting up a Meeting, selecting the Group’s icon invites all the people and places you’ve
specified.

To create or modify Groups, choose Groups from the Meeting menu. The Groups dialog
box opens.

If you’re choosing the Groups command for the first time, Now Up-to-Date asks you to
name the first new Group. Once you’ve done so, the dialog box opens directly.

Choose a 
Group

Click to select or 
deselect an item:
items with 
checkmarks are 
included in the 
Group

Information for 
the selected item 
is displayed here

Click to duplicate 
the current Group

Click to delete the 
current Group

Click to create a 
new Group

Click to rename 
the current Group

Scheduling a Meeting
There are two different ways to schedule Meetings. Use Auto-Pick to let Now Up-to-Date
find the best time to meet on a particular day. Or, use Group View to specify the exact
time you want to hold the Meeting.

Meetings you create while offline don’t block out time on any users’ schedules until you
connect to the Server again.

To schedule a Meeting using Auto-Pick:
1. Choose New Meeting from the Event menu.

The Schedule Meeting dialog box opens.

2. Select the users, Groups, Conference Rooms, and/or Resources to include in the Meeting.
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Drag the desired items from the list on the left to the “Req:” list on the right. To dese-
lect an item, drag it back to the first list. To inform a user that the Meeting will take
place but not invite that user, drag the user’s name to the “Opt:” list. Drag Rooms
and/or Resources directly to the “Req:” area to reserve them.

When you drag a Group to the “Req:” list, all of the items it contains appear
separately. Also, when you drag a Group to the Opt list, any Conference
Rooms or Resources it contains are automatically omitted from the list.

3. Click Auto-Pick.

Now Up-to-Date checks the schedules of invited users and Resources and displays
the Auto-Pick dialog box with available Meeting times.

The available Meeting times are shown with durations corresponding to the default
duration specified in your New Meeting Preferences.

4. Select the time when you want the Meeting to take place and click OK.

You’re returned to the Schedule Meeting dialog box.

5. Click OK.

The dialog box closes, and you see the Event Info window for your new Meeting.

6. Fill in any necessary information for the Meeting and press the Enter key to confirm
the new Event.

The Meeting now appears in your Calendar File, and everyone in the “Req:” and
“Opt:” lists receives notification of the new Meeting.
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To schedule a Meeting using Group View:
1. Choose New Meeting from the Event menu.

The Schedule Meeting dialog box opens.

2. Select the users, Groups, Conference Rooms, and/or Resources to include in the
Meeting.

3. Click Group View.

Any users you’ve placed in the “Opt:” list appear in italics at the bottom of the list.

The highlighted time is shown with a duration corresponding to the default duration
specified in your New Meeting Preferences.

4. Click in a column to select the time you want the Meeting to take place and click OK.

You’re returned to the Schedule Meeting dialog box.

5. Click OK.

The dialog box closes, and you see the Event Info window for your new Meeting.

6. Fill in any necessary information for the Meeting and press the Enter key to confirm
the new Event.

The Meeting now appears in your Calendar File, and everyone in the “Req:” and
“Opt:” lists receives notification of the new Meeting.
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Handling conflicts in Group Scheduling
Now Up-to-Date checks for conflicts in the schedules of users you’ve placed in the “In-
vite:” list only—not users whose attendance is optional. When conflicts occur, you’ll see
the dialog box below.

When you see this alert, you can choose to:

• Open the Group View dialog box so you can find a non-conflicting time yourself;
• Open the Auto-Pick dialog box to let Now Up-to-Date find a non-conflicting time auto-

matically;
• Book the Meeting at the time you originally specified, even though some attendees may

not be able to attend the Meeting because of schedule conflicts.

Viewing and responding to Meeting Notices
When another user on your network schedules a Meeting and lists you as an attendee,
you’ll be notified in Now Up-to-Date with two visual cues. The Meeting Notices button in
the Toolbar changes to look like the button shown here. Also, the right side of the header
area displays a text message telling you to “check Meeting notices.”

Click to open the 
Meeting Notices 
dialog box

Click to dismiss 
this dialog box

You can also set different notification options. See “Meeting Preferences” later in this
chapter for details.

You are notified of any new Meeting to which you’re invited, regardless of whether you
are subscribed to the Public Category in which the Meeting is stored.

To respond to a Meeting Notice:
1. Click the Meeting Notices button in the Toolbar to open the Meeting Notices dialog box.

You can also choose Open Meeting Notices from the Meeting menu.
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The Meeting Notices dialog box opens.

2. Check the information displayed for each Meeting in this dialog box.

The Status column displays Unconfirmed, if you haven’t indicated whether you’ll at-
tend or decline, or Rescheduled, if the Meeting’s been moved to another date, time or
location.

The Req/Opt column indicates whether your attendance at the Meeting is Required or
Optional (for your information only).

Meetings that are repeating Events appear only once in the Meeting Notices
dialog box. Accepting an invitation to a repeating Meeting marks you as At-
tending for all Meetings in the repeating series.

3. Act on any Meetings appearing in the dialog box as desired.

Click Meeting Info to see the information that you’d see if you opened the Event Info
window for the Meeting.

4. Click OK.

You’re returned to the calendar display.
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Proxies
A Proxy is someone who is selected by one user to act on his/her behalf in scheduling
Meetings and accepting/declining invitations to Meetings. A Proxy can:

• Create new Meetings on behalf of the proxied user and include attendees, Conference
Rooms and Resources.

• View the proxied user’s schedule commitments and Meeting notices.
• Accept and decline invitations to Meetings.

A Proxy cannot:

• Read, modify, create or delete the proxied user’s Private Events (they do appear when
the Proxy selects the “Include all Events that block my free time” option in the Define
Sets dialog, but only as time blocks with the generic title **Private Meeting**).

• Change the user’s Log-In password.
• Modify the user’s Meeting Availability settings.

Selecting a Proxy for yourself
To select a Proxy, choose Proxies from the Meeting menu. In the Choose Proxies dialog
box, select one or more names—a checkmark appears in front of any names you select—
and then click OK.

Once you’ve selected a Proxy, your name appears at the bottom of the Meeting menu in
the Proxy’s Calendar File. Your Proxy chooses your name from the Meeting menu to
schedule Meetings and accept or decline invitations to Meetings on your behalf.
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Acting as a Proxy for another user
When you act as another user’s Proxy, the user’s name appears at the bottom of the Meet-
ing menu below your name. Choose that name from the menu so that it’s checked instead
of yours. Your Calendar File automatically changes to display the proxied user’s schedule.

In the calendar display, some Meeting titles appear in brackets, and no detailed informa-
tion is available for them. To view or edit information for such a Meeting, open the Define
Sets dialog box and add the Category, or you will not be able to see complete Meeting in-
formation. Attend or Decline Meetings in the calendar display by opening the Event Info
window and choosing the desired option from the Meeting Confirmation menu.

To respond to new Meetings, choose Open Meeting Notices from the Meeting menu. You
can accept or decline in this dialog box.

To schedule a new Meeting, choose Schedule Meeting from the Meeting menu. New
Meetings you create while acting as a Proxy automatically include the proxied user as an
attendee and show that user’s name as the last person to modify the Event.

Choose Print from the File menu to print the proxied user’s schedule.

Acting as a Proxy for a Conference Room or Resource
It’s useful for someone in your workgroup to function as a Proxy for the Conference
Rooms and Resources that are available for Group Scheduling, so that you can view or
print a calendar display that shows only the Meetings involving a specific Room or Re-
source. Conference Rooms and Resources always automatically attend Meetings that
they’re included in. As a Proxy for a Conference Room or Resource you can create new
Meetings if you wish.

If you are set up as a Proxy for a Room or Resource, choose the item’s name from the bot-
tom of the Meeting menu. The name of the Room or Resource you’re proxying for appears
in the title bar of your Calendar File and your Calendar File displays the schedule for the
Room or Resource, and nothing else.
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Meeting Preferences
To set your preferences for Meetings, choose New Meetings from the Preferences sub-
menu in the Define menu. In this pane you can set defaults for new Meetings and Meeting
notification.

Use this option… To specify…
Category The default Public Category for Meetings you create.

Priority The default Priority level for Meetings you create.

Start time and Duration The default start time to schedule new Meetings, and
the default duration.

Remind How you want to receive a reminder through
QuickDay.

New Meeting notification The form of alert you want to receive when someone
invites you to a Meeting.

Meeting notification sound The sound that will accompany the alert you receive
when someone invites you to a Meeting.

Auto-Pick interval The interval of Meeting times suggested in Auto-
Pick.

Always attend New Meetings Whether or not you should be shown as attending
Meetings you create.

If you want your private and public Meetings
to appear as unavailable time to other users
on the network and/or to your Proxy, be sure
that you’re entered as attending them, and
that this last checkbox is selected.
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Reference

Index
A
Address Book printing 141

dimensions 141
letter headers in 137
margins 140
page breaks 137
preset sizes 140

addresses
changing automatically 87
international 88
secondary 108
swapping 87

Apple Events 167
dialing Contacts with 111, 117

AppleTalk 175, 180
Appointment Book printing 60–63
Appointments 80, 107

creating 17–18
default values for 36

archiving Events 71
area codes

omitting when dialing 112
specifying 112, 117

attaching documents 150
with drag and drop 78
to Contacts 78
to Events 32

attaching Events
to Contacts 80–81

Attachments submenu 31
Auto-Save

setting time interval 38
auto-saving

in Now Contact 91
Automatic Address Entry 75

preferences 89
automatic data entry 75–76

preferences 89
Automatic Phone Entry 75
Automatic Typing 76

preferences 89
AutoType 75–76

B
Banners

and meeting availability 196
creating 21
default values for 36
displayed in Month View 40

bar codes 142
Blank Page Template 147
button labels

hiding 91

C
Calendar Events

creating 80–81
when dialing 112, 117

date/time stamping 82, 90
and duplicate Contacts 95
in exported Contacts 131
linking to Now Up-to-Date 74
timing 82–97
types of 80–81

Calendar File
archiving Events from 71
converting earlier versions 15–38
creating 15–16
customizing Views in 48–50
graphics in 22–23
importing into 67–71
primary 4, 15–16
printing 57–65
reducing size of 71
saving 28, 38
viewing 4

Calendar Formats
defining 48–49

Calendar Views
going to a specific date 48
navigating in 47–48

Calls 80, 107
creating 19
default values for 36
marking as Done 19–20, 44
marking as In Progress 19–20
timing 24

Categories 51–53
archiving Events from 71
assigning Contacts to 106, 120–121
assigning Events to 53
color settings 33, 54–56
color settings for 188
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creating 52
while importing Events 68

creating in Now Contact 119–120
and Custom Fields 82–85
default for meetings 204
default for new Events 56, 184
defined 4
deleting in Now Contact 122–123
and exporting 69
filtering Contacts 96–97
finding Contacts with 96–97
importing 129
in Now Contact 119–123
modifying 53
modifying in Now Contact 122
network. See Public Categories
Private 51
Public 51. See Public Categories
receiving Reminders for 56
in Templates 145
text and color settings

in Now Contact 123
text style settings 33, 54–56
types of 51

Categories command 189
Category Header 106
color

of Categories, changing 33, 54–56
of Events, changing 32–33

color palette 38
combining Contact files 130
comma in dialing string 115
comma-delimited text files 131
Comments 77

attaching to a Contact 77
Comments field

resizing 107
compound merge fields

in Now Contact 144–146
Contact Details printing 141
Contact Files

auto-saving 91
creating 73–74
duplicate copies 131
merging two files 130
navigating in 106
position of current Contact in 106
primary 74
printing 150
synchronizing copies 131–133
updating copies 131–133

Contact Info dialog box 170

Contact information
copying 86, 109
entering automatically 75–76

Contact List printing 142
and List Layouts 142

Contact Log 107
defined 6
entries in 107
icons 107
Keywords in 124, 125
Notes in 77–78
sorting in 107

Contacts 4
assigning Keywords to 125
assigning to Categories 120–121
attaching documents to 78, 150
attaching Events to 80–81
attaching Notes to 77–97
attaching to Events 30
attaching Web links to 79–80
attaching with SmartWords 165
changing addresses for 87
classifying 119–123
copying 85

with drag-and-drop 106
creating in QuickPad 163
creating new 30
creating with QuickContact 157
Custom Fields for 82–85
default values 88–97

Keywords 88
deleting 85, 122
dialing 110–118
duplicate 129
duplicating 85
entering e-mail addresses for 84–85
entering information 74
entering URLs for 84–85
exporting 130–131
finding 92–97.See finding Contacts
finding duplicate 95–96
grouping 119–123
hiding in List View 97
identifying by Category 123
including in QuickContact 106
including in QuickContact menu 153
linking to Now Up-to-Date 167–174
marking 106, 126
modifying

in List View 103–104
network. See Public Contacts
organizing 119–126



207Index

Reference

posting to Public Categories 188
Primary Fields for 109–110
printing 135–137.See printing
Public. See Public Contacts
dialing in QuickPad 164
replacing information automatically 86–87
searching for.See finding Contacts
selecting 76–77
sharing on a network 175–191
sharing over a network.See Public Contacts
text color 123
text style 123
unmarking 126
viewing 6, 99–118

Copy Contact Info
Formats 89–90

in Templates 145–146
Listing field and 90, 91
preferences 89–90
Primary Fields in 109
submenu 109
using 86

copying
Contact information 86, 109
Contacts 85

with drag-and-drop 106
Events 34

creating
Contact Files 73–74
new Contacts 74–76

creating events 17–23
Custom Fields

defining 82–85
importing from other Categories 83
types of fields available 83

D
Data Entry Aids 75–76
Date/Time Picker 24
Date/Time Stamp 24
date/time stamp

elapsed time in 82
format 90, 91
format in Now Contact 91
in Calendar Events 82, 91
in Notes 82, 91

Day View 43
creating Events in 17–38
printing 59
shading hours in 38
Zoom feature in 43

Day-Timer 57
DayRunner 57
Default Event Type

selecting in QuickPad 166
default values for New Events 36
Define Server Connections dialog box 180
deleting Contacts 85
deleting Events 34
DeskTop Dialer 111
Detail Layouts

defining 108
Detail View

arrow buttons in 106
assigning Categories in 188
Category Header in 106
Category pop-up menu in 106
comments in 77, 107
components of 105–108
Contact Log in 107
defined 6
defining Layouts for 108–118
information blocks in 106
Keyword list in 107, 125
Listing Header in 106, 109–110
Mark checkbox in 106, 126
marking Contacts in 126
Name/Address blocks in 108
numbers in Category Header 106
QuickContact checkbox in 106, 153
swapping addresses in 87

dialing Contacts 110–118
with another application 111, 117
with Apple Events 111, 117
and area codes 112, 117
commas in dialing strings 112, 113, 115
configuring 111–113
creating Calendar Events when 117
default settings 112
with a DeskTop Dialer 111
and dial tones 112, 115–118
Dial Tone strings for 112, 115, 116
expert setup 113–114
local area code with 112
and long-distance prefixes 112
and long-distance suffixes 112
methods 110–111
with a modem 111, 118

dialing prefix 114
dialing suffix 114
initialization string 114
port setting 114
preferences 113–118
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omitting area codes 112, 117
preferences 111–118
and Primary Phone 116
in QuickPad 164
with speaker 110

Comma Duration option 113
length of dialing tones 113
Pause Between Tones option 113
preferences 113–114
Tone Duration option 113
volume 113

and telephone extensions 112–113
touch-tone dialing 110

dialing strings
comma duration 113
defining 115–116
predefined 115, 117

modifying 115
types of 115

discarding an event
in QuickPad 163

disconnecting
from Public Contact Server 182

documents
attaching to Contacts 78, 150
attaching to Events 32
creating 147–148
and duplicate Contacts 95
printing in Now Contact 150–151
text files 148

double-sided printing 60, 62–63
offsetting 63

drag and drop 75, 78, 84
in QuickPad 165

duplicate Contacts 129
finding 95–96
merging 95
preferences 95

duplicating Contacts 85

E
e-mail

addressing from List view 85
e-mail addresses

in Custom Fields 84–85
editing text in List View 103
Envelope printing

bar codes in 142
Template setup options 142

Event Info window 16
Date/Time Stamp 24

Find Contact button 171
Link/Unlink Event button 173, 174
in Now Contact 173
in Now Up-to-Date 173
opening

automatically 37
Events

archiving 71
assigning Priorities to 24–38
assigning to Categories 53
attaching Contacts to 30
attaching documents to 32
attaching to Contacts 80–81
attaching Web links to 30–32
copying 34
creating 17–23, 46

from QuickDay Event menu 157–158
creating with QuickPad 162–163
customizing 24–33
default Category for 56
deleting 34, 71
displaying 49
editing with QuickDay 158
exporting 69–70
finding 35–38
hiding and unhiding 35, 50
importing from text files 67–69.See also

importing Events
linking to Now Contact 74, 167–174
modifying in To-Do list 44
moving 33–34
organizing 51–56
posting to Public Categories 185
preferences 36
printing 57–65
repeating 25–33

custom 26–27
deleting 34
modifying 27
standard 25–26

setting Reminders for 28–29
sharing on a network 175–191
sort order in Month View 40
text style and color 32–33
using word wrap in 50
viewing hidden 35, 50

Export file
creating 69–70

Export Templates 130–131
exporting

Event types included 70
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Reference

exporting Contacts 130–131
by dragging 131
to a Contact File 131

exporting Events 69–70

F
fields

primary 108–110
FiloFax 57
Find Original command 179
finding

Events 35
text 35
unreconciled Events 179

finding Contacts 92–97
accents in search criteria 94
basic operation 92
by Category 96–97
default settings 94
detailed operation 92–93
duplicates 95–96
found list 93
by Full Name 93
by Keyword 96–97
and Notes 94
other options 94
preferences 94
with QuickFind 96–97
in QuickPad 163–164
with QuickContact 156

footers
printing 64

Franklin Planner 57

G
Graphics

attached to a day 22
attached to an Event 22
default values for 36
modifying 23
adding 23
pasting from the Clipboard 23
placing in Templates 144

graphics in calendars 22–23
Graphics Palette 22
Group Scheduling 193–204

adding users and resources 195
Auto-Pick feature 197–198

setting interval 204
availability for 196

defined 5
and Groups 197
Groups in.See Groups
guided setup 194
handling conflicts 200
logging in 193, 194
overview 193
password protection 196
preferences for 204
preset Groups for 197
Proxy 202–203, 204

acting as another's 203
for a Conference Room 203
for a Resource 203
scheduling meetings as 203
selecting for yourself 202

and Public Categories 193, 194–195
and Public Event Server 193
requirements for 193
reserved personal time 196
scheduling a Meeting 197–200
security 196
selecting resources 195
selecting users 195
setting up 194–197
user name in 194
using Group View 199

Groups for Meetings 197
Group View 199

H
headers

printing 64
hidden Events 35, 50

viewing 35
hiding Contacts 97
hiding/unhiding Events 35, 50
Holiday 81
Holidays

and meeting availability 196
creating 20
default values for 36

hot key
to open QuickPad 165
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I
icons

in Contact Log 107
import fields

special in Now Contact 128–129
Import Templates

for Now Contact 128
importing Contacts

from Contact Files 130
Define fields 128–129
and duplicate Contacts 129
from text files 127–129

importing Events
problems 69
and repeating Events 68
and Templates 67–68
from text files 67–69

information blocks
Address 74, 106, 108
Name 108
telephone number 106

installation 9–13
deinstall procedure 13
disabling extensions for 10
license agreement 10
system requirements 9
upgrading from previous versions 9

international addresses 88

K
Keywords 7

assigning to a Contact 125–126
defining in Now Contact 124
filtering 96–97
finding Contacts by 96–97
in Now Contact 124–125
list in Detail View 107, 125
and Public Categories 7, 188

in Now Contact 124
in Templates 145
unavailable in Public Categories 7, 188

Keywords button 125

L
Label printing 142

in Now Contact 137
license agreement 10
linked Contacts

default settings 168
deleting 172
finding in Now Up-to-Date 171
and Public Events 172

linked Events 74
creating 173–174
deleting 174
in exported Contacts 131
in Now Up-to-Date 173

linking
and primary files 167
preferences 167–168

List Layouts
and Contact List printing 142
defining 100–118
Marked field in 126
sort order in 46, 101

List View 45–47
addressing e-mail from 85
arranging columns 102
assigning Categories in 188
columns 99

moving 47
numerals in 46
order 102
resizing 47–50, 102–103
sorting 46

components of 99–100
creating Events in 46
customizing 45
defined 6
defining Layouts for 100
dragging columns 102
duplicate Contacts in 96
editing text in 103
hiding Contacts in 97
marking Contacts in 126
modifying Contacts in 103–104
modifying Events in 47
moving columns 102
No Edit symbol in 103
pop-up menus in 47, 104
printing 59, 142, 150
replacing Contact information in 86–87
resizing columns 102–103
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Reference

sort level indicators in 101
sort order in 101

reversing 101
sorting

with column headers 101
temporarily 101

Toolbar 100
Listing

format 91
importing in Now Contact 129

Listing Header
appearance 109
defined 106
setting 108, 109–110

«Listing» merge field 90

M
marking Contacts 106, 126

in Detail View 126
in List View 126

Marks
displaying 49
and offline editing 178

Meeting menu
adding to menu bar 177
removing from menu bar 178

Meeting Notices 200–201
button 200
header message 200
QuickDay 204
responding to 200–201
viewing 200–201

Meeting Notification
Preferences 204

Meetings.See also Group Scheduling
accepting 201
always attend those you create 204
availability for 196
conflicting 200
creating 194, 197–200, 204
declining 201
default Category for 204
default values for 36
duration 198
inviting attendees 197–198
multiple 201
notification 195
Preferences 204
Proxies for 204.See Proxies
and Public Categories 204
scheduling 18–19, 197–200

scheduling as a Proxy 203
scheduling automatically 197–198
scheduling in Group View 199
status 201

menu bar
viewing Contacts from 153

menu bar alerts 28
merge documents

creating 148–149
previewing Contacts in 149
printing 150–151
selecting Contacts for 148

merge fields 109
and Copy Contact Info 90
«FullName» 90
«Listing» 90
Primary Fields in 90, 109, 145
in Templates 144–146
text style 146
in Word Processor documents 149

merging
Contact files 130
duplicate Contacts 95

minimizing windows
in QuickPad 165

modem
dialing 118

modem dialing 111
initialization string 114
port setting 114
preferences 113–118
prefix 114
suffix 114

Month View 40–41
order of Events in 40
printing 59
scrolling in 41, 50
See-Thru Month 41
start of week in 37

moving
List View columns 102

moving Events 33–34
Multi-Day View 42

creating Events in 17–18
scrolling in 42, 50
shading hours in 38
start of week in 37
Zoom feature in 43

multiple open windows
in QuickPad 165

multiple work addresses 75
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N
network. See Public Contact Server
network status in Views 39
network use 175–191
new Contacts

creating 74–76
Notes 107

attaching to Contacts 77–78
with drag and drop 77

copying between Contacts 78
Date/Time stamping 82–97, 90
and duplicate Contacts 95
and synchronization 133
in Templates 145
timing 82

Now Contact
color palette 91
configuring 88–91
default values for 37
files from previous versions 73, 144
importing Contacts into.See importing

Contacts
network use.See Public Contact Server
and Now Up-to-Date

deleting linked Events 174
switching between applications 173, 174

preferences 88–91
version 1.x

Sets 96
Now Contact Server application.See Public

Contact Server
Now Up-To-Date

color palette in 38
Now Up-to-Date

finding Contacts in 171
Group Scheduling 193–204
linked Contacts in 169–172.See linked

Contacts
linked Events in 80
and Now Contact

repeating Events 172
preferences 36–38
upgrading from previous version 15–16
window elements 39

numerals in column headers 101

O
offline editing

automatic reconciliation and 178–179
in Now Contact 182
in Now Up-to-Date 177
and passwords 179
and unreconciled Events 179–191

Online Help 1
“Owner” password 191

P
Passwords

removing 196
setting for Group Scheduling 196

passwords 191
and protection symbols 186
and Public Categories 186
and archiving 71
and offline editing 179
and Public Categories 191

pop-up menus in List View 104
PowerBook

and Public Contact Server 181
Preferences

new Meetings 204
preferences

Data Entry Aids 75, 89
default Category in 56
Dialing 111–113
Duplicate Handling 95
Finding Contacts 94
General 90–91, 109
General for Now Up-to-Date 37–38
linking 167–168
New Contacts 88
New Events 36
Now Contact 37
in Now Up-To-Date 36–38
Personal Data 145
QuickContact 154–155
QuickDay Event menu 159–160
Reminders 160–161

Previous/Next arrows
in Now Up-To-Date 47

Primary Address 108
Primary Field Selector 109–110
Primary Fields 108–110

and addresses 108
and Copy Contact Info 90, 109
functions 108–109
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Reference

and Listing 90, 109, 91
and Listing Header 106, 108, 109–118
selecting 109–110
and telephone numbers 109
in Templates 145
in Word Processor documents 109

primary file 4, 74
and linking 167
and QuickPad 162
defining in Now Up-to-Date 15–16

Primary Name 90, 91, 108, 109
importing 129

Primary Phone 108, 109, 116
printing 57–65

Address Books.See Address Book printing
aligning correctly 63
Appointment book sizes 60–63
attaching documents to Contacts during 150
bar codes 142
Contact Details.See Contact Detail printing
Contact information 135–137
documents 142
double-sided 60, 62–63
Envelopes.See Envelope printing
folding pages 61
general instructions 57–58
headers and footers 64
Labels. See Label printing
List View 142
Manual Feed option 63
non-enhanced 38, 65
offsetting 63
options 137
options in Now Contact 150
problems with 38, 65
single-sided 61–62
using the Print dialog box 65
Views 59–65
Word Processor documents 150–151

Priorities
defining 25
using 24–25

Priority
modifying by dragging 44

Proxy 202–203, 204
acting as another's 203
for a Conference Room 203
for a Resource 203
scheduling meetings as 203
selecting for yourself 202

Public Categories 175
archiving Events from 71

assigning Contacts to 188
assigning Events to 185
assigning passwords to

in Now Up-To-Date 186
and Category color settings 188
creating 185–187, 189–190.See also Define

Categories dialog box
defined 5, 7
deleting 187, 190
filtering with Sets 187
and Group Scheduling 193, 194–195
and Keywords 7, 188

in Now Contact 124
and Meetings 204
modifying 190. See also Define Categories

dialog box
in Now Up-To-Date 185–187

moving 187
password-protected 185, 191
passwords 190

“Owner” 191
“Read” 191
“Write” 191

posting Events to 185
and Sets 187
subscribing to

in Now Contact 181
in Now Up-To-Date 184–185

and synchronizing Contact Files 132
unavailability of Keywords in 7, 188
and unreconciled Events 179
unreconciled Contacts 183
updating

in Now Contact 181
viewing Events from 184–185

Public Contact Server 7
adding 181
and AppleTalk 180
availability of 175, 180
Categories on 181
changing status of 182
communicating with 175–183
connecting to 180–183.See also Define

Server Connections dialog box
disconnecting from

permanently 182
going offline 182
lost connection 182
not on network 180
status messages.See status messages
subscribing to Categories on 181
suspending communication with 182–183
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unreconciled Contacts 183
update frequency 181

Public Contacts
assigning to local Categories 189
Calendar Events in 188
copying 189
deleting alert 181
moving 189
Notes in 188
offline editing of 182–183
password-protected 191
posting to Public Categories 188
and Private Categories 189
updating 181

Public Event Server
availability of 175
communicating with 175–183
connecting to 175–179

remotely 175
disconnecting from 177–178

permanently 177
going offline 177
and Group Scheduling 193, 195
reconnecting to 177–178
and time zones 177
and unreconciled Events 179–191
update frequency 177

Public Events
alert on deletion 38
creating while offline 178
editing while offline 178
editing with QuickDay 158
filtering 187
and linked Contacts 172
password-protected 191
unreconciled 179
viewing 184–185

Q
QuickAccess features 153–166
QuickContact 153–157

configuring 154–155
creating Contacts 157
defined 7
dialing Contacts 156
dialing Contacts from 155
finding Contacts with 156
hot key 154
launching Now Contact from 156
menu 153

including Contacts in 74, 106

menu icon 154
modify Contacts 157
preferences 154–155
adding Contacts to menu 153
and primary file 153
settings for 155
view Contact info 155–156

QuickDay 157–161
and Meeting notification prefs 204
checking your schedule 157
creating Events in 157–158
defined 7
editing Events 158
Event menu preferences 159–160
modifying Events from 28–29
Reminder preferences 160–161
setting preferences in 159–161

QuickDay Event Info dialog box
editing Events in 29
limitations of 157–158

QuickDay Event menu
commands in 160
display preferences 157
font and text size 160
Hot Keys 160
preferences 159–160

QuickFind 94
using 96–97

QuickPad 162–166
creating Contacts 163
creating Events 162–163
Default Event Type pop-up menu 166
defined 7
dialing Contacts 164
finding Contacts 163–164
hot key 162
minimizing windows 165
multiple windows in 165
preferences 165–166
saving an item 163
SmartWords 164–165
using drag and drop editing 165
using the hot key 165



215Index

Reference

R
“Read” password 191
registering the software 12
Reminders

alert dialog box
responding to 28–29

date range in 38
default action 161
dismissing 28–29
in QuickDay Control Panel 28
menu bar alerts

enabling 28
preferences 160–161
for Public Events

preferences for 38
receiving 56
responding to 28–29
setting for Events 28–29
setting preferences for Meetings 36
snoozing 28–29, 29, 160

repeating Events 25–33
creating by copying 34–38
custom 26–27
deleting 34
editing in QuickDay 158
importing 68
modifying 27–38
moving 33–34
and Now Contact 172
standard 25–26

replacing Contact information 86–87
resizing List View columns 102–103
Resources

reserving 197–198
Roman numerals in column headers 101
Rooms

reserving 197–198

S
saving an item

in QuickPad 163
scrolling Month View 41
Secondary Address 108
Secondary Name 90, 91, 109
See-Thru Month 41
selecting Contacts 76–77

for merge documents 148
for printing 135, 150

Server.See Public Contact Server

Server Connections command
in Now Contact 180

Server Connections dialog box 176
Server status messages.See status messages
Sets 53–56

and Group Scheduling 194–195
and archiving 71
creating 54
defined 5
and exporting 69
modifying 54–56
name in title bar 37, 53
and Public Categories 187–191
switching between 53
in View menu 53

Sets in previous Now Contact versions 96
Setting Preferences

in Now Contact 88–91
Setting preferences

in QuickPad 165–166
sharing Events and Contacts 175–191
sharing information 167–174
short field labels

printing in Now Contact 137
SmartWords 164–165
snoozing Reminders 160
software registration 12
sorting in Contact Log 107
sorting in List View 46, 101

with column headers 101
speaker dialing 110

preferences 113–114
volume 113

Special Event 81
Special Events

and meeting availability 196
creating 20
default values for 36

status of To-Dos and Calls
changing in To-Do list 44

Sticky Notes
appear in Month View only 40
creating 21
default values for 36

synchronizing Contact Files 131–133
undoing changes 133
viewing changes 133

system requirements 9



216 Index

T
tab-delimited files 67, 131
TCP/IP

connecting to Public Server 175
technical support 2
telephone numbers

dialing 110–118
with extensions 112–113
numbers to dial after 112, 115, 116
numbers to dial before 112, 115

Template Editor 143–146
graphics tools 144
previewing Contacts in 146
Toolbar 143

Template-based printing 138–146
in Now Contact 135–151

Templates
Address Book.See also Address Book printing
Blank Page 147
Categories in 145
Contact Detail.See also Contact Detail

printing
Contact Details 141
Contact List 142
Copy Contact Info Formats in 145–146
creating.See also Template Setup dialog box
creating and modifying 138–139
document 142
Envelope.See also Envelope printing
export 70–71
fields included in 70
graphics in 143, 144
import 67–68
in Now Contact 138–146, 140–146
Keywords in 145
Label 142
location of files 138
merge document 142
merge fields in 144–146
modifying. See also Template Setup dialog

box
new documents and 147
Notes in 145
and Primary Fields 109
selecting for printing 136
setup options 140–141
types of 140
and Word Processor documents 146

text files
saving Word Processor documents as 148

text, finding 35

text style
of Categories, changing 33, 54–56
of Events, changing 32–33

Time display 49
Timer 82
timing activities 82
To-Do 81, 107
To-Do list

changing size of 44
dragging items to modify 44

To-Dos
creating 19
default values for 36
marking as Done 19–20, 28–29, 29, 44
marking as In Progress 19–20
timing 24

Today button 39
Tool Tips 1

hiding 91
Toolbars 39

button labels
hiding 91

Detail View 81, 105
hiding and showing 50
List View 100
Template Editor 143
Tool Tips 1

hiding 91
Word Processor 146

touch-tone dialing 110
transferring to Now Up-to-Date 173

U
Undated To-Do 81
Undated To-Dos

default values for 36
unreconciled Events 179

comparing with original 179
finding 179

unreconciled Public Contacts 183
upgrading from previous versions 9
URLs

entering in Custom Fields 84–85
linking Contacts to 79–80
linking Events to 30–32
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Reference

V
viewing Contacts 6, 99–118
Views

common elements 39
customizing 48–50

view-specific features 49–50
Day 43
default 40–41
defined 4
displaying weekends 50
duplicate windows in 50
Go to Date button 48
List 45–47

creating Events in 46
customizing 45
sorting columns in 46

Marks displayed in 49
Month 40–41

scrolling in 41
Multi-Day 42

scrolling in 42
navigating in 47–48
printing 59
To-Do list 44
Week 41
Year 43

W
Web links

attaching to Contacts 79–80
attaching to Events 30–32
in Custom Fields 84–85

week, start on Monday 37
Week View 41

printing 59
weekends

displayed in Views 50
Word Processor

choosing file type 148
creating documents 147–148
selecting a Template 147
and Templates 146
Toolbar 146

Word Wrap
in Event names 50

World Wide Web
linking Contacts to 79–80
linking Events to 30–32
URLs in Custom Fields 84–85

“Write” password 191

Y
Year View 43

printing 59

Z
Zoom commands

in Day View & Multi-Day View 43




	Now Up-to-Date & Contact 3.8 User's  Manual
	Table of Contents
	Introduction 
	About this User’s Manual 
	Online Help 
	Technical support 

	Overview 
	Now Up-to-Date  
	Now Contact basic concepts 
	QuickAccess Features 

	Installing Your Software 
	System requirements 
	Installing Now Up-to-Date & Contact 
	Registering your software 
	Removing Now Up-to-Date & Contact 

	Working with Calendar Events 
	Creating and opening a Calendar File 
	Event Info window 
	Creating Events 
	Customizing Events 
	Moving, copying, and deleting Events 
	Hiding and unhiding Events 
	Finding Events and text in your Calendar File 
	Setting preferences for Now Up-to-Date 

	Viewing Calendar Events 
	Using Calendar Views 
	Navigating through Calendar Views 
	Customizing Calendar Views 

	Organizing Calendar Events 
	Using Categories 
	Using Sets 

	Printing Calendars 
	Printing your Calendar 
	Setting printing options 
	Now Up-to-Date print settings 

	Importing, Exporting and Archiving Events 
	Importing data into your Calendar File 
	Exporting data from your Calendar File 
	Archiving data from your Calendar File 

	Working with Contacts 
	Creating a Contact File 
	Creating a new Contact 
	Customizing Contacts 
	Setting preferences for Now Contact 
	Finding Contacts 
	Hiding Contacts 

	Viewing and Dialing Contacts 
	List View 
	Detail View 
	Primary Fields 
	Dialing Contact telephone numbers 

	Organizing Contacts 
	Using Categories 
	Using Keywords 
	Using the Mark function 

	Importing, Exporting and Synchronizing Contacts 
	Importing from a text file 
	Importing Contacts from another Contact File 
	Exporting Contact data to a text file 
	Exporting Contacts to a Contact File 
	Synchronizing Contact Files 

	Printing Contacts 
	Printing your Contact information 
	Templates 
	Creating and Printing Documents 

	QuickAccess Features 
	Using QuickContact 
	Using QuickDay 
	Using QuickPad 

	Linking Events and Contacts 
	Setting linking preferences 
	Working with linked Contacts in Now Up-to-Date 
	Working with linked Events in Now Contact 

	Using Now Up-to-Date & Contact on a Network 
	Communicating with a Public Server 
	Sharing Events Using Public Categories 
	Sharing Contacts Using Public Categories 

	Group Scheduling 
	Getting started with Group Scheduling 
	Scheduling a Meeting 
	Viewing and responding to Meeting Notices 
	Proxies 
	Meeting Preferences 

	Index 

